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Introduction 

Welcome! 
Congratulations on your purchase of an Intellispec system! The Intellispec is a high-speed machine vision 
system designed specifically for product and online process monitoring. It is a very powerful tool that 
provides inspection much more reliably than the human eye or sampling methods. The latest PC 
technology, powerful new inspection algorithms, online adjustment capability, and inspection data 
storage allow the Intellispec to automatically inspect parts with extreme accuracy on high-speed lines. 

The Intellispec will help you provide the highest quality of products shipped to your customers. 
 

About this manual 
This manual: 

 Is considered to be valid as of release 5.0.501 of the Intellispec Series V software. Contents of this 
manual are subject to change without notice. 

 Is considered an integral part of the system and should be kept handy for future reference as long as 
the system is being used in your plant. 

 Is your responsibility to keep in good condition, in a dry place, and ready for consultation by the 
authorized users of the system. 

 Contains the technology implemented at the time of selling and supplying the system and shall not 
be considered inadequate in case of technological enhancements in the machine or in the manual's 
illustrations. 

Related books include: 

 Intellispec Series V Operator's Guide which has Operator-level user instructions, and is a good place 
to start if you are new to Intellispec 

 

Typographical Conventions 
Following is a list of typographical conventions used in this manual: 

 Bold type indicates a topic heading or an important item or statement. 

 Italicized type indicates emphasis. 

 Names of main components and system control signals have the first letter of each word capitalized. 
For example: Processor Cabinet. 

 Danger messages appear as shown below: 

 Danger 
Danger messages alert you to specific conditions that can cause serious or fatal personal injury. 

Danger messages give you important information which must be observed to prevent injury. 
These messages are set off from the body text as shown here. 

Chapter 1 
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 Caution messages appear as shown below: 

 Caution 
Caution messages indicate important information which must be observed to prevent: loss of 
data, poor system performance, or equipment damage. These messages are set off from the 

body text as shown here. 

 Notes appear as shown below: 

 Note: Notes contain special information that warrants being set off from the body text as shown 
here. 

 

Safety Considerations 
Observe the following safety warnings when operating the system or working near it: 

 Warning 
Potential for projectiles to strike persons and cause injury. Keep clear of reject devices. 

 

 Warning 
Sensitive electronics and High Voltages may be exposed. Keep Processor Cabinet door closed. 

 
 

Static Discharge Protection 

 Caution 
Electronic components can be damaged by static electricity discharge. 

Always observe the following precautions before removing, installing or handling any electronic 
components within the Inspection System: 

 Wear an anti-static wristband which is grounded to the Inspection System. 

 Stand on an anti-static, grounded floor mat, and lay circuit boards on the mat during any board 
replacement. 

 Keep circuit boards in static shield bags when storing and transporting. Ensure the bag is sealed. 
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Navigating Through the System 

This section describes the regions of the user interface and how to navigate through the software. It also 
describes how to select items and how to use the user interface buttons. 

 

Intellispec cabinet and user interface 

 

 

1  24" Diagonal color LCD with optional touch screen. An on-screen keyboard (OSK) is displayed when needed. 

2 
Trackball with two sets (left-handed or right-handed) of buttons: Select buttons [ ] and Information 

buttons [ ] 

3 Vision processor on/off switch. 

Chapter 2 
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4 Inside the cabinet: 

 Ethernet switches 

 Vision processor 

 Mechanical keyboard (MKB) 

5 USB convenience port is mounted on the side of the user interface. 

 
 

Monitor 

The standard monitor is an LCD color monitor mounted on a mechanical arm to allow the user to tilt or 
swivel the screen for best viewing. It has an area of 1920 x 1200 pixels and a diagonal size of about 24 
inches. 

 
 

Touch Screen Monitor (optional) 

Some Intellispec systems have a touch screen monitor installed. It has an area of 1920 x 1200 pixels and 
a diagonal size of about 24 inches. This is used primarily for high level navigation, obtaining information 
from the system, and responding to alarms. It is not to be used for inspection setup or configuration 
tasks, as those tasks require detailed input. 

 

Use the touch screen to: 

 Log in / out 

 Put the system online / offline 

 Clear statistics 

 Print reports 

 Acknowledge or reset Alarms 

 Navigate the menus (from System Overview to Lane View to Sensor view, etc.) 
 

User interface input devices 
The following devices are available to input information to the Intellispec system: 
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 Trackball and buttons (see "How to select menu items" on page 9) 

 On Screen Keyboard (OSK) (on page 10) 

 Touch Screen monitor (optional) (on page 8) 

 Temporarily connected conventional Mechanical Keyboard (MKB) (on page 12) 

 USB Ports (on page 12) 

 Optional Biometric Identification login device (see "Biometric login device" on page 13) 
 

User interface selection devices 

The user interface hardware consists of several buttons and selection devices: 

1 2

3

4

5

6

7

 

 

1  (not a button) Grommet for user interface equipment cords. 

2 Optional Biometric Identification login device 

3 and 
4 

Secondary set of buttons, used with track ball. See also items 6 and 7. 

5 Track Ball 

6 Button (left-click) to select and activate objects on screen 

7 Button (right-click) to call up a context-sensitive menu about the selected object on screen 

 
 

How to select menu items 

Use the track ball to select, interact, and change active objects on the screen. The track ball will be 
required for all inspection editing tasks. 
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Under the track ball are two buttons. Use the left button (the primary button ) to select and activate 

objects on the screen. Use the right button  to call up a context-sensitive menu related to the area 
or object clicked. A second set of each button type is located on the left side of the podium for 
two-handed operation. 

 Note: Swapping the button assignments is not supported. The second set of buttons is to 
accommodate left-handed users. 

The following table shows the actions available for the track ball and buttons, and the results of those 
actions. 

 

Action Result 

Point (move pointer with the 
track ball) 

Display Tool Tip when hovered over active object 

Click (Left-click)  
When the pointer is over an active object, a click initiates various actions. Nothing 
happens when the pointer is clicked on a disabled object. 

Double-click   
When the pointer is over an active object, a double-click initiates various actions. 
For example, edit an inspection. 

Right-click  
Display a context-sensitive menu when you click on an enabled object. The 
context-sensitive menu often contains functions that are also available in a menu 
bar or other screens. For example, add a point to a polygon. 

Drag (hold the left button while 
moving the track ball) 

Examples: move a selected Region of Interest (ROI) around an image or move an 
inspection in a Tree View to change the order of execution.  

 
 

On Screen Keyboard (OSK) 

Different types of on screen keyboards will be displayed depending on what kind of input is needed. 
When you want to type text or numbers into a field, right-click or double-click on a text input field to 
display the appropriate keyboard. 
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 If alphanumerical input is needed, a full alphanumeric keyboard will be displayed 

 In numeric input only is needed, a smaller, numeric keypad only will be displayed 

Alphanumeric keyboard 

 

 

1  Shift lock button - capitalizes all letters until you press this button again. 

2 Shift button - capitalizes one letter, then returns to uncapitalized letters automatically. 

3 OK button - accepts the typed information and closes the keyboard screen. 

4 Cancel button - disregards the typed information and closes the keyboard screen. 

Numeric keyboard 

The numeric keypad is displayed when the input field requires a numeric entry. Most of the buttons are 
self-explanatory. Additional buttons are described below. 

 Note: some buttons are not displayed if they are not appropriate for that field. 

 

 

1 Backspace - removes a digit 

2 Enter - populates the field in the Intellispec screen without closing the keyboard. This is useful if you want to 
test a value and see the results of the change immediately. 

3 [+/-]   makes the number positive or negative 

4 [.]  available only if a decimal number is valid in the input field 
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5 [<=>]  cycles to the next limit of the parameter. If the parameter has more than two limits, then asterisks 
will surround the selected value in the menu. 

 

6   accepts your changes and closes the numeric keypad 

 
 

Mechanical keyboard (MKB) 

The system supports the temporary connection of a conventional mechanical keyboard using one of the 
available USB ports (on page 12). This keyboard will mostly be used for system level tasks such as BIOS 
configuration, Network configuration, and Operating System level setup. 

 

The keyboard: 

 Is primarily used by Pressco Field Service Engineers 

 Is stored inside the Vision PC chassis 

 Requires a stable location when in use 
 

USB Ports 

There are USB ports available to back up or transfer data, and also to connect the optional mechanical 
keyboard. One is mounted on the side of the user interface pedestal. 

Some touch screen monitors have additional USB connectors on the side of the monitor. 
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Biometric login device 

The Biometric Identification login device (see "Adding a user with the biometric login device" on page 
26) is used to log in and out of the Intellispec system. This device is optional and must be purchased with 
the system. 

 

To log in with this device, press your finger to the device. The following are conditions for use: 

 You must use the same finger as initially set up by your administrator 

 If you do not know how your account was set up (or which finger you used), contact your 
administrator 

 If, after three tries, the Intellispec does not recognize your finger print, you must log in using the on 
screen keyboard (OSK (see "On Screen Keyboard (OSK)" on page 10)) 

 

User Interface Display - 4 Levels 
The display on the user interface has four levels for viewing: 

 

Look at the tab at the top of the screen to quickly determine which level you are viewing (from System 
Overview to Sensor Overview). The tab will read "System Overview" [level 1], "Lane n" [level 2], or 
"sensor name" [level 3]. In the Inspection Screen [level 4], the tab also reads "sensor name," but the 
inspection graphs and parameters are available to view and edit. 

 Note: when you switch between System Overview and Lane Overview modes, you will see one screen 
'minimize' to the task bar while your selected screen is displayed. This is normal. 

 To view the four viewing levels: 

1. Click the Home button  to go to level 1, System Overview. 
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 System Overview - Displays information that represents the complete system as well as a 
thumbnail line for each Lane that is configured. More information about the System Overview 
screen (on page 16). 

 

2. Click a Lane button  to go to level 2, Lane Overview. 

 Lane Overview - Displays information for a particular Lane as well as a thumbnail line for each 
sensor used in that Lane. More information about the Lane Overview Screen (on page 17). 

 

3. Click a Sensor button  to go to level 3, Sensor Overview. 



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Navigating Through the System  15 
© 2014 Pressco Technology Inc. Proprietary 
 

 

 Sensor Overview - Displays information for a particular sensor, including an image area, sensor 
statistics, a graphics area that displays user-selectable graphs, and a user-selectable inspection 
list. More information about Sensor Overview Screen (on page 18). 

 

4. Double-click an inspection name  in the Analysis Inspections list to get to level 
4, Inspection Screen. 

 Note: Some menu items are only available to advanced level users. 

 Inspection Screen - Double-click on any inspection name to see this view, which allows you to 
see inspection parameters and make changes if necessary. 

 

5. Click the exit button  to go back to level 3 Sensor Overview mode. 
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System Overview screen 

For a description of the toolbar icons, see Menu Toolbar (on page 19). 

 

 

1 Home 

2 Alarms 

3 System Settings 

4 Favorites 

5 Wizards 

6 Language 

7 Help menu 

8 Log in 

9 Walk By Graphic 

10 Click to go to Lane Overview 

11 Lane Statistics 

12 Current Part Program 

13 Online/ Offline 

14 Heartbeat Image 
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Lane Overview Screen 

 

 

1 Click the sensor button to toggle to detailed Sensor View and back 

2 Switch to System Overview 

 
 

More Lane Information 

 

Under the Lane Overview screen, click the More Lane Information bar to display additional graphs, 
statistics, or an additional Walk By graphic. Buttons on the right side of the screen provide different 
viewing options. 

 

Sensor Information 

 

Under the Lane Overview screen, click the Sensor Information bar (at the bottom of the screen) to 
display the default sensor information. Graphs, images, or statistics are displayed depending which 
button on the right is selected. 

 

Statistics menu 

Use the Statistics menu in the Lane Overview screen to view, reset, or print statistics. 

 Note: Some menu items are only available to advanced level users. 

 To view the Statistics menu: 

1. Go to the Lane Overview screen by clicking a Lane n button. 
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2. Click over a statistics box. The Statistics menu is displayed. The items in the menu are described 
below. 

 

Clear Lane Statistics 

Clear the statistics for the lane only. 

Clear Lane Statistics and Clear Images 

Clear the statistics for the lane and empty the defective image buffer. 

Print Lane Report 

Send the lane statistics report to the default configured printer. 

Statistics Last Reset 

Display the date and time when the lane statistics were last reset. 

 
 

Sensor Overview Screen 

 

 

1 Double-click to open Inspection View 

2 Switch to System Overview 
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Inspection Overview Screen 

 

 

1 Close the Inspection View 

2 The inspection window must be closed first to switch to System Overview 

 
 

Menu Toolbar 

 

1 Home 

2 Alarms 

3 Tools 

4 Favorites 

5 Wizards 

6 Language 

7 Help 
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Home 

Click Home to return to the System Overview Screen. If a region or inspection editor menu is open, 
you must close it before anything else can be selected. The Home button is highlighted in the System 
Overview screen. 

Alarms 

When this icon is selected, a different pop-up window appears depending on what screen you are on. 
For more information, refer to the section about alarms (on page 49). 

Tools 

When this icon is selected, a different pop-up window appears depending on what screen you are on. 
For more information, refer to the section about tools (see "Tools Menus" on page 61). 

Favorites 

From the Lane and Sensor Overview screens, select Take Screen Shot or Background Tasks. For more 
information, refer to the section about favorites (see "Favorites Menu" on page 106). 

Wizards 

From the Lane or Sensor Overview screens, select wizards that assist in setting up certain features. At 
the present time the only wizard is for setting up the Walk By graphic. This allows you to select group 
names, inspections assigned to each group, and values that determine when areas of the Walk By 
graphic turn to yellow, red, or back to normal (green). 

Language 

Select an available language from this menu. 

Help 

Access the help documents, support package utility, remote support, launch Windows Explorer, and 
determine software version. 

 

Language 

 Click the language button to select a different language. Choose from the available options. 

 

English 

If this box is checked, the names of the available languages are displayed in US English (example: 
Swedish instead of svenska). 

Select Language 

Select the language to display on the user interface. 

Select Language for Report Output 

Select the language for the reports, such as the Lane Report from the Statistics menu (on page 17). 
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Install Language Pack button 

When a new language is available, use this option to install the proper files. You will receive 
instructions from Pressco to install the language pack. 

 

Help 

Click the Help icon  to: 

 use the help files 

 create a support package (see "Creating a Support Package" on page 100) 

 access Pressco remote support (see "Help - Remote Support" on page 102) 

 open Windows Explorer (administrators only) 

 obtain your current software version 

 

 To access the user manuals: 

1. Click the Help icon . 

2. Select Help Documents, then select a manual from the list. The user manual is displayed. 

 
 

Online / Offline 

 

 The stoplight is the online/offline indicator for each lane. A red light indicates the lane is offline; a 
green light indicates the lane is online. 

 To switch from the online to offline mode, or vice versa, click the stoplight. 

 Lanes can be put online or offline independently. If multiple lanes are configured, then one can be 
offline while another is online. 
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Exiting the Intellispec software 
You must have proper user permissions to exit the software. This prevents unauthorized system 
shutdowns. Contact your system administrator if you need user permissions. 

 To exit Intellispec software: 

1. Log in. 

2. Click the Home button . 

3. Click the Tools button  to display the Tools menu. 

4. Click the Exit System option. 

5. A drop-down menu allows you to choose an option: 

 Shut down the Intellispec software only 

 Shut down the Intellispec software and computer 

 Shut down the Intellispec software and restart the computer 

 

6. Choose the desired option from the menu and click the OK  button. The Intellispec software 
and/or computer shuts down (and restarts if applicable). 
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User Accounts and Login Information 

This section describes how to log in and how to manage user accounts. 
 

Logging in and logging out 
Each user account has a list of permissions and restrictions. This is to give administrators more control 
over the system, and restrict others from performing tasks like changing lighting, or adding and editing 
inspections. When you log in, you can perform the tasks made available to you. 

 To log in, follow either of the steps below: 

 Click the Log In button  to display the login dialog box. Select your user name from 
the drop-down list. Enter your password using the On Screen Keyboard by touch screen or trackball 
and buttons. The password characters will not be shown for security reasons. 

 [With the optional biometric sensor] Press your finger to the sensor. The system will automatically 
determine your identity and log you in. If the system fails to recognize your identity after three 
attempts, the log in dialog box will appear, to allow you to log in with your user name and password. 

 To log out, follow either of the steps below: 

 Click the Log In button that displays your user name. The account drop-down menu appears. Select 
the Log Out button. The system logs you out. 

 [With the optional biometric sensor] Press your finger to the sensor. The system logs you out. 

 Note: When another users logs in, the system automatically logs you out. 

 
 

Log in menu 
To ensure that only authorized users perform certain changes to the system, users are required to log 
in.* 

*Some tasks can be configured so that users do not need to log in. This is done through Manage 
Permissions. 

 Note: Accounts may be shared by a group of people (example: Shift 1).  

 To view the Log In menu: 

1. Click the Log In button  and enter your password. The text on the button 
changes to indicate who is logged in. 

2. Click the Log In button again (which has your user name displayed on it). The Log In menu is 
displayed. Some options in this menu are only available to authorized users. 

 

Chapter 3 
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1 Logout - Logs out whoever is logged in 

2 Switch user - Allows you to switch from one user to another 

3 Change Password (see "Changing your password" on page 24)- Allows you to change only your password 

4 Manage Users (see "Managing user accounts" on page 25) – Used to assign, remove, or edit users. This is 
where users are given access to specific tasks (example: one user is given the access to edit inspections and 
another is not given this access). You can also give users access to specific tasks through Manage 
Permissions. 

5 Export Users (see "Exporting user accounts" on page 27) - Allows you to export user profiles from one 
Intellispec to another 

6 Import Users (see "Exporting user accounts" on page 27) - Allows you to import user profiles from one 
Intellispec to another 

7 Manage Permissions – This is where the system can be configured to allow pre-defined tasks to be 
performed with no log-in 

8 Setup Auto Logout (see "Setting up Auto Logout" on page 33)– This feature will automatically log you out if 
there is no activity for a defined amount of time 

 Note: There is a Pressco Technician account for use only by Pressco Service Engineers. This gives 
access to unsupported features (menu items are a different color). If you log into this account and 
use those features, do so at your own risk. 

 

Switching users 
The Switch Users option from the Log In menu logs out the current user, and allows a new user to log in. 

 To switch users: 

1. Click the Log in button (which has the current user's name displayed). 

2. Select Switch Users from the menu. 

3. Select the new user name from the drop-down menu. 

4. Enter the new user's password. The new user is logged in. The previous user is logged out. 

 If you have a biometric sensor: 

Press your finger to the biometric sensor device to log in. The previous user will be automatically logged 
out by the system. 

 

Changing your password 
The Change Password function is available to all users. 

 Note: an Administrator can reset a password if necessary. 

 To change your password: 

1. Log in. 

2. Click the Log In button with your user name to see the Log In menu. 

3. Select Change Password. The Change Password dialog box is displayed. 

4. Enter your Old Password. 

5. Enter a New Password. 

6. Confirm your New Password. 

7. Click the OK button  to accept the changes. The dialog box closes and your password is 
changed. 
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Managing user accounts 
The Manage Users button is only available to those with the Manage Users permission. This feature 
provides a wizard that allows you to Add a new user, Edit a current user or Remove any user. You may 
create one user account for a group of people and give that group the password to the account 
(example: Shift 1). 

 Note: the biometric login features are only used when the optional biometric login device is installed 

 To manage a user account: 

1. Log in as an administrative user. 

2. Click the button with your user name to see the login drop-down menu. 

3. Select Manage Users. The Manage Users dialog box is displayed. 

4. Select Add, Edit, or Remove a user. Follow the information on screen to complete these actions. 
The current step is highlighted on the left side of the configuration screen [item 1 in illustration 
below], and is repeated at the bottom of the screen. 

5. Use the forward arrow button [item 2] to move to the next screen after you have entered the 
appropriate information. Use the back arrow button (not shown in first step) to return to the 
previous step. You do not need to enter information in each screen to move from one screen to 
the next. 

 

 

1 Current step in the wizard is highlighted. 

2 Forward navigation to move to the next step. A back arrow (not shown) is available in later steps. 
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Adding a user with the biometric login device 

When you have the optional biometric login device installed, you will need the user present. The 
biometric login uses finger recognition software to log in rather than selecting a user name and entering 
a password. You can always log in (see "Logging in and logging out" on page 23) using your user name 
and password, even if you have a biometric login device. The maximum number of biometric accounts is 
40. 

 Note: use of one account by a group of people is not supported with the biometric device. Each user 
must have his or her own account. 

 Additionally, you cannot create two accounts for the same finger print. You could create two 
accounts for one person, but you must use two different fingers. 

 

 To add a user with the biometric login device: 

1. Log in as an administrative user. 

2. Click the button with your user name to see the login drop-down menu. 

3. Select Manage Users. The Manage Users dialog box is displayed. 

4. Click the Add button. 

5. Add the user name when prompted. Click the forward arrow. 

6. Enter a password, then Confirm it. Click the forward arrow. 

7. [Biometric login] The next screen gives you the option of creating a biometric login or skipping 
over it. If you chose Skip, go to step 10. If you chose Create, go to step 8.  

8. [Select Finger] Choose which finger the biometric sensor will read. Select any finger by using the 
touch screen or trackball and buttons to choose the circle above the finger. Only one finger can be 
used, and you must use this finger every time when logging in. Click the forward arrow. 
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9. [Read Finger] Click the Start Button at the top of the screen. The system will ask you to place the 
finger you selected on the biometric sensor. To ensure an accurate biometric measurement, you 
are asked for three readings. Instruct the user to place his or her finger on the biometric sensor 
three times when prompted. Click the forward arrow. 

10. [Permissions] This is where you can set up what each user can and cannot do within the system. 
After you have selected the desired permissions, click the forward arrow. You can also change 
permissions later. For more information, see Managing Permissions.  

11. [Finished] Click the OK button   to accept changes and exit. 

 
 

Exporting user accounts 
This allows you to export user accounts from one system to another. The user accounts may be used in 
other Intellispec Series V systems in your plant. You may also want to back up your user accounts in the 
event they are changed in the system. 

 What you need: 

 A USB memory device to export or import data 

 User access permission to change permissions 

 To export a user account: 

1. Log in as an administrative user. 

2. Insert the USB (see "USB Ports" on page 12) device into an available slot on the Intellispec Series V 
system. 

3. Click the button with your user name to see the login drop-down menu. 

4. In the user login drop-down menu, click Export Users. The Export Users dialog box is displayed. 

 

5. Select the user account that you want to export. 

6. Click the right arrow  to export the user account. 

7. Choose the destination to save the user account from the drop-down menu, or click the Save 

button  to browse to the USB device. 

8. Click OK  to accept changes and exit the screen. The user account is exported. 
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Importing user accounts 
This allows you to import user accounts from one system to another. The user accounts may be used 
from other Intellispec Series V systems in your plant. 

 What you need: 

 A USB memory device with user accounts already saved on it, or a folder on the Intellispec hard 
drive with valid user accounts 

 Administrative access to user accounts 

 To import a user account: 

1. Log in as an administrative user. 

2. Insert the USB (see "USB Ports" on page 12) device into an available slot on the Intellispec Series V 
system. 

3. Click the button with your user name to see the login drop-down menu. 

4. In the user login drop-down menu, click Import Users. The Import Users dialog box is displayed. 

 

5. Select the user account that you want to Import from the right column. If you do not see any users 

available, click the Save button  to browse to a location where the user account is saved. 

6. Click the left arrow  to import the user account. 

7. Click OK  to accept changes and exit the screen. The user account is imported. 
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Managing Permissions 
The Intellispec has some default permissions that you can use to quickly set up users. To grant these 
permissions, click the appropriate button in the Manage Users screen. When you select these default 
permissions, you could also add or subtract specific permissions for the user. 

 

 

1 Choose from one of the predefined Roles to use the default permissions 

2 Subtract one of the Granted Permissions. First highlight the permission in the list, then click the left arrow. 

3 Grant one of the Denied Permissions to the selected user. First highlight the permission in the list, then click 
the right arrow. 

Notes about roles and permissions: 

 Granted permissions have priority over roles. If you change the permissions of a role, or change the 
role of a user, the granted permissions persist. 

 When you change permissions for a role, all users with that role get the new permissions of that 
role. This is useful to change permissions for groups of users. 

The following table provides a brief description of all the available default permissions. Note that some 
permissions may not be available in your list. For more information, refer to Editing Permissions (on 
page 32). 

Key: ROLES:  O = Operator; M = Mechanic; D = Designer; A = Administrator 

 

 
Permission Description O M D A 

1 Access advanced inspection 
parameters (Editor Options (on 
page 160)) 

Access advanced parameters inside of the 
inspections, and access some inspection 
tree items (such as regions). 

  X X 

2 Access image tools (see "Image 
Analysis" on page 114) 

Access the Image Analysis Tools. X X X X 
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Permission Description O M D A 

3 Access system configuration 
(see "Lane Setup" on page 70) 

Change system configuration values.  X X X 

4 Access system diagnostics Perform system functions including I/O 
(see "I/O Diagnostics" on page 83) and 
correlation diagnostics (on page 84). 

 X X X 

5 Adjust date and time (see 
"Adjusting Date and Time" on 
page 99) 

Adjust Intellispec system date and time.    X 

6 Allow Task Manager Access Access Windows Task Manager.  X X X 

7 Cancel Background Task (see 
"Background Tasks" on page 
107) 

Cancel a background task if it is 
interfering with inspection. 

   X 

8 Clear statistics (see "Statistics 
menu" on page 17) 

Reset inspection statistics. X X X X 

9 Clear alarms (see "Viewing and 
Clearing Alarms" on page 50) 

Clear inspection and system alarms X X X X 

10 Configure alarms (see "Lane 
Alarm Configuration" on page 
52, "Sensor Alarm 
Configuration" on page 56) 

Configure the lane and sensor alarms.  X X X 

11 Configure charts (see "Lane 
Setup" on page 70) 

Configure trend charts and other 
statistics charts. 

 X X X 

12 Configure statistics (see 
"Statistics Configuration" on 
page 45) 

Configure how the statistics graphs are 
displayed. 

 X X X 

13 Configure walk-by (see "Walk 
By Setup" on page 36) 

Name, set up alarms, and set up which 
inspections will be used with a particular 
region on a part. These regions are 
displayed in the walk-by graphic. 

 X X X 

14 Design inspection tree (see 
"Inspection menu" on page 147) 

Add or delete inspections.   X X 

15 Edit inspections Edit existing inspections.  X X X 

16 Edit Lighting (see "Sensor menu" 
on page 111) 

Change the lighting settings for each 
camera. 

 X X X 

17 Edit Part Notes (see "Part 
Setup" on page 67) 

Add information to the part setup file.  X X X 

18 Enable defect database (see 
"Reporting" on page 62) 

Enable the optional defect database.   X X 

19 Enable inspection items (see 
"Inspection menu" on page 147) 

Enable or disable individual inspections 
and the rejecter for those individual 
inspections. 

 X X X 

20 Forced Reject (on page 80) 
Sampling 

Request forced reject sampling. X X X X 
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Permission Description O M D A 

21 Go Offline (see "Online / 
Offline" on page 21) 

Put a lane offline. X X X X 

22 Go Online (see "Online / Offline" 
on page 21) 

Put a lane online. X X X X 

23 Install language pack (see 
"Language" on page 20) 

Update the language files for the user 
interface, if provided by Pressco. 

   X 

24 Launch Windows Explorer Launch Windows Explorer from Task 
Manager or from the desktop. 

   X 

25 Manage part programs (see 
"How to Create, Copy, or Import 
a Part Program" on page 144) 

Create, import, export, copy, or load part 
programs. 

 X X X 

26 Manage user accounts (see 
"Managing user accounts" on 
page 25) 

Open Manage Users which lets you add, 
edit and remove users. 

   X 

27 Open help sessions (see "Help - 
Remote Support" on page 102) 

Start a remote help session with Pressco 
Technical Support. 

X X X X 

27 Rollback part program (see 
"Part Program Change Log" on 
page 150) 

Roll the current part program back to a 
previous state. 

 X X X 

29 Run Mass Manager Used with mass sensors - select 
appropriate Scaling Recorder sessions to 
scale the Intellimass readings. 

 X X X 

30 Run Mass Recorder Used with mass sensors - enter sample 
data from cut and weighed bottles. 

X X X X 

31 Setup printer (see "Setting up a 
printer" on page 100) 

Set up a printer for Intellispec reports.    X 

32 Setup report schedule (see 
"Schedule Reports" on page 64) 

Schedule statistics reports to be 
generated periodically. 

 X X X 

33 Shut down system (see "Exiting 
the Intellispec software" on 
page 21) 

Shut down the Intellispec system.  X X X 

34 Switch part program Change the currently running part 
program. This also allows you to add a 
new part program. 

X X X X 

35 Switch report language (see 
"Language" on page 20) 

Choose a language for the Intellispec 
reports. 

   X 

36 View change logs (see "Part 
Program Change Log" on page 
150) 

View the inspection change logs.  X X X 

37 View system logs (see "Log 
Reader" on page 66) 

View the system logs. X X X X 
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Editing Permissions 

This feature allows you to set up permissions that will be available when no one is logged in. It also gives 
the selected permissions to all users. Once a permission has been selected, it will no longer appear in the 
available or selected columns when adding or editing a user in the Manage Users option. This feature is 
only available to Administrators (with Manage Users permissions). 

 

 To grant permissions to all users: 

1. Log in as Administrator. 

2. Click the Log in button with your name on it to see the Log in menu. 

3. Select Manage Permissions. The Edit Permissions screen is displayed. 

4. Click the Roles button. 

5. From the drop-down menu below Roles, select "Not Logged In." 

6. Highlight the desired permission in the left column. 

7. Click the right arrow  to move the permission to the right column. 

8. Repeat the above two steps for all desired permissions.  

9. Click the OK button  to accept changes and exit. 

You can also remove permissions from all users that are assigned specific roles. 
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 Caution 
Be sure you select the User name from the drop-down menu before you change Roles. 

Otherwise, you could change your Administrator permissions (example: from Administrator to 
Operator, and not be able to Manage User Permissions afterwards). 

 To remove permissions from a role: 

1. Log in as Administrator. 

2. Click the Log in button with your name on it to see the Log in menu. 

3. Select Manage Permissions. The Edit Permissions screen is displayed. 

4. Click the Roles button. 

5. From the drop-down menu below Roles, select the role from which you want to remove the 
permissions. 

6. Highlight the desired permission in the right column. 

7. Click the left arrow  to move the permission to the left column. 

8. Repeat the above two steps for all desired permissions. 

9. Click the OK button  to accept changes and exit. 

You can also manage permissions for any user. 

 To edit a user's permissions: 

1. Log in as Administrator. 

2. Click the Log in button with your name on it to see the Log in menu. 

3. Select Manage Permissions. The Edit Permissions screen is displayed. 

4. Select a user from the User drop-down menu. 

 Move the desired permissions between Denied and Granted. Or: 

 Assign that user a new role. For example, change Jane's permissions from Operator to Mechanic. 
The user will acquire all permissions for that role, including any that you have assigned 
separately from Pressco's default settings. 

5. Repeat the above step for all desired permissions. 

6. Click the OK button  to accept changes and exit. 

 
 

Setting up Auto Logout 
This feature will automatically out any user after a set number of minutes of inactivity. 

 To set up Auto Logout: 

1. Log in as an administrative user. 

2. Click the button with your user name to see the login drop-down menu. 

3. Select Setup Auto Logout. The setup menu is displayed. 

4. Click the box next to "Auto Logout" to enable the feature. A check mark is displayed in the box 
when it is enabled. 

5. Set the Wait time in minutes by clicking the up or down arrows, or by highlighting the number of 
minutes and typing a new value (from 1 to 9999 minutes). 
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6. Click the OK button . All users will be logged out automatically after the set number of minutes 
of inactivity. 
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Graphs and Image Displays 

Several graphs are available on the user interface to help you view inspection trends. This section 
discusses the buttons on the right side of the screen in the Lane Overview and Sensor Overview modes. 

 

Walk By Graphic 

 

This feature uses a graphic representation of a part so that you can quickly identify which area of the 
part is failing. It is called Walk By because you can quickly walk by the Intellispec and look at the graphic 
to determine the status of inspection: 

 Green areas indicate that parts are passing inspection. 

 Yellow warning areas notify you that the spoilage rate is approaching, but has not yet reached a 
critical level. This allows you to make necessary changes to the manufacturing process before the 
failure rate gets too high. 

 Red areas indicate the spoilage rate has exceeded user defined limits. 

The defect percentage rate at which each group reaches warning or failure limits is defined in Walk By 
Setup (on page 36). 

There are two available Walk By Graphics: 

 A small Walk By Graphic is displayed in System Overview, Lane Overview, and Sensor Overview 
modes 

 A large Walk By Graphic can be displayed in Lane Overview mode 

 To see the large Walk By Graphic: 

1. Click a Lane n button to view the Lane Overview mode.  

2. Click the More Lane Information bar in the center of the screen to display more graph options. 

 

3. Click the Walk By button on the right side of the screen.  The Walk By Graphic is 
displayed in the center of the screen. 

The large Walk By Graphic displays the group names, pointing to the appropriate areas on the part. It 
also displays the current defect percentage for each of those groups, from inspection results. 

 
 

Using the Walk By Graphic 

You can view inspection information by clicking on the areas of the graphic. The Intellispec will display 
the configured inspection group and detail. The example below shows: 

Chapter 4 
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 The Panel group was clicked - all the inspections for Panel are displayed in the table 

 The Panel area in the Walk By Graphic is red - The average defect % for the group of inspections 
exceeds the failure limit from the Walk By setup (on page 36) 

 

Double-click an inspection from the table (example: a Contrast inspection) to open and edit that 
inspection. Note: Some menu items are only available to advanced level users. 

 

Walk By Setup 

This screen allows you to set up the Walk By Image. Each Lane can be set up differently if needed. 

Each area of the part graphic display is:  

 Assigned a group name. 

 Assigned the correct inspections for that group. 

 Configured to turn the area yellow or red when defined defect statistics are achieved. 

 Note: you must have correct user permissions to set up the Walk By Graphic. You must also have a 
part program loaded. 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu > Lane set 
up > Walk By Setup. 

 

 To set up the Walk By graphic: 

1. Follow the instructions on screen, and navigate using the buttons at the bottom of the screen. 
Some parameters are explained below. 
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2. After the last screen, the system takes you back to the first screen so that you can set up another 

group. If you are finished, click the OK button  at the bottom of the screen to accept your 
changes and exit the screen. 

Group 

Each graphical area on the part is assigned to a group - this is defined in the graphic file. Assign as 
many inspections as you wish to a group, preferably those inspecting that area of the part. 
Inspections can be from any sensor within the same part program on the lane. Some drop-down 
menus on the user interface refer to 'groups' - these represent groups of inspections that inspect one 
area of a part. 
A group can be a contiguous area, or a group of related areas on a part, as shown in red below. 

 

Warning Percent 

Set the value at which the group on the Walk By Graphic turns yellow. Yellow warning areas notify 
you that the spoilage rate is approaching, but has not yet reached a critical level. This allows you to 
make necessary changes to the manufacturing process before the failure rate gets too high. 

 Note: this warning percentage is not connected to inspection warning limits. Those limits are set 
separately. Additionally, this warning percentage does not affect the Excessive Warnings alarm. 

Failure Percent 

Set the value at which the group on the Walk By Graphic turns red. Red areas indicate the spoilage 
rate has exceeded user defined limits. 

 Note: this failure percentage is not connected to inspection limits. Those limits are set separately. 
Additionally, this failure percentage does not affect the rejects alarms. 

Group Digital Outputs (for Extended I/O option) 

Select the group number (Group 0 through 15) to trigger an output signal through the Extended I/O 
board. If your system has firmware version lower than F168, then you will have outputs 0 through 14 
available. 

 
The outputs go active when any inspection within the assigned group fails. You can use these outputs 
to monitor the process within your plant and make adjustments as necessary. 
You can assign multiple groups to one output. The groups can contain inspections from any sensor 
within their corresponding lane part program. Each lane may have its own Extended I/O board, so 
you cannot combine inspections from different lanes. 
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Trend Graphs 

 

 To view the Lane trend graphs: 

1. Select a lane (click a Lane n button). 

2. Click the Trend Graphs button on the right side of the screen. The trend graph is displayed. 

Trend graphs are available to view statistics based on specified criteria. These graphs are available for 
each lane and each sensor within that lane. You can select criteria for the H-axis, the V-axis, and Series. 
There is an adjustable Alarm Level for Defect %. Both the H-axis and V-axis adjust automatically to higher 
and lower values. The Alarm Level will adjust as well. Below is a list of possible combinations for Time 
and Parts based graphs. 

H-axis V-axis Series 

Time Defect % 

Defect Count 

Defect Cost 

Parts and Defects 

Lane Total 

All Walk-By Groups 

All Sensors 

Individual Sensors 

Parts Defect % 

Defect Count 

Defect Cost 

Lane Total 

All Walk-By Groups 

All Sensors 

Individual Sensors 

For Trend Graphs, you can select which data to display. Select from the Series drop-down menu. 

 

Lane Total 

Displays the statistics averaged for all sensors within the lane. 

All Walk-By Groups 

Displays the statistics for inspection groups. These groups are defined in the Walk By Graphic setup, 
and pertain to a specific area of a part. 

All Sensors 

Displays the statistics for each sensor. 

Individual Sensors [names vary] 

Displays the statistics for only the selected sensor. 
Note: A key (to explain color-coding and data point shape) is displayed to the right of the graph for 
All Walk-By Groups and All Sensors. 

 To change the graph criteria: 

1. Click any button (next to H-axis, V-axis, or Series) to view the drop-down menu options. 

2. Select the desired criteria. The graph is updated to display based on your chosen criteria. 

When the data falls outside of the current viewing range (example, time) a scroll button  becomes 
available next to the Series drop-down box. 
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 To view other data: 

1. Click the scroll button . A scroll bar becomes available. 

 

2. Click and drag the scroll bar to view the desired data. 

3. To exit, click the exit button . The graph returns to the current data. 

 
 

Multiple Trend Graphs 

In the Sensor Overview screen (on page 18), the upper and lower portions of the screen can display 
different trend graphs. For example, you could display a time based graph at the top of the screen, and a 
part based graph at the bottom of the screen. When the Trend Graph button is available on the right 
side of the screen in multiple locations, you could view any combination of trend graphs as you wish. 

 

Trend Chart Configuration - System Overview 

This is the setting for the trend chart displayed on System Overview screen. 

 Note: the vertical axis setting is automatically scaled to best represent the data on the chart. 

 To change the chart configuration: 

1. Click the Home button  to view the System Overview screen. 

2. Right-click over the trend chart. The Chart Configuration menu is displayed. 

 

3. Choose from the available trend chart types, and select the number of points to display on the 
chart. 

4. Click the OK button  to accept changes and exit the menu. The selected chart is displayed in 
the System Overview screen. 

 Note: these changes affect all trend charts in the System Overview screen 
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Trend Chart Configuration - Lane Overview 

These settings affect the display of all the trend charts in the Lane Overview or Sensor Overview screens. 

 Note: the statistics for the lane are reset when you change a configuration setting. 

 To change the trend chart display: 

1. View the Lane Overview or Sensor Overview screen by clicking either a Lane n button or a Sensor n 
button. 

2. Click one or all of the Trend Charts buttons on the right side of the screen to display a trend chart. 

3. Right-click over one of the trend charts. The Graph Menu is displayed. 

4. From the Graph menu, select Configuration. The Trend Chart Configuration menu is displayed. 

 

5. Select the desired settings from all the available parameters. 

6. Click the OK button to save your changes and exit the screen. All the trend charts for the selected 
lane are updated to reflect your changes. 

 
 

Alarm Percentages in Trend Charts 

The alarm level can be adjusted when Defect % is selected for the V-axis. Click and drag on the red Alarm 
Level line to adjust it. This also changes the alarm percentage in the Lane Alarm Configuration (on page 
52) menu. The illustration below shows Sensor Overview mode with Trend Charts displayed for both 
Lane and Sensor. Changing the alarm percentage in any one of the Trend Charts or Lane Configuration 
menu changes the percentage in all the other locations. 
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 Note: Changing this alarm percentage does not affect the alarm percentage level in the Walk By 
Graphic. 

 

 
 

Reject Images 

 

Reject Images are images from the last 100 defects from a sensor (or all sensors for Lane Overview 
mode). These images are available in the Lane Overview screen and the Sensor Overview screen. 

 To view Reject Images: 

1. From the System Overview screen, click a Lane n button to display lane information. 

2. Click a Reject Images button on the right side of the screen. Note: there are buttons for Lane and 
Sensor levels - these display images for the entire lane or just the sensor. 
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 Lane Reject Images show a variety of images from different Sensors. Below the image is the name of 
the Sensor it came from and what time it was rejected. You can scroll through the images using the 
arrows. Clicking on an image will bring you to the Sensor from which it failed. 

 

 Sensor Reject Images show snapshots of failed images from that Sensor only. Below the snapshot is 
the time it was rejected. 

 

 

 To use the images: 

 Click an image from the Lane Reject images to display the corresponding Sensor information in the 
lower part of the screen. 

 

 Click any one of the small images to display a larger version of that image. 

 Click on the large image to display a magnified portion of the image. This is useful to see small 
defects. Click and drag on the magnified portion to navigate around the image. Click in the 
magnified area to toggle the magnifier. 
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 Right-click on the image to choose a zoom amount. An enlarged image, the same size as the Big Live 
Image (on page 48) is displayed. Use the navigation arrows, or click and drag the cursor to pan 
around the image.  

 From the pop-up menu, you may also choose Image Analysis (on page 114) (when the lane is 
offline). 

 Click the exit button  to close the zoom window 

 

 
 

Machine Part Graphs 
Machine Part Graphs are available when you have the Correlation option installed. Machine Parts 
Graphs display defect information for each machine part. Below is a list of possible combinations for 
Defect % and Defect Count. 

H-axis V-axis Series 

Defect % Machine Parts Lane Total 

All Sensors 

Defect Count Machine Parts Lane Total 

All Sensors 

An example graph is displayed below. It shows defects for a machine part type, and the number of 
defects correlated to each sensor. 

 
 



44  Graphs and Image Displays Software User's Guide INTELLISPEC™ (Software Version 5.0.501) 
   © 2014 Pressco Technology Inc. Proprietary 
 

 

Timing Trend 

 

 Note: this chart is mostly used by Pressco service engineers during installation, or it can be used 
when additional inspections or hardware have been added to the system. 

This chart displays the time required to run inspections. It is important to view the inspection timing, 
especially if you have multiple sensors or multiple lanes, to make sure that the system is inspecting all 
parts before they reach the reject station. 

The choices for the Series in the Timing Trend chart allow you to choose Sensor Total, which is all 
inspections for that sensor, or any individual inspection for that sensor. 

 

 
 

Inspections graph 

 

Click the Inspections button on the right side of the screen to see the Inspections Graph. This graph 
displays the Defect Count or Defect % for the selected sensor. It displays the failed inspections in 
descending order of failure. The example below is the graph shown in both Lane Overview and Sensor 
Overview modes. 
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Statistics Grid 

 

The Statistics Grid displays information about each Sensor. There are two different types of Statistics 
Grids: Lane and Sensor. 

Lane Statistics Grid 

The Lane Statistics Grid (in Lane Overview mode) displays general information about each Sensor. It 
shows the Total number of parts run, Sensor, Defects, Defect %, Last N, and Last N %. 

 

Sensor Statistics Grid 

This grid is available when you display Sensor information. It shows specific information for each 
sensor, including Inspection, Total number of parts run, Defects, Defect %, Last N, and Last N %. 

 

 Note: you can configure (see "Statistics Grid options" on page 47) the statistics display. Your system 
may not display all of the above-mentioned items. 

To display the statistics grid, click the Statistics button on the right side of the screen. There may be 
multiple buttons, depending which screen you are viewing. 

Sorting order 

To sort any column in ascending or descending order, click the button at the top of the column. Click it 
again to toggle to the opposite order. Right-click to clear sorting in the statistics grid. 

 

 
 

Statistics Configuration 

All the statistics grids in the current lane will use these settings. 

 To get to this screen: 

1. From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu. 
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2. Choose Lane Setup, then Statistics Configuration. 

 

Last N 

Specify how many parts to include in recent statistics, such as the column "Last N" which displays the 
number of defects in the Last N parts, or "Last N %" which displays the percentages of defects within 
the Last N parts. 
This feature allows you to continue to collect inspection data (Total inspected, total defects, and 
defect %) without clearing the statistics to see how the most recent batch of parts has done. 

Parts per Update 

Determines the graduations on the horizontal axis for the Trend Chart and Timing Trend if "Parts" is 
selected. 

Time per Update 

Determines the graduations on the horizontal axis on the Trend Chart and Timing Trend if "Time" is 
selected. 
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Statistics Grid options 

To change what is displayed in the statistics grids, use the options menu. These settings are applied to all 
statistics grids, whether in the Lane Overview screen, or Sensor Overview screen. Right-click over any 
statistics grid to see the options. These are explained below. 

 

Column Visibility 

Change the number of columns that are displayed in the grid. 

Display Options 

Change the number of rows that are displayed in the grid. This only affects the statistics grids in the 
Sensor Overview level. 

Hide Regions 

If this is checked, then the inspection regions are not displayed in the grid. This means the Ring, 
Polygon, Rectangle, or Adaptive regions that identify the inspection area, but do not have any reject 
criteria. 

Hide Enhancement 

If this is checked, then the inspection enhancements such as Clipping, Stretch Grayshades, or Power 
Filter are not displayed in the grid. 

Change Limits 

This menu allows you to change the number of columns and rows of the grids in the first two sections of 
the menu. These are the same as Column Visibility and Display Options. 

The lower two sections of this menu allow you to enable and change limits for inspection. 
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Use Error Limit 

Causes the Defect % and Last N % columns to display in red if the trigger percentage is exceeded. 
This allows you to see these statistics from a distance. 

Use Warning Limit 

Causes the Defect % and Last N % columns to display in yellow if the trigger percentage is exceeded. 
This allows you to see these statistics from a distance. 

Clear Sorting 

Puts the sorting order back to the default setting. To sort any column in ascending or descending order, 
click the button at the top of the column. Click it again to toggle to the opposite order. 

 

Big Live Image 

 

Click the Big Live Image button in Sensor Overview mode to view an enlarged image of the last part that 
was inspected. 

This image is updated when the lane is online and the camera is snapping images. The image is outlined 
in green if the part is passing, yellow if it is in a warning state, or red if the part is failing. You can view 
this image from a distance to quickly see how the inspection process is performing. 
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Alarms 

There are three levels of alarms within the Intellispec system: System, Lane, and Sensor alarms. Most of 
these are configurable. The table below lists the alarms, possible causes for triggering the alarm, the 
reset mechanism, and color of the indicator on the light tree. Also refer to the light tree status for more 
information about the lights. 

The information in this section is valid as of software version 5.0.501. 

 Note: Alarms are recorded in the system log reader (on page 66), even when the alarms are 
automatically cleared. 

 

Alarm Name Cause Reset Mechanism Color in light 
tree 

System Alarms (see "System Alarms Description" on page 52) 

Note: If a system alarm occurs, an alarm icon is displayed in the lower right of the screen (in the Windows 
system tray) 

UPS 

 

Battery is dead. 

Or: 

Manually [you must 
first replace battery] 

Not applicable 
(N/A) 

Plant power is lost and the UPS shutdown 
time is exceeded. The Intellispec shuts 
down. 

If plant power is 
restored before the 
Intellispec shuts down, 
then the alarm 
condition is 
automatically cleared. 

Otherwise, you must 
restart the system 
manually. 

N/A 

Over temperature CPU temperature exceeds highest 
recommended operating temperature. 

The Intellispec system shuts down. You 
must wait till the processor cools before 
resuming operation. 

Manually N/A 

Lost network 
connection 

If the plant network is configured to 
communicate with the Intellispec and the 
network connection is lost, a lost network 
icon appears in the Windows system tray 

Restoring plant network 
connection 

N/A 

Lane Alarms (see "Lane Alarms Description" on page 55) 

Percent Defects¹ Percentage of defects exceeds the set 
limit 

Manually Red 

Chapter 5 
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Alarm Name Cause Reset Mechanism Color in light 
tree 

Offline¹ Lane goes offline Manually Green when 
system is 
online 

Red when 
system goes 
offline 

Chute Full¹ Reject chute is full Manually [you must 
first clear chute] 

Red 

Blow Molder Door 
Open¹ 

Blow molder door is open Automatically [by 
closing blow molder 
door] 

Red 

Power Status¹ Lane AC Power is lost Automatically Off when AC 
power is lost 

Blue when 
power is OK 

Good Parts¹ Used as a part counter. When specified 
number of parts is reached, then alarm is 
triggered. 

Manually Red 

Missed Reject¹ System missed rejecting a part. Works 
with Reject Confirm (see "Reject Confirm 
Calibration (Optional)" on page 95). 

Manually Red 

System Error¹ Part tracker or other internal system 
errors 

Manually Red 

Sensor Alarms (see "Sensor Alarms Description" on page 59) 

Percent Rejects¹ Percentage of rejected parts exceeds the 
set limit 

Manually Red 

Excessive Rejects¹ Excessive number of rejects Manually Red 

Excessive Warnings¹ Excessive number of warnings Manually Amber 

Consecutive Defects¹ Too many consecutive defects Manually Red 

System Error¹ Missed part, missed acquisition, missed 
result, or other internal error 

Manually Red 

¹ If you want to connect an external monitoring device such as a PLC, an optional Extended I/O board is 
required for each lane. 

 

Viewing and Clearing Alarms 
Use the View/Clear Alarms menu to see which alarms are enabled and disabled. A green light indicates 
that the alarm has not been triggered, while a red light indicates the alarm has been triggered. 

 To get to the View/Clear Alarms menu: 

 Click an Alarm button . The View/Clear Alarms menu is displayed. 

Or: 

1. View the Lane Overview or Sensor Overview screen by clicking either a Lane n button or Sensor 
button. 
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2. Click the Alarms button  to view the Alarms menu. 

3. Select View/Clear Alarms from the menu. The menu shown below is displayed. 

 To view when an alarm was triggered and who last cleared it: 

Click an LED in the View/Clear Alarms screen.  

 

 To clear an alarm: 

 Click the Clear button next to any alarm to clear a single alarm. Or: 

 Click the Clear All button at the bottom of the screen to clear all alarms. 

 Note: some triggered alarms may be from another sensor - click the red sensor indicator [in item 1] 
to see that sensor's alarms 

 

1  List of sensors in the selected lane. Click an LED to select a sensor. 

2 List of Lane alarms 

3 List of Sensor alarms. Use the drop-down menu to select a sensor. 

 Note: The LED with a white circle around it in the list of sensors [item 1] is the selected sensor. The 
drop-down menu also indicates the selected sensor. 

The indicators in this screen show whether an alarm is enabled, and whether it is triggered. 

 
Green Off - the alarm is not enabled nor triggered 
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Green On - the alarm is enabled, but has not been triggered 

 
Red On - the alarm is both enabled and triggered 

 
 

System Alarms Description 
The system alarms are the UPS (uninterruptible power supply) and CPU temperature alarms. You can 
configure the UPS shut down time. 

 To get to this menu: 

1. Click the Home button  to view the System Overview screen. 

2. Click the Alarms button  to view the system alarms. The screen shown below is displayed. 

 

 

1  UPS Shutdown Time – Set the number of seconds that the UPS will maintain power to the 
system if AC power has been lost. The Intellispec system shuts down after this time period. 
This allows for a normal Windows shutdown. 

2 CPU Temperature – Displays the current, warning, and shutdown temperatures associated 
with the computer CPU. If a multiple core computer is used, the highest temperature is 
displayed. If the shutdown CPU temperature is reached, the Intellispec system shuts down. 

 
 

Lane Alarm Configuration 
In the Lane Alarm Configuration menu, you can edit alarms for an entire lane. To see a description for 
each type of alarm, see Lane alarms description (on page 55). 

 Note: Some menu items are only available to advanced level users. 

 To get to this menu: 

1. Log in. 

2. View the Lane Overview screen by clicking a Lane n button. 

3. Click the Alarms button  to view the Alarms menu. 
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4. From the Alarms menu, select Lane Alarm Configuration. 

 

Select an alarm from the drop-down menu to configure that alarm. You can enable or disable 
parameters for each alarm individually. A check mark appears in the box next to the parameter, and the 
name of the alarm, when it is enabled. The parameters are described below. 

For numeric values, you can change the numbers with the slider bars or click in the box to the right of 
the slider to nudge the number up or down, or bring up a numeric keypad to enter a new value. 

Alarm Enabled 

Enables alarm. 

Minimum Count 

Specify the minimum number of parts that must be inspected before the alarm can be triggered. This 
prevents the alarm from being triggered too soon, when only a small number of parts may make the 
statistics trigger the alarm. 
Minimum Count is used in the Percent Defects alarm. 

Trigger [%] 

Define the percentage of parts inspected that must fail to trigger the Percent Defects alarm. This 
number is selectable between zero and 100. The default value is five percent. 
Trigger [%] is used in the Percent Defects alarm. 

 Note: you can change this percentage in the Trend Charts (see "Alarm Percentages in Trend 
Charts" on page 40) in Lane Overview mode when Defect % is selected for the V-axis. 

Trigger (thousands) 

[Good Parts alarm] The number of parts that must pass inspection to trigger the alarm. The number 
is expressed in thousands. 

Audible Enabled 

If this parameter is enabled, the audible alarm will sound when triggered. 

Audible Duration 

The number of seconds the audible alarm will sound if triggered. It will remain on until the alarm is 
cleared. Use the slider to set values up to 3600 seconds (60 minutes), or use the drop-down menu 
option to allow the alarm to remain on forever (until cleared). 

Visual Enabled 

If this parameter is enabled, this alarm will switch on the appropriate light on the light tree when 
triggered. 
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Visual Duration 

The number of seconds the light will remain on when the alarm is triggered. It will remain on until 
the alarm is cleared. Use the slider to set values up to 3600 seconds (60 minutes), or use the 
drop-down menu option to allow the alarm to remain on forever (until cleared). 

Alarm Outputs 

Select an output (Inspection Alarm 0-14) to be toggled on the optional Extended I/O kit when the 
alarm is triggered. 

 Note: if your system has firmware version F168 or higher, there are 16 Alarm Digital Outputs. 
They are numbered 0-15. Firmware versions below F168 support 15 Alarm Digital Outputs 
numbered 0-14. 

 There are 15 available Inspection Alarm outputs that correspond to the extended I/O signals. 
Click one of the output numbers to assign the current alarm to an output. 

 These outputs go active when the alarm is triggered, and go inactive when the alarm is cleared. 

 The outputs can be monitored by your plant equipment, such as a PLC, to notify you when 
certain alarms are triggered. 

Disable All Alarms 

Click this button to disable all the current alarms at once. This disables only the alarms for the 
current sensor or lane. This is used in emergencies when you cannot repair a situation immediately, 
or when setting up the system. The remaining parameter settings for each alarm are saved for future 
use. You must re-enable each alarm individually when you are ready. 

Missed Reject and System Error Alarm Details 

The Missed Reject and System Error Alarms cannot be disabled. However, there is a Details button that 
shows whether they are being used as an alarm (to light the red light of the light tree, turn on the horn, 
or turn on the audible alarm). Alarms may be added or subtracted from the software without notice. 

 

Use as Alarm 

This is the normal setting. 

Count Only 

If one or more of the System Error alarms have Count Only selected, then those alarms will be used 
as a warning. In the View/Clear Alarms screen, the LED will be yellow if the alarm is triggered (instead 
of red). The Count Only alarms will NOT light any light in the light tree, sound the horn, nor cause the 
red flashing ALARM button over the Lane button. 

 Note: We do not recommend using Count Only for any of the System Error alarms, unless the 
system has a problem where a specific alarm is frequently triggered and thus overshadows other 
alarms. 

Click the OK button  to apply changes and exit the menu. 
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Lane Alarms Description 
The available Lane alarms are as follows: 

Percent Defects 

This alarm is triggered when the percentage of defective parts from a Lane exceeds the Percent 
Trigger. It will remain triggered until you clear the alarm. It uses the red light of the light tree as a 
visual indicator. 

Offline 

This alarm indicates whether the system is online or offline. The green light of the light tree is on 
when the system is online. The green light turns off and the red light turns on when the system goes 
offline. 

Chute Full 

This alarm is mainly used in systems that have inspection modules installed within a blow molder, 
and use the blow molder’s internal reject chute. It is triggered when the blow molder’s internal reject 
chute is full. This alarm may not apply to your system. It uses the red light of the light tree as a visual 
indicator. 
If this alarm is enabled and triggered, the blow molder’s internal rejector will be disabled, thus not 
allowing any more defective parts to be rejected. The rejector will remain disabled until you clear the 
chute and then clear the alarm from the alarms tab. If you clear the alarm without clearing the chute, 
the alarm will be triggered again. 

 Note: This alarm is disabled when the Intellispec is offline. 

Blow Molder Door Open 

This alarm is used for systems that have inspection modules installed within a blow molder. It is 
triggered when the blow molder door is opened. It will remain triggered until the door is closed. It 
uses the red light of the light tree as a visual indicator. This alarm may not apply to your system. 

 Note: In PET Preform applications, this alarm is triggered when the Bypass Gate opens. 

Power Status 

This alarm is triggered when Lane AC power is lost. It remains triggered until AC power is restored. If 
AC power remains off for an extended period of time, the system will shut down. 
The red light of the light tree will switch on when Lane AC power is lost. The blue light should remain 
on as long as the Lane power is on. 

Good Parts 

This alarm can be used as a part counter. For example, say you are inspecting preforms, and have a 
box at the end of the conveyor (after inspection) that holds 5000 preforms. This alarm will count the 
number of good inspected parts, and notify you when 5000 good parts have reached that box. The 
Alarm Output through the optional Extended I/O can be used to stop the conveyor from moving 
parts into the inspection system. You can then install a new box at the end of the conveyor, reset this 
alarm, and start counting the next 5000 parts. 
This alarm is triggered when a number of good inspected parts [Trigger (thousands)] has been 
reached. It will remain triggered until you clear the alarm. It uses the red light of the light tree as a 
visual indicator. Note that clearing this alarm also clears the Good Parts count. 
See also information about the optional Extended I/O module. 

Missed Reject 

This alarm works in conjunction with Reject Confirm (see "Reject Confirm Calibration (Optional)" on 
page 95). It is triggered when a missed reject occurs. It uses the red light of the light tree as a visual 
indicator. There will be two Missed Reject alarms available if two rejectors (see "Rejector Enable/ 
Disable" on page 78) are enabled and two Reject Confirm rejectors (see "Reject Confirm Calibration 
(Optional)" on page 95) are enabled. 
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System Error 

System Error is a group of several internal system alarms. Click the System Error LED on the Lane 
Alarms screen to see all the alarms and their statuses. See also Lane Alarm Configuration (on page 
52) to see how this alarm is configured. 

 
These errors are recorded in the Log Reader (on page 66). Some of these are described below. Other 
system error alarms may be added and shown on the screen, or removed without notice. 

 Part Tracker Lost Communication - You may be able to reset the Part Tracker to re-establish 
communication. See Resetting the Part Tracker Board in FHCP 3X. 

 Internal Error - an internal error was logged. This usually requires Pressco technical assistance. 
 

Sensor Alarm Configuration 
In the Sensor Alarm Configuration pop up window, you can edit alarm settings for an entire Sensor. To 
see a description of each type of alarm, see Sensor alarms description (on page 59). 

 Note: Some menu items are only available to advanced level users. 

 To get to this menu: 

1. Log in. 

2. View either the Lane Overview or Sensor Overview screen by clicking a Lane n or Sensor n button. 

3. Click the Alarms button  to view the Alarms menu. 

4. From the Alarms menu, select Sensor Alarm Configuration. 
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5. Choose a sensor to configure. You must configure each sensor separately. 

 

Select an alarm from the drop-down menu to configure that alarm. You can enable or disable 
parameters for each alarm individually. A check mark appears in the box next to the parameter, and the 
name of the alarm, when it is enabled. The parameters are described below. 

For numeric values, you can change the numbers with the slider bars or click in the box to the right of 
the slider to nudge the number up or down, or bring up a numeric keypad to enter a new value. 

Alarm Enabled 

Enables alarm. 

Minimum Count 

Specify the minimum number of parts that must be inspected before the alarm can be triggered. This 
prevents the alarm from being triggered too soon, when only a small number of parts may make the 
statistics trigger the alarm. 
Minimum Count is used in the Percent Rejects alarm. 

Sample Size 

Define the number of parts that must be inspected to determine the excessive warning percentage. 
This number is selectable between one and 100,000. The default value is 100. This is a sliding 
window: for example assume Sample Size = 1,000 and Percent Trigger = 3. If three percent of the last 
1000 parts have had a warning status, the alarm is triggered. 
Sample Size is used in the Excessive Rejects and Excessive Warnings alarms. 

Trigger [%] 

Define the percentage of parts inspected that must fail to trigger the Percent Defects alarm. This 
number is selectable between zero and 100. The default value is five percent. 
Trigger [%] is used in the Percent Rejects, Excessive Rejects, and Excessive Warnings alarms. 

 Note: you can change this percentage in the Trend Charts (see "Alarm Percentages in Trend Charts" 
on page 40) in Sensor Overview mode when Defect % is selected for the V-axis. 

Consecutive Triggers 

Define the number of defects in a row that the system must have to trigger the alarm. This number is 
selectable between two and 100. The default value is 25. 
Consecutive Triggers is used with the Consecutive Defects alarm. 

Audible Enabled 

If this parameter is enabled, the audible alarm will sound when triggered. 
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Audible Duration 

The number of seconds the audible alarm will sound if triggered. It will remain on until the alarm is 
cleared. Use the slider to set values up to 3600 seconds (60 minutes), or use the drop-down menu 
option to allow the alarm to remain on forever (until cleared). 

Visual Enabled 

If this parameter is enabled, this alarm will switch on the appropriate light on the light tree when 
triggered. 

Visual Duration 

The number of seconds the light will remain on when the alarm is triggered. It will remain on until 
the alarm is cleared. Use the slider to set values up to 3600 seconds (60 minutes), or use the 
drop-down menu option to allow the alarm to remain on forever (until cleared). 

Alarm Outputs 

Select an output (Inspection Alarm 0-14) to be toggled on the optional Extended I/O kit when the 
alarm is triggered. 

 Note: if your system has firmware version F168 or higher, there are 16 Alarm Digital Outputs. 
They are numbered 0-15. Firmware versions below F168 support 15 Alarm Digital Outputs 
numbered 0-14. 

 There are 15 available Inspection Alarm outputs that correspond to the extended I/O signals. 
Click one of the output numbers to assign the current alarm to an output. 

 These outputs go active when the alarm is triggered, and go inactive when the alarm is cleared. 

 The outputs can be monitored by your plant equipment, such as a PLC, to notify you when 
certain alarms are triggered. 

Disable All Alarms 

Click this button to disable all the current alarms at once. This disables only the alarms for the 
current sensor or lane. This is used in emergencies when you cannot repair a situation immediately, 
or when setting up the system. The remaining parameter settings for each alarm are saved for future 
use. You must re-enable each alarm individually when you are ready. 

System Error Alarm Details 

The System Error Alarm cannot be disabled. However, there is a Details button that shows whether it is 
being used as an alarm (to light the red light of the light tree, turn on the horn, or turn on the audible 
alarm). Alarms may be added or subtracted from the software without notice. 

 

Use as Alarm 

This is the normal setting. 

Count Only 

If one or more of the System Error alarms or Missed Reject have Count Only selected, then those 
alarms will be used as a warning. In the View/Clear Alarms screen, the LED will be yellow if the alarm 
is triggered (instead of red). The Count Only alarms will NOT light any light in the light tree, sound the 
horn, nor cause the red flashing ALARM button over the Lane button. 
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 Note: We do not recommend using Count Only for any of these alarms, unless the system has a 
problem where a specific alarm is frequently triggered and thus overshadows other alarms. 

Click the OK button  to apply changes and exit the menu. 
 

Sensor Alarms Description 
The available Sensor alarms are as follows: 

 Note: parameters, such as Percent Trigger, are adjusted in the Sensor Alarm Configuration (on page 
56). 

Percent Rejects 

This alarm is triggered when the total percentage of defects for the current sensor exceeds a defined 
percentage. This percentage is defined with the Trigger [%] parameter. It will remain triggered until 
you clear the alarm. It uses the red light of the light tree as a visual indicator. 

Excessive Rejects 

This alarm is triggered when a percentage of the last n parts have been found defective. It will remain 
triggered until you clear the alarm. n = Sample Size. The percentage is defined with the Trigger [%] 
parameter. It uses the red light of the light tree as a visual indicator. 

Excessive Warnings 

This alarm is triggered when a percentage of the last n parts have been found with a warning status. 
It will remain triggered until you clear the alarm. n = Sample Size. The percentage is defined with the 
Trigger [%] parameter. It uses the amber light of the light tree as a visual indicator. 
Warnings are enabled in the Retro-Spec Options (on page 164) when you are editing an inspection. 

Consecutive Defects 

This alarm is triggered when the sensor has had too many consecutive defects. The number of 
defects is defined by the Consecutive Triggers parameter. It will remain triggered until you clear the 
alarm. It uses the red light of the light tree as a visual indicator. 

System Error 

System Error is a group of several internal system alarms. Click the System Error LED on the right side 
of the View/Clear Alarms screen to see all the alarms and their statuses. See also Sensor Alarm 
Configuration (on page 56) to see how this alarm is configured. Alarms may be added or subtracted 
from the software without notice. 

 
These errors are recorded in the Log Reader (on page 66). 

 Missed Part - No current function. 

 Missed Acquisition - This alarm is triggered if the sensor misses acquiring the image of a part.  
For example, the inspection time was too high, or the part was too deformed to properly detect. 
It will remain triggered until you clear the alarm. It uses the red light of the light tree as a visual 
indicator. See also Sequence of Events (see "Sequence of Events During Inspection" on page 
144). 

 Missed Result - This alarm is triggered if the sensor misses the inspection results of a part. For 
example, the inspection time was too high, or the processor was too busy to process the 
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inspection results before the part reached the reject position. It will remain triggered until you 
clear the alarm. It uses the red light of the light tree as a visual indicator. See also Sequence of 
Events (see "Sequence of Events During Inspection" on page 144). 
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Tools Menus 

This section covers the tools menus that are available through System Overview or Lane/Sensor 
Overview modes. 

 

Tools menu - System Overview Screen 

 To view the Tools menu: 

1. Log in. (Some items may be grayed out if you do not have permissions to use the items) 

2. Click the Home button  to view the System Overview screen. 

3. Click the Tools button  to view the Tools menu. 

 

 

1 Log Reader (on page 66) – Open the Intellispec log 

2 Clear System Statistics – Clear the entire system statistics (all Lanes) 

3 Disk Imaging Software – Open Acronis Echo software for backing up system hard drive 

4 CPU Temperature – Displays the current, warning, and shutdown temperatures associated with the 
computer CPU. If a multiple core computer is used, the highest temperature is displayed. If the shutdown 
CPU temperature is reached, the Intellispec system shuts down. 

5 UPS Information – Display Uninterruptible Power Supply (UPS) information and settings 

6 Chart Configuration – Choose the Trend Graph Type and the number of divisions for the horizontal axis for 
the chart displayed in the System Overview Screen 

7 Defect Writing (see "Enabling/ Disabling Defect Writing" on page 274) - [Only available if Defect Database 
option is installed and enabled] Enable or disable defect recording for multiple lanes. 

8 System - Set system date and time or set up a printer 

9 Exit System – Shut down Intellispec software 

 
 

Chapter 6 
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Tools menu - Lane Overview and Sensor Overview 

Screens 
The Tools menu is the same in both Lane Overview and Sensor Overview screens. 

 To view the Tools menu: 

1. Log in. (Some items may be grayed out if you do not have permissions to use the items) 

2. Click a Lane n button to view the Lane Overview screen. 

3. Click the Tools button  to view the Tools menu. 

 

Reporting (on page 62) 

Part Setup (on page 67) 

Lane Setup (on page 70) 

Hardware Setup (on page 83) 
 

Reporting 

The Intellispec generates many different reports to provide inspection detail. Many of these reports can 
be transferred outside of the Intellispec. 

 Note: Some menu items are only available to advanced level users. 

 To view reports: 

1. View the Lane Overview screen by clicking a Lane n button. 

2. Click the Tools button  to view the Tools menu. 

3. From the Tools menu select Reporting, then select your desired option. These are described 
below. 

 

 

1 Lane Summary Report (on page 63) - Generate a summary of the statistics for the current lane. 

2 Lane Detail Report (on page 64) - Generate a report with the lane and sensor defect statistics broken down 
to inspection-by-inspection data. 

3 Correlation Report - (Only available if correlation is enabled on your system) Generate a report with the 
percentage of defects by machine part 

4 Schedule Reports (on page 64) - Define the frequency and destination for automatic statistics reporting. 

5 Log Reader (on page 66) – Open the Intellispec log 

6 Sensor Missed Statistics (on page 67) - Display the number of missed parts for the lane. 
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7 Defect Data Viewer (see "Defect Data (Images) Viewer" on page 275) - [Only shown if this option is 
enabled] View the images in the defect database 

8 Defect Database (see "Defect Database Viewer" on page 277) - [Only shown if this option is enabled] View 
the inspection data and reports from the defect database 

 
 

Lane Summary Report 

This report lists the statistics summary for the lane, including: 

 Number of parts inspected 

 Number of defects 

 Defect percentage 

The above numbers are reported per sensor, and as an overall number for the lane. An example from a 
one lane system is shown below. 
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Lane Detail Report 

This report contains all the information in the Lane Summary Report (on page 63), plus inspection detail 
for each sensor with the number of defects found by each inspection. An example is shown below. 

 

 
 

Schedule Reports 

Set up a schedule where the Intellispec generates reports automatically. This is a Lane-level setting. To 
schedule reports for more than one lane, you must repeat the process for each lane. 
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 To schedule reports: 

1. Go to the Lane Overview screen by clicking a Lane n button. 

2. Click the Tools button  to view the Tools menu. 

3. From the Tools menu, select Reporting, then select Schedule Reports. The screen shown below is 
displayed. 

4. Change the settings as desired. These are described below. 

5. Click the OK button  to save changes and exit the screen. 

 

Report drop-down menu 

Select which report to schedule, then change the settings in the menu. Each report must be set up 
separately. 

See also Lane Summary Report (on page 63) and Lane Detail Report (on page 64). 

Report settings 

Enable Scheduled Report 

Choose whether to schedule the selected report. When this box is checked, the settings below are 
active. 

Destination drop-down menu 

Choose whether to send the report to the default printer or a file. When Text File is selected, you can 
enter a file name by clicking the File Name button. 
If you do not name the file, then the file is named "PresscoReportnn.txt" where nn is the number of 
the next generated report. It is saved at the hard disk location "c:\Pressco." Subsequently saved 
reports overwrite the file. 

Print on Change-Over 

Schedule the system to generate a report if someone changes a part program. This contains defect 
statistics from the time of the last statistics reset until the time that the part change-over occurred. 
See Change-over Report Example. 

Keep File Name 

When a report is printed to file and this feature is enabled, the system will write the inspection 
statistics to the same file name each time, rather than creating new files with unique names. The 
system overwrites the file each time. You will need to click the File Name button, browse to the 
location where you want to save it, and create a name for your report. 
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An example of where this feature might be used is a plant where the Intellispec is networked. Say the 
office computer is programmed to poll the Intellispec at regular intervals to get the latest statistics 
report. With the same file name, the office computer just needs to request the same file name each 
time, regardless of the date and time the report was saved. 

Reset Statistics 

The Lane statistics are cleared after each print. 

Next Scheduled Report 

Using a 24 hour clock, set the time when the Intellispec should save or print the next report. 

Time Between Reports 

Set the time interval when the Intellispec should save or print the following reports. This interval is 
used after the Next Scheduled Report, and is repeated the set number of hours and/or minutes 
thereafter. 

 

Log Reader 

The log reader displays the Intellispec event history including: 

 User log in and log out information 

 Part program changes 

 Note: detailed part program changes are found in the Part Program Change Log (on page 150) 

 Alarms, when triggered and cleared 

 System errors 

 System starting information 

 Lane online/ offline history 

 Lighting changes 

Text files of the logs are stored at: C:\Pressco\Logs. 
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Sensor Missed Statistics 

Displays the number of missed parts and missed part tracking for the sensor. 

 

This information is recorded in the Log Reader (on page 66). 

Missed Results 

This can occur if you set the Reject Delay Calibration (on page 88) incorrectly. Another cause could 
be kinks or intermittent connections to cables, or the inspection time for the lane is too long. 

 

Error messages 

Part Tracker Exception 

If you see an error "Part Tracker Exception" on the Intellispec screen, this means that power was lost 
to the Cluster Box or Part Tracker. 

 To reset the part tracker board: 

Push the Reset button on the part tracker board. This is found inside the inspection module or Cluster 
Box. 

Lost Part Tracking 

If you see a "Lost Part Tracking" message, possibly the power was lost to the Cluster Box or Part 
Tracker inside an inspection module. Reset the Part Tracker board as described above. 

 

Part Setup 

The Part Setup menu provides access to lighting, part display options in charts, and part width 
calibration. 

Some menu items are only available to advanced level users. 

 To view the Part Setup menu: 

1. View the Lane Overview screen by clicking a Lane n button. 

2. Click the Tools button  to view the Tools menu. 

3. From the Tools menu select Part Setup >> then your desired option. These are described below. 
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1  Advanced Adjust Lighting (on page 118) 

2 Basic Adjust Lighting (on page 117) 

3 Clear All Defect Images - Remove all images from the Reject Images buffer. 

4 Change Part Type - Select the type of part to be displayed on the Walk By Graphic for the current lane. 

5 Set Cost Per Part - Set the cost of each product, to be used with the "Defect Cost" trend chart. 

6 Image Analysis (on page 114) - Determine the gray shade value for any pixel or group of pixels in your 
image. 

7 Part Width Calibration (on page 68) - Set the number of encoder pulses that the part detect sensor "sees" 
the part. 

8 Select Inspections For Charts - Select which inspections (up to 8) to display on the Trend Chart and Timing 
Trend. 

9 Part Notes - Add setup and programming information about the part. This is especially helpful if you or 
someone else need to modify the part program later. 

 
 

Part Width Calibration 

Part Width is the number of encoder pulses that the part detect sensor "sees" the part. To perform the 
calibration you must be running parts past the part detect sensor. 

 To get to the Part Width menu: 

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu (on page 
111). 

2. Select Part Tracking, then select Part Width Calibration. 
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 To calibrate the Part Width: 

1. With parts running under the camera or sensor, click Start Calibration. As each part goes by its 
part width will be displayed in Part Width field. 

2. After a sufficient number of parts have gone by (we recommend about 10 parts), click Stop 
Calibration (same button as Start Calibration). This will display the calibration results in the lower 
part of the screen. 

3. Examine the results; look for the minimum and maximum values to be within approximately 10 

encoder pulses of each other. If the results are acceptable click OK  to save the data. If the 
results are skewed, recalibrate the part width. To exit without saving the changes, click the exit 

 button. 

4. The system will prompt you to confirm your changes. If the results are acceptable click OK  to 

save the data. If the results are skewed, click the cancel  button and recalibrate. 
 

Part Rate 

In Intellispec systems with software version 5.0.440 and later, the part rate is displayed in Lane Overview 
and Sensor Overview modes. 

You can reset the part rate by right-clicking over the part rate tab and clicking Reset Part Rate. 

The part rate displays: 

a) ppm (parts per minute) - The average rate over the last five seconds. It is updated once per second. 
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b) max -  The maximum rate found for all individual parts in the last five seconds determined in [a]. 
The displayed value is the largest value found in the last five minutes. 

 
 

Lane Setup 

Some menu items are only available to advanced level users. 

 

 

1 Change Lane Name - Change the name of the current lane. 

2 Change Sensor Name - Change the name of the selected sensor. 

3 Image Display Configuration (on page 71) - Set the frequency, rotation, and other display options for the 
sensor images. 

4 Machine Part Correlation (on page 72) - Configure up to four different machine parts for correlation. [This 
option only appears when Correlation is configured] (This is usually done by the Pressco installer) 

5 Manage Part Programs (on page 74) - Create, delete, or edit part programs. 

6 Remote Part Program Switching (on page 76) - Select one of two part programs remotely. 

7 Miscellaneous Configuration (on page 78) - Change settings for Missed Results, Inspection Warnings, and 
Defect Database (not currently available). 

8 Defect Recording Configuration (see "Preparing the Database" on page 271) - [only shown if this option is 
enabled] Enable defect recording 
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9 Rejector Enable/ Disable (on page 78) - Enable or disable the rejector for lane or sensors. 

10 SmartCAL - SmartCAL is a tool that allows you to load a set of images, run them with the current part 
program, and make sure the part program is passing or rejecting parts as you expect. 

11 Image Source (on page 121) - Select images to display on the lane. 

12 
and 
13 

Start Forced Reject (on page 80) - Force parts to be rejected based on correlation to a specific machine part. 

Stop Forced Reject - Stop the Forced Reject process. 

14 Chart Configuration – Set the number of columns in the Trend Chart and the currency type to be used in the 
"Cost per Part" trend chart. 

15 Statistics Configuration (on page 45) - Change the display settings for the charts displayed by the Statistics 
buttons. 

16 Statistics Grid Configuration (on page 82) - Change the amount of information for the charts displayed by 
the Statistics buttons. 

17 Walk By Setup (on page 36) - Set up the group names, inspections assigned to each group, and the criteria 
determining when the areas of the graphic turn green, yellow, or red. 

 
 

Image Display Configuration 

Adjust the display settings for images. 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu, then select 
Lane Setup, then select Image Display Configuration. 

 

 

1 Set the frequency to update the image in the sensor view window. 
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2 If correlation is used, check this box to display correlation information in the Big Live Image view. 

3 Rotate the defect images, sensor display images (heartbeat), and the Big Live Images by selecting rotation in 
degrees with respect to camera position, or rotation with respect to the orientation (if an orientation is 
being used). 

 
 

Machine Part Correlation 

Configure up to four different machine parts for correlation. Each machine part can be named and 
assigned the correct number of stations. The offset bar is used for calibrating the displayed part with the 
actual machine part. 

 Note: This screen is usually set up by the Pressco installer. 

 To get to this screen: 

From the Lane or Sensor overview screen, click the Tools button  to see the Tools menu, then select 
Lane Setup, then select Machine Part Correlation. 

 

Number Of Machine Parts 

Select the number of correlation sensors in your system (1-4). 

 Note: If you only see two Machine Parts available, you probably have a two channel Part Tracker 
board. This is the default configuration. 

 If your system has an eight channel part tracker board, you must run the Discovery software and 
configure the lane for an eight channel part tracker board. Use the Edit Existing Lane function. This 
will provide the capacity for four Machine Parts to be configured. 

Name 

Rename each machine part to something more recognizable to you (examples: Cavity, Spindle, or 
Liner Gun #1). This name will be displayed on the Intellispec screens and throughout correlation 
reports. 
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Source 

Select between Hardware and Part Program to provide correlation. Some applications have 
inspections from which you can derive correlation information. 

Number 

Set the number of components in each machine part (example, number of pockets in a starwheel). 

Offset 

This allows you to change the mapping between what the inspection system considers part #1 (or 
pocket #1) and the actual parts. For example, if you try to reject a part from cavity #1, and the system 
rejects the part from cavity #2, then you would set offset at 1. This information is required to be 
correct for the inspection system to track components properly. 

Outfeed Transfer Sequential 

(only available when four sensors are used, and only applicable to blow molder installations) Specify 
whether the infeed and outfeed transfer arms are numbered Independently or Sequentially. For 
example, say your machine has 10 infeed transfer arms and 10 outfeed transfer arms. If they are 
numbered Independently, the infeed transfer arms would be numbered 1 - 10, and the outfeed 
transfer arms would be numbered 1 - 10 as well. If they are numbered Sequentially, the infeed 
transfer arms would be numbered 1 - 10, and the outfeed transfer arms would be numbered 11 - 20. 

Outfeed Linked to Infeed (MP4 to MP3) 

(applicable to blow molder installations) Enable this to derive the outfeed correlation count (MP4) 
from the infeed correlation count (MP3). This is typical of most blow molders. For example, in an 
SBO20 machine, the infeed count will be from 1 - 10. The outfeed count will be from 11 - 20. Infeed 
count 1 will correspond to outfeed 11, and so forth. 

 Note: When this feature is enabled, the number of components is forced to be equal (number of 
components in MP3 = number of components in MP4 ). 

 Note: There is no index sensor for MP4 in the hardware configuration. 

Dual Cavity System 

(only available when four sensors are used, and only applicable to blow molder installations) Enable 
this if your system is a dual cavity machine. 

Show correlation values in images 

Displays the correlation value in the images. These values are saved as part of the image file (if you 
save images). 
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Manage Part Programs 

Create new part programs or delete, edit, rename, import or export existing part programs for all the 
different products inspected with the system. 

 To get to this screen: 

 From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu, then 
select Lane Setup, then select Manage Part Programs. Or:  

 Right-click the Part Program drop-down menu. 

 

For information on using this screen see: 

 How to Create, Copy, or Import a Part Program (on page 144) 

 Export a part program (on page 75) 

 Load a Part Program (on page 75) 
 

Delete a part program 

You can delete a part program to prevent other users from running it. 

 To delete a part program: 

1. Go to a Lane Overview or Sensor Overview screen [from Home: Lane button > Sensor button]. 

2. Load a known good part program, one that you will not delete. You cannot delete the currently 
running part program. 

3. Right-click over the part program drop-down menu. The Manage Part Programs menu is displayed. 

4. Highlight the program name in the Manage Part Programs menu, then click the Delete button. 

5. A warning box will ask you if you are sure you want to delete the program. Click the OK button  
to delete the program. The program is deleted from memory. 
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Right-click 

 

 
 

Load a part program 

You can switch part programs by loading a different part program from disk. 

 To load a part program: 

1. Go to a Lane Overview or Sensor Overview screen [from Home: Lane button > Sensor button]. 

2. Right-click over the part program drop-down menu. The Manage Part Programs menu is displayed. 

3. Highlight the program name in the Manage Part Programs menu, then click the Load button. The 
program name will appear in the Part Program drop-down menu on the Lane Overview or Sensor 
Overview screen. 

4. Click the OK button  to exit the Manage Part Programs menu. The new part program is loaded 
into the Intellispec memory. 

 

Right-click 
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Export a part program 

You can export a part program to use it on another sensor, lane, or Intellispec. 

 

Right-click 

 

 To export a part program: 

1. Go to a Lane Overview or Sensor Overview screen [from Home: Lane button > Sensor button]. 

2. Right-click over the part program drop-down menu. The Manage Part Programs menu is displayed. 

3. Click the Import/Export button. The Import or Export Part Programs menu is displayed. 

 

4. Click the disk icon  to browse to the folder or USB destination to export the part program. 

5. Highlight the part program that you want to export in the Current Part Programs column. 

6. Click the right arrow button  to export the part program. 

7. Click the OK button  to exit the Import or Export Part Programs menu. The part program is 
exported. 

8. Click the OK button   to exit the Manage Part Programs menu. 
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Remote Part Program Switching 

 Note: this feature is available in versions 5.0.493, 5.2.026, 5.3.005 and higher versions of software. 

The Remote Part Program Switching function is used to select one of two part programs remotely 
through a PLC. 

 To use Remote Part Program Switching: 

 Your system must have an Extended I/O board connected to the tracker board for the lane on which 
you are using the function, and 

 You must have user access permission to Manage Part Programs. See Managing Permissions. 

 You must have at least two part programs already configured 

 To use the Remote Part Program Switching menu: 

1. From Lane Overview or Sensor Overview mode, select the Tools  button > Lane Setup > 
Remote Part Program Switching. This item will be disabled if there is no Extended I/O board or if 
the system is online. 

 

2. Enable the function by checking the Enable Remote Part Program Switching box. 

3. Select Part Program 1 from the drop-down list available. 

4. Select Part Program 2 (different from Part Program 1) from the drop-down list available. 

5. Select the OK button to complete the selection and exit. The Remote Part Program Switching 
function is enabled. 

Connect to the Extended I/O board. Reference these topics: 

 Extended I/O board 

 Extended I/O signals 

 Extended I/O circuits (for information about how to connect your equipment to the board) 

 On the Extended I/O board, follow this sequence to select a part program: 

1. Set Input Port Strobe (J1-11) low. 

2. Set Generic Input 0 (J1-3) and Generic Input 1 (J1-4) low. 

3. Pulse Input Port Strobe high and then low. (This clears the input state.) 

4. Set either Generic Input 0 or Generic Input 1 high. 
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5. Pulse Input Port Strobe high and then low. (This selects part program 1 if Generic Input 0 is high or 
part program 2 if Generic Input 1 is high.) 

Timing considerations are as follows: 

 Generic Input change to Pulse Input Port Strobe transition 10 microseconds minimum. 

 Input Port Strobe high time 10 microseconds minimum. 

 When the above sequence is performed, the system will go offline which brings System State (J4-16) 
low. The part program is changed and then the system is put back on line which sets the System 
State output high. 

 The part selection sequence can be commanded when the system is offline. In this case, the part 
program is changed but the system does not go online automatically. 

 

Miscellaneous Configuration 

Enable or disable additional lane options. 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu > Lane 
Setup > Miscellaneous Configuration. 

 

Reject Missed Results 

A missed result occurs if the system misses the inspection results of a part. This can happen if the 
inspection time is too long or if the system is too busy to process all the data before the part reaches 
the reject station. 
Check this box if you want the system to reject parts from any missed results in the current Lane. 

Disable Inspection Warnings 

Inspections can have reject and/or warning limits. A warning allows you to perform maintenance or 
adjustments before the system starts rejecting parts. 
The warning limits are represented by the yellow adjustable slider bar on the Retro-Spec graphs. If 
you do not wish to use warning limits, check the Disable Inspection Warnings box. 

 

Group Priority Level 

This feature allows you to assign a priority to each group within the Walk By graphic. You can 
designate which defects are more important and prioritize the reporting structure accordingly. See 
Group Priority Level 
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Rejector Enable/ Disable 

Enable or disable the rejector at the Sensor level or at the Lane level. 

 If one or more Sensors are checked, the reject device for all inspections performed by those Sensors 
is disabled. 

 

 If all Sensors are checked, the reject device is disabled at the Lane level. An icon is displayed in the 
Lane window to indicate that the rejector is disabled. 

 Note: the trash can symbol is only displayed if ALL sensors within the lane are disabled. 

 

 To enable or disable the rejector for one sensor only: 

1. Go to Sensor Overview mode. 

2. Right-click over the desired sensor button to see the Sensor menu. 

3. Click "Reject Enabled" to toggle it to "Reject Disabled" or vice versa. If Reject Enabled is displayed, 
the rejector is enabled. 

If you put the system online when the Sensor rejector is disabled, you will see a message stating "Sensor 
Rejector Disabled - Do you want to go online?" 

 To enable or disable the rejector for one or more sensors within a lane: 

1. From Lane Overview or Sensor Overview mode, click the Tools button  to go to the Tools 
menu. 

2. From the Tools menu, click Lane Setup, then select Rejector Enable/ Disable. 

3. Check or un-check the box next to the sensor(s) to enable or disable the rejector. 
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4. Click the OK button to apply the changes and exit the menu. The new setting is applied. If the 
rejector for all sensors within the lane is disabled, you will see the trash can icon near the statistics 
for that lane. 

 

If you put the system online when the lane rejectors are disabled, you will see a message stating "Lane 
Rejector Disabled - Do you want to go online?" 

 
 

Forced Reject 

The Forced Reject feature allows you to force any part to be rejected. The system will reject all parts 
associated with the checked components, regardless of the pass/fail condition of those parts. This 
provides a means of handling an emergency situation until repairs on a blow-molder or other machine 
can be made. If you know there is a serious problem with a particular component, you can use this 
method to ensure that no part from the defective machine component passes the inspection process. 

 Note: the correlation check boxes and machine parts are only displayed if your machine is using 
correlation. 
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 To get to this menu: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu, then select 
Lane Setup, then select Start Forced Reject. 

 

The parts of the menu are as follows: 

 Note: The lane must be online to force rejects. 

Reject One Part/ Reject N Parts/ Continuous Reject 

Reject one part, ‘N’ parts, or continuously reject from a specific machine part. To begin rejecting, 
click the Start Forced Reject button. 
Reject One Part - rejects the next part that reaches the reject station, regardless of its inspection 
status. If you select Single or Combined Machine Parts in the above drop-down menu, the part must 
meet that criteria. 
Reject N Parts - the numeric field next to this drop-down menu becomes active. Enter a number of 
parts you want to reject, regardless of their inspection status. If you select Single or Combined 
Machine Parts in the above drop-down menu, the part(s) must meet that criteria. 
Continuous Reject - rejects all parts regardless of their inspection status, until you click the Stop 
Forced Reject button. If you select Single or Combined Machine Parts in the above drop-down menu, 
the part(s) must meet that criteria. 

Skip N Parts Between Parts 

Uses the criteria set up with the Reject One Part/ Reject N Parts/ Continuous Reject menu, adding a 
number of parts that you specify between rejected parts. 

Cavity /spindle/ infeed/ outfeed 

The names displayed in this section will correspond to the names of your machine part components. 
These are only shown if you select Single or Combined Machine Parts in the first drop-down menu. 
Specify the number of the machine part correlated to the part you want rejected. 

Rejector 

(Not shown in the above screen) Specify which rejector to force rejection of part. If you only have 
one rejector, then this button is not applicable. 

Numeric Keypad 

This is used to type values for numbers or series of rejected parts or correlation to machine parts. 
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Start Forced Reject/ Stop Forced Reject 

When you click Start Forced Reject, the criteria specified in the menu is applied and the parts are 
rejected. Click the Stop Forced Reject button to stop the reject process. Note that if you only reject 
one part, or specify a number of parts, the button toggles back to Start Forced Reject automatically. 

Status Box 

Displays information about the rejection process. 
 

Statistics Grid Configuration 

Choose how the statistics grids are displayed. 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu, then select 
Lane Setup, then select Statistics Grid Configuration. 

 

 

1  Checking these boxes determines what information is shown on the Statistics Grid screen. 

2 These two slidebars allow you to enable/disable and determine the setting for warning and error limits 
applied to the Statistics Grid screen. 
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Hardware Setup 

Some menu items are only available to advanced level users. 

 

 

1 I/O Diagnostics (on page 83) - Verify the presence of input and output signals. 

2 Extended I/O Configuration - Configure the optional Extended I/O board. 

3 Correlation Diagnostics (on page 84) - Verify correlation signals. 

4 Offline Imaging (on page 113) - Choose how the Intellispec acquires images when the lane is offline. 

5 Part Present Delay Calibration (on page 85) - Calibrate the distance (in encoder pulses) from the part detect 
sensor to the camera centerline. 

6 Part Present Delay with Encoder (on page 87) - Coarsely calibrate the part present delay by using encoder 
counts. 

7 Reject Delay Calibration (on page 88) - Calibrate the distance (in encoder pulses) from the part detect 
sensor to the rejector. 

8 Use part tracker simulation (on page 92) for troubleshooting or if a part detect sensor is bad. A simulated 
part rate would allow inspection to continue. 

9 PDX Configuration (on page 93) - Set up the part detect generator. Only used in some applications. 

10 Missed Packets Exception (on page 95) - Set the number of missed packets to trigger the part tracker to 
send a Lost Part Tracking message to the Intellispec. 

 
 

I/O Diagnostics 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu > Hardware 
Setup > I/O Diagnostics. 

This screen can be used to verify the presence of input and output signals. Part rate and encoder rate are 
also displayed. 
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 Green lights are input signals (signals that originate outside the Intellispec and are communicated to 
the system). When an input is received the light is on. 

 Red lights are output signals (signals that originate inside the Intellispec and are transmitted out of 
the system). When an output is generated the light is on. You can test an output signal by clicking on 
the appropriate light. 

 

The outputs correspond to the hard-wired input and output signals throughout the Intellispec system. 

Encoder counts 

At the bottom of the screen, you can use the diagnostics and buttons to count encoder pulses. This is 
used as an approximate number of encoder counts to assist in setting up part tracking sensors along 
with other machine part hardware. 

 Note: due to start and stop time of machine components, the encoder count will not be exact. This 
tool is used for approximation of encoder counts. 

Encoder Counts 

The encoder count from the part tracker board. The board continually counts, and restarts at zero 
when you press the Reset button. 

Start button 

Begin displaying encoder pulses. 

Stop button 

Stop updating the encoder pulse display. The part tracker will remain counting, but the display will 
stop updating. 

Reset button 

Reset the part tracker board encoder count. 
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Correlation Diagnostics 

This is a troubleshooting tool to verify that correlation sensor information is being received by the 
Intellispec. 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu, then select 
Hardware Setup, then select Correlation Diagnostics. 

 

For systems that have correlation sensors, this screen is used to verify that the correlation sensor 
information is being received by the system. It is a troubleshooting tool. 

As the production unit is operating, if the correlation sensor is transmitting pulses, it will come up in the 
appropriate window. For example, if you have a cavity sensor attached to machine part one (MP1) and 
are running an 8-cavity blow molder, you will see MP1 increment from 1-8 repeatedly. 

Make sure that each machine part (MP) increments according to the number of components in your 
system. 

MP = Machine Part. MP1 through MP4 correspond to the correlation sensors that you have configured in 
the Machine Part Correlation (on page 72) screen. 

 

Part Present Delay Calibration 

Part Present Delay is the distance (in encoder pulses) from the part detect sensor to the camera 
centerline. Two independent signals are generated: 1) light strobe and 2) camera snap. 

 Note: if your system is using a PDX, set up PDX Configuration (on page 93) before Part Present 
Delay. 

The Part Present Delay ensures that your part is in the center of the image when the camera snaps its 
picture. Depending on the orientation of your camera, your part could be moving from left to right, right 
to left, top to bottom or bottom to top as it travels through the camera’s field of view. You need to be 
aware of the part flow direction in order to set up the Part Present Delay Calibration. 

For an illustration of Part Present Delay within the inspection process, refer to the Sequence of Events 
During Inspection (on page 144). 

Even if you are unsure what the Part Present Delay value should be, you can view the strobing of the 
lights to gauge whether the delay has been set too long or too short. When the Part Present Delay value 
has been set too short, the lights will strobe before the part reaches the camera; likewise when the delay 
is set too long, the lights will strobe after the part has passed the camera. When the part is close enough 
to be in the actual image that the camera acquires, you can use the image itself to center the part. A Part 
Present Delay calibration needs to be done for each camera in the system. 
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Calibration 

When you calibrate the Part Present Delay, it is ideal to only use one part at a time. Otherwise, it will not 
be easy to determine if the part detected is actually the same part in the image or the part rejected (for 
Reject Delay) since all the parts look alike. If it is not possible to use only one part, an alternative is to use 
a different color part. You will most likely use a few parts to test the calibration, or run the same part 
through several times. 

 

 To calibrate the Part Present Delay: 

 Note: you must be logged in with proper user access to calibrate the Part Present Delay. 

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu (on page 
111). 

2. Select Part Tracking, then select Part Present Delay Calibration. 

3. Click the Start Calibration button. 

4. Place a part onto the conveyor or into the part stream. The part will trigger the part detect sensor, 
then the system will count the number of encoder pulses and take a picture. 

5. Manually adjust the part present delay (encoder ticks) value until the image is centered every time 
a part is run through the system. 

6. When completed, click the Stop Calibration button. The Part Present Delay calibration value is 
saved and stored in a Lane configuration file. 

Advanced settings 

 Note: Advanced settings are normally set at the Pressco factory. You should not need to adjust them. 
Normal settings are listed below. 

Set a Base/Neck configuration as follows: 
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Camera Strobe Delay Trigger Delay Part Present Delay 

Base 5 0 same as Neck 

Neck 5 30 same as Base 

Also check Advanced adjust lighting - set delay (on page 119) to make sure that the Neck lighting delays 
are set correctly. 

 

Part Present Delay with Encoder 

This tool provides a rough calibration of the part present delay by using encoder counts. You can fine 
tune the calibration using the Part Present Delay Calibration (on page 85) tool. Up to eight buttons 
(sensors) may be displayed on this screen, depending on your system configuration. Each part present 
delay is set separately, unless the sensors use the same sensor trigger (as in Base/Neck modules). 

 

 To set the Part Present Delay with Encoder: 

1. Run the conveyor or machine slowly or by hand, and place a part before the part present sensor. 

2. When the part reaches the part present sensor, and you see the Part Present LED flash on the 
inspection module or cluster box I/O box, select the Reset button to set the encoder count to zero. 

3. Press the Start button to begin counting encoder pulses 

4. Run the conveyor slowly so that the part passes in front of or underneath the sensor. 

5. When the part reaches the sensor, press the Stop button to stop counting encoder pulses. 

6. Press a sensor button [example: Neck or Dome] to apply the encoder counter to the sensor's Part 
Present Delay value. 

7. Repeat this process for the remaining sensors. 

8. Select the OK button  to save changes and exit. 

ENCODER COUNTS 

Encoder Counts 

The encoder count from the part tracker board. The board continually counts, and restarts at zero 
when you press the Reset button. 

Start button 

Begin displaying encoder pulses. 
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Stop button 

Stop updating the encoder pulse display. The part tracker will remain counting, but the display will 
stop updating. 

Reset button 

Reset the part tracker board encoder count. 

 

Reject Delay Calibration 

Reject Delay is the distance (in encoder pulses) from the part detect sensor to the rejector. This signal 
ensures that the correct part is rejected. 

During Reject Delay calibration, the reject device will activate for each part that flows through the 
system. Ensure that the rejector is activated properly and that each part is rejected properly. After 
calibration, ensure that adjacent parts are not being rejected (example, from too long a reject dwell 
time), nor being knocked off by the rejected part. 

For an illustration of the Reject Time Delay within the inspection process, refer to the Sequence of 
Events During Inspection (on page 144). 

 

 To calibrate the Reject Delay: 

 Note: you must be logged in with proper user access to calibrate the Reject Delay. 

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu (on page 
111). 

2. Select Part Tracking, then select Reject Delay Calibration. 

3. Click the Start Calibration button. 

4. Place a part on the running conveyor or into the part stream. After the number of encoder pulses 
shown in the Reject Delay box, the rejector will be activated. 

5. Make sure the correct part was rejected. 

6. Continue to insert parts into the part stream. 

7. Manually adjust the reject delay (encoder ticks) until the correct part is rejected every time. 

8. Adjust the Reject Dwell so that it is long enough to completely reject the part, and short enough 
that only one part is rejected for each reject pulse. 

9. When completed, click the Stop Calibration button. The Reject values are saved and stored in a 
Lane configuration file. 
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Reject Dwell 

The duration of the reject signal. Dwell can be set by encoder ticks or by milliseconds. Select the 
correct button for your application. This signal must be long enough to ensure the part is efficiently 
rejected, and short enough to ensure that only one part is rejected for each reject pulse. 

Adaptive Reject 

Adaptive Reject (optional) (on page 89) 
 

Adaptive Reject (optional) 

This topic applies if your system has Part Tracker firmware version F185 or higher. If you have this 
firmware, the Reject Delay Calibration will show "Max Encoder Frequency" in the lower menu. If your 
menu shows "Diff. from Calibration [%],", then go to Adaptive Reject (optional) - older version (see 
"Adaptive Reject (optional)" on page 91). 

This feature is used to compensate for the reject device’s turn-on time delay with varying speeds of 
machine operation. An example where this is used is on a Belvac machine. The turn-on time of the reject 
device might be over one-half of a can width at high machine speeds. The Adaptive Reject will delay the 
activation of the reject device as a function of encoder speed. As the belt (or production line) slows 
down, more delay is added. 

Adaptive Reject allows for different speeds without having to recalibrate between part types. 

 For best results when using Adaptive Reject: 

 Calibrate the Reject Delay (see "Reject Delay Calibration" on page 88) and Reject Dwell at the 
fastest possible conveyor or production line speed prior to enabling the Adaptive Reject function 

 Calibrate the Reject Delay when the conveyor or production line is running at a constant speed -- 
not during a startup or stopping 

 Note: Adaptive Reject will not function properly if the reject device delay is greater than the spacing 
between parts. 

 To set Adaptive Reject: 

1. Go to the I/O Diagnostics (on page 83) screen and record the encoder rate while the line is 
running at max speed. 

2. Go to the Reject Delay Calibration menu: Right-click over a sensor button > Part Tracking > Reject 
Delay Calibration. 

3. Click the check box next to Use Adaptive Reject in the Reject Delay Calibration (on page 88) menu 
to enable the feature. 

4. Set the Max Encoder Frequency to the value you recorded in step 1. 

5. Set the reject device Turn On Time (usually about 10 ms for air rejectors and about 15 ms for the 
pusher rejector). 
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6. Click the OK button  to save changes and exit the Reject Delay Calibration menu. 

 

Settings for Adaptive Reject: 

Turn On Time 

Latency of the rejector mechanism in milliseconds. 

Max Encoder Frequency 

Maximum encoder frequency of the starwheel or conveyor. 

 Notes: 

 Reject Delay should be calibrated with the system running at the maximum encoder frequency. 

 A positional error will occur if the encoder frequency exceeds the maximum encoder frequency. 

The table below shows the computed value of the delay based on encoder speed and how the resultant 
delay (in encoder ticks) is the same regardless of speed. 

 

Max Encoder 
Frequency (Hz) 

Encoder 
Frequency (Hz.) 

Computed Delay 
(encoder ticks) 
(A) 

Reject device 
turn-on delay 
(encoder ticks) (B) 

Total movement 
(encoder ticks) 
(A + B) 

10000 500 95 5 100 

10000 1000 90 10 100 

10000 2000 80 20 100 

10000 3000 70 30 100 

10000 4000 60 40 100 

10000 5000 50 50 100 

10000 6000 40 60 100 

10000 7000 30 70 100 

10000 8000 20 80 100 

10000 9000 10 90 100 

10000 10000 0 100 100 
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 Computed Delay (Encoder Ticks) (A) = [Max Enc Freq (Hz) – Enc Freq (Hz)] * Reject Turn-on Delay 
(msec) / 1000 

 Rejecter Latency (Encoder Ticks) (B) = Enc Freq (Hz) * Reject Turn-on Delay (msec) / 1000 

 Total Movement = A+B 
 

Adaptive Reject (optional) 

This topic applies if your system has a part tracker firmware version below F185. You can tell by the 
Reject Delay Calibration menu. If the lower part of the menu has "Diff. from Calibration [%]" then follow 
the instructions in this topic. If the menu shows "Max Encoder Frequency" then go to Adaptive Reject 
(see "Adaptive Reject (optional)" on page 89). 

 

This feature is used to compensate for the reject device’s turn-on time delay with varying speeds of 
machine operation. An example where this is used is on a Belvac machine. The turn-on time of the reject 
device might be over one-half of a can width at high machine speeds. The Adaptive Reject will delay the 
activation of the reject device as a function of encoder speed. As the belt (or production line) slows 
down, more delay is added. 

If you do not know the fastest conveyor or production speed when you are setting Reject Delay, you 
could calibrate the Reject Delay again when you run a different part at a different production speed. 
Adaptive Reject allows for different speeds without having to recalibrate between part types. 

 For best results when using Adaptive Reject: 

 Calibrate the Reject Delay (see "Reject Delay Calibration" on page 88) and Reject Dwell at the 
fastest possible conveyor or production line speed prior to enabling the Adaptive Reject function 

 Calibrate the Reject Delay when the conveyor or production line is running at a constant speed -- 
not during a startup or stopping 

 Note: Adaptive Reject will not function properly if the reject device delay is greater than the spacing 
between parts. 

 Before calibrating Adaptive Reject: 

1. If you have not done so already, calibrate Reject Delay and Dwell. See Reject Delay Calibration (on 
page 88) for more information. 

2. Write down or make note of the Reject Dwell value after Reject Delay calibration. You will need to 
temporarily change this during Adaptive Reject calibration. 

 To calibrate Adaptive Reject: 

1. Click the check box next to Use Adaptive Reject in the Reject Delay Calibration (on page 88) menu 
to enable the feature. 

2. Set Reject Dwell to zero during the Adaptive Reject calibration process. 

3. Run the conveyor or production line at the fastest speed that you will use, and click the Start 
Calibration button. 

4. Let the conveyor or production line run for about 20 seconds. The part tracker will record the 
maximum encoder frequency. It will use this number to determine the amount of delay to be 
applied to the rejector at all other encoder frequencies. 

5. Click the Stop Calibration button. 

6. Set the Reject Dwell back to the value originally calibrated during Reject Delay calibration (the 
number you noted before calibrating Adaptive Reject). 

7. Enter the Turn On time of the reject device installed in your system. 
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8. Enter a value for Max Encoder Frequency or Diff. from Calibration %, if applicable. See more 
information below. 

9. Click the OK button  to save changes and exit the Reject Delay Calibration menu. 

 

Settings for Adaptive Reject: 

Turn On Time 

Latency of the rejector mechanism in milliseconds. 

Diff(erence) from Calibration (%) 

This number is used if the maximum speed of the conveyor or production line is greater than the 
speed at which the Reject Delay was calibrated. For example, if you calibrated the conveyor for one 
part where the conveyor runs at a slower speed, and know that you will run the conveyor 20% faster 
for another part, then enter 20 for Diff. from Calibration. 
The ideal setting is zero. However, a value of approximately 10 is acceptable, to allow for speed 
fluctuations due to power surges. 

 Note: this value only applies to potential speeds greater than calibration speeds, not slower 
speeds. 
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Part Tracker Simulation 

Use part tracker simulation for troubleshooting or if a part detect sensor is bad. A simulated part rate 
would allow inspection to continue. 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu, then select 
Hardware Setup, then select Part Tracker Simulation. 

 

To enable the simulated part tracker, click the check box and then enter the desired part rate in the 
window. 

Part Rate - Enter a simulated part rate in parts per minute (PPM). 

Encoder Rate and Resolution - Enter the simulated encoder properties. 

 Note: the system cannot run in both PDX (see "PDX Configuration" on page 93) mode and Part 
Tracker Simulation (on page 92) mode at the same time. If one mode is already running and you 
enable the other mode, the system displays a warning that the latest setting will override the 
previous mode. 
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PDX Configuration 

The Part Detect Generator (PDX) is used in some applications where the Intellispec system inspects 
directly on a machine, rather than on a conveyor. The PDX is a circuit built into the Part Tracker board. 

 Note: the system cannot run in both PDX (see "PDX Configuration" on page 93) mode and Part 
Tracker Simulation (on page 92) mode at the same time. If one mode is already running and you 
enable the other mode, the system displays a warning that the latest setting will override the 
previous mode. 

 

 To get to this screen: 

1. From the Lane Overview or Sensor Overview screen, click the Tools button  to see the Tools 
menu. 

2. Select Hardware Setup, then select PDX configuration. The parameters are described below: 

Enable PDX 

Enables the PDX circuit. 

Enable PDX-Generated Pocket 

 If your system is using a physical pocket disk with an index pin, leave this box un-checked. 

 If your system is not using a pocket disk, and you need the Z-index signal of the encoder, check 
this box. This eliminates the need for a pocket disk. The index signal is handled on the Part 
Tracker board. 

Reverse Encoder 

Reverses the direction of the encoder pulses. Instead of the normal A, B sequence of pulses, the 
pulses switch to B, A. 

Encoder Resolution (Pulses Per Rev) 

Enter the resolution of the encoder installed on your machine. 

Number of Parts Per Revolution 

Enter the number of machine parts (example, number of Transfer Arms) to which the encoder is 
attached. 

 To configure the PDX: 

1. Click the Enable PDX check box. 

2. Enter the encoder resolution used on your system (example, 8192 pulses per revolution). 
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3. If your system is NOT using a pocket disk to generate the index signal, check the Enable 
PDX-Generated Pocket box. 

4. Click the OK button  to accept changes and exit. 

 
 

Missed Packets Exception 

For each part and for each camera, two packets of information are communicated: 

 The part tracker sends the host PC a signal stating the camera has been triggered (correlation signal) 

 The host PC then sends a pass/fail signal back to the tracker (results signal) when the inspections are 
done 

A missed packet exception occurs when the part tracker has sent out X number of correlation signals 
without receiving any results signals back from the PC. The default is set at 6. 

When this number has been met a Lost Part Tracking input is received on the Sensor Missed Statistics 
(on page 67) screen. 

 To get to this screen: 

From the Lane or Sensor Overview screen, click the Tools button  to see the Tools menu, then select 
Hardware Setup, then select Missed Packets Exception. 

 

Set the number of missed packets to trigger the part tracker to send a Lost Part Tracking message to the 
Intellispec. 

 

Reject Confirm Calibration (Optional) 

Reject Confirm can detect missed rejects. Coupled with the Missed Reject Alarm (see "Lane Alarms 
Description" on page 55), Reject Confirm will reliably detect and notify you of any missed reject 
condition. 

 Note: Reject Confirm is an optional feature, and an additional sensor must be installed at your site. 

Reject Confirm uses a part detect sensor positioned at a calibrated and defined distance (Reject Confirm 
Delay) past the normal reject mechanism to determine whether the defective part was actually rejected. 
Reject Confirm Delay must be a value of 1024 or less. 

After the rejector fires (meaning the reject delay for a part has passed), the Reject Confirm Delay starts. 
Once the Reject Confirm Delay has passed, the system examines the reject confirm sensor for a period of 
time equal to the Part Width. If the reject confirm sensor “sees” a part within that time, it means that 
the reject was missed. If the reject confirm sensor does not see a part, it means the part was rejected 
successfully. 

If the reject was missed, the Missed Reject Alarm will be triggered. However, the Missed Reject Alarm 
(see "Lane Alarms Description" on page 55) must first be enabled and configured. 



96  Tools Menus Software User's Guide INTELLISPEC™ (Software Version 5.0.501) 
   © 2014 Pressco Technology Inc. Proprietary 
 

 

Below is a timing diagram of the Reject Confirm process. 

 

 

1 Reject Delay (see "Reject Delay Calibration" on page 88) 

2 Reject Dwell (see "Reject Delay Calibration" on page 88) 

3 Reject Confirm Delay, set by Reject Confirm Calibration 

4 Part Width (see "Part Width Calibration" on page 68) 

5 Part Detect (PD) - where the part is first detected by the sensor 

6 Image Acquired - image is taken, inspection is performed 

7 Rejector Station - standard rejection point 

8 Reject Confirm - second part sensor to determine whether a defective part was rejected 

 

 To set up Reject Confirm Calibration: 

1 - Enable the Missed Reject alarm 

Go to the Lane Alarm Configuration (on page 52) to enable the alarm. 

2 - Calibrate Standard Reject Delay 

Calibrate the standard reject delay (see "Reject Delay Calibration" on page 88) using normal procedures. 

3 - Set up Reject Confirm 

Mount the Reject Confirm sensor at “X” distance beyond the rejector where “X” is distance in encoder 
ticks. For example, if there are 70 encoder pulses per inch, and the sensor is mounted five inches beyond 
the rejector, the Reject Confirm Delay would be set to 350. 

 Note: The maximum setting for Reject Confirm Delay is 1024. Mount the Reject Confirm sensor 
within that range of encoder ticks. 

When the Reject Confirm sensor sees a part that is not supposed to be there, it triggers the Missed 
Reject alarm. 
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 To calibrate Reject Confirm: 

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu (on page 
111). 

2. Select Part Tracking, then select Reject Confirm Calibration. 

3. Enable Reject Confirm. 

4. Click the Start Calibration button. 

5. Run a part through the system. 

 Tip: for best results, run about 10 parts through the system. 

6. When completed, click the Stop Calibration button. The system will determine the number of 
encoder pulses from the part detect sensor to the reject confirm sensor. 

Reject Confirm Delay is computed. Reject Confirm Delay = (number of pulses from Part Detect to Reject 
Confirm Sensor) minus Reject Delay. 
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Software Utilities 

This section includes various software utilities that assist with Windows settings, help and support from 
Pressco, and sensor configuration. 

 

Go Online at Startup 
Use this option to have the Intellispec system go online to inspect when you start the software (or 
reboot the computer). This saves the extra step of putting each lane online, and it automatically puts the 
system into inspection mode if power is lost and the computer reboots as a result. 

 To use this option: 

1. Click the Home button to go to System Overview mode. 

2. Click the Tools button to see the tools menu, then select System > Go Online at Startup. A check 
mark is displayed next to the menu item when this is enabled. 

 To disable this option: 

1. Click the Home button to go to System Overview mode. 

2. Click the Tools button to see the tools menu, then select System > Go Online at Startup. The check 
mark is removed when this option is disabled. 

 

Adjusting Date and Time 
Adjust the date and time for the Intellispec system. The Windows operating system time is also changed. 

 To adjust date and time: 

1. Go to System Overview mode by clicking the Home button . 

2. Click the Tools button  to see the Tools menu. 

3. Select System > Set Date and Time. The System Date and Time menu is displayed. 

 

4. Choose your time zone from the drop-down menu. 

5. Enable the check box to automatically adjust for daylight savings time if applicable. 

6. Click the OK button  to save changes and exit. 

Chapter 7 
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Setting up a printer 
Configure a USB or networked printer to print Intellispec reports. The driver for the printer must be set 
up by an Administrator that has access to Windows. 

 To set up a printer: 

1. Go to System Overview mode by clicking the Home button . 

2. Click the Tools button  to see the Tools menu. 

3. Select System, then select Setup Printer. The printer configuration screen is displayed. 

 

4. Select the printer to configure from the drop-down menu. The Intellispec system recognizes 
printers through the Windows drivers. 

5. To test the printer, click the Print Test Page button. A basic "Intellispec Test Page" message is 
printed. 

6. Click the OK button  to save changes and exit. The printer will be ready to use. 

 
 

Creating a Support Package 
A support package is a set of files that is gathered by the Intellispec system to help determine system 
problems. You will send this package to Pressco service specialists so that they can troubleshoot your 
system. 

 Note: A Support Package does NOT contain images. You may be asked to send images with the 
support package for the most effective troubleshooting. At least one image per camera is desired. 
See Saving Images (on page 126). 
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 What you need: 

 Mechanical keyboard (MKB) (on page 12) to enter problem description 

 USB flash drive (128MB or larger) 

 If a Pressco Support representative sent you a ".pcf" file to acquire additional system information, 
then copy that file to the USB drive prior to connecting it to the Intellispec system 

 To set up for the support package procedure: 

 Connect the mechanical keyboard (MKB) to the convenience USB port (see "USB Ports" on page 12) 
on the side of the user interface. 

 To create the support package: 

1. Click the Help button  at the top of the screen. The help menu is displayed. 

 

2. Select the Create Support Package option. The support package wizard is displayed. 

3. Follow the instructions on screen. 

4. Use the forward arrows  to move to the next screens. 

5. When asked to describe the problem, use the mechanical keyboard to enter information. 

6. Optional: At Step 3: Configure, check the Custom Configuration box. A .pcf file is custom Pressco 
configuration file that gathers additional information (beyond the standard Support Package) from 
your system. A Pressco Support representative will send you a .pcf file to load before you run the 
Support Package option. 

 

a) If a Pressco Support representative sent you a .pcf file to acquire additional system information, 
then connect the USB device that contains the .pcf file. 

b) Click the disk icon  and browse to the location (usually your USB drive) where the .pcf file is 
stored. The system locates the .pcf file. 
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7. When the steps are completed, verify that the Step 5: Export screen is displayed. 

 

8. Select the USB Flash Drive in the "Copy to:" location. You may need to remove the mechanical 
keyboard and then insert a USB flash drive into the USB port. 

9. Click the Copy button. The support package files are copied to the USB flash drive, then a "Copy 
Succeeded" message is displayed. 

 

10. Click the OK button  to continue. 

11. Click the OK button  at the bottom of the Support Packaging screen to exit. 

12. Remove the USB flash drive. 

13. Remove the mechanical keyboard (MKB). 

14. Send the support package files to Pressco. 

 

 To send the files to Pressco: 

1. Copy the files that were saved, including images, from the USB drive to your computer. 

2. Send an e-mail to techsupport@pressco.com (mailto:techsupport@pressco.com) and attach the 
support package files. Pressco service/ tech support will respond within one business day, if 
possible. 

 

  

mailto:techsupport@pressco.com
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Help - Remote Support 
Remote Support is used to allow remote access to the Intellispec software. iTivity software is the method 
used by Pressco to provide remote system support if a Maintenance Agreement is purchased for that 
Intellispec system. With this software Pressco can log in and operate the Intellispec remotely. 

 You will need: 

 A functioning Intellispec (systems without power, or systems that are not capable of running 
Intellispec software, cannot be remotely accessed) 

 An internet connection to your Intellispec. This can be established through your network, and is 
usually set up during installation. You may use DSL, Cable, Mobile Broadband, or plant network 
connections to connect to the internet. Contact your network administrator for help. 

 To use Remote Support: 

1. Notify a Technical Support (see "How to Contact Pressco" on page 303) representative that you 
require remote support. You will need to identify yourself, your location, and the Intellispec to 
which he should connect. 

2. In the Intellispec software, Click the Help button . From the Help menu, select Remote 
Support. 

  

3. Select the iTivity button. If the system has a valid internet connection, the iTivity agent will attach 
to the server at Pressco. A connection status screen will appear indicating that the session has 
been established, as shown below. Intellispec systems are identified by computer name, which, in 
most cases, is the serial number. 
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4. When the Pressco Tech Support representative is connected, you will be asked to give him control 
of your Intellispec system. Check Allow remote user MOUSE and KEYBOARD control and click 
Accept. The Tech Support representative will now perform the necessary troubleshooting of your 
system. 

 

5. When the Tech Support representative is finished, he will disconnect your Intellispec from the 
remote session. 

If you need to disconnect your Intellispec from the remote session yourself, follow the steps below. 

 To disconnect from remote support: 

1. Click the X in the upper right corner of the 'iTivity Live Support Agent Connection Status' box. 

2. When the system asks "Do you really wish to exit the iTivity Live Support Agent?" click OK. The 
system will be disconnected. 

 Note: if you click the  button, the session will be disconnected, but this does not 
close the remote support program. 

 If the session is disconnected and you want to allow Tech Support to be able to access your 

system again, click the  button. 
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Discovery Software - What is Discovery? 
Discovery is software installed on the Intellispec hard drive that automatically looks for and identifies 
certain components installed on each lane. Specifically, the software identifies any sensors, cameras, 
lighting drivers, part trackers, and if used, Intellimass drivers that are attached to the system. Each one 
of these devices communicates with the Intellispec software via Cat -6 cabling and is assigned a unique 
MAC address. 

 Note: You should rarely need to use this software. However, if a new component (for example, 
camera) is installed on the system the software would be used to configure the new camera. 

Additionally, during system startup, if a previously configured component fails to communicate with the 
Intellispec software, the discovery software screen will automatically appear on the user interface, 
alerting you to the problem. 

 

Discovery software screen 

 

 

1 The tree on the left side of the screen shows the system configuration including the lanes in the name and 
MAC address of each component in that lane. 

 Unassigned hardware devices are shown in red 

 Missing hardware devices are shown in orange 

2 This menu allows you to perform specific actions, such as add or edit lanes or sensors, by clicking on the 
designated button. 

3 The Discovery menu toolbar (on page 106) allows you to perform additional actions.  
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Discovery Menu Toolbar 

 

 Tools Menu 

 Rediscover New Hardware - when this command is initiated this software will perform another 
search of all hardware communicating with the Intellispec and displayed in the tree on the left side 
of the screen. 

 Add Simulated Devices for Testing - this is software used by Pressco engineers to assign devices on 
an Intellitrainer.* 

 Inspection Module Preset Editor - this is software used by Pressco engineers to assign new 
components as they become available. 

 Wizard Menu - lists the same choices as those listed in the green buttons in the center of the 
screen. 

 Language Menu - displays language choices that can be displayed. 

 Help - provides software and systems for users. 

*Intellitrainer = portable Intellispec training computer. 
 

Discovery - access and use 

 The initial configuration of all hardware devices will be performed by the Pressco installer, and it is 
not anticipated that plant personnel will normally need to use Discovery software. 

 The Discovery screen is automatically displayed during system startup anytime a hardware device 
that was previously configured is not communicating with the Intellispec software. 

 If you need to run the Discovery screen manually, you must log in as an Administrator, shut down 
the Intellispec software, and run the Discovery program from Windows 

 An example of a situation where plant personnel may use the Discovery software and actions to be 
taken is described next: 

 During system startup camera does not communicate with the Intellispec software 

 The Discovery screen sees this as a missing piece of hardware and automatically displays the 
Discovery screen. The configuration tree shows the camera in the expected location but 
displayed in orange, indicating that hardware device is missing. 

 As a first step you should open the tools menu icon and select "Rediscover New Hardware." This 
will trigger the software to search for the missing camera. 

 If the camera re-establishes communication, as seen by the camera name changing to black, you 
can close the discovery software and resume normal operation. 

 If the camera does not re-establish communication this indicates a hardware problem and the 
camera will most likely need to be replaced. 
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Favorites Menu 
Access the Favorites menu from System Overview, Lane Overview, or Sensor Overview menu. Click the 

Favorites button  from the toolbar to see the menu. 

 Note: Some menu items are only available to advanced level users. 

 

This menu allows you to access the following utilities: 

Take Screen Shot (on page 107) 

Manage Background Tasks (on page 107) 
 

Take Screen Shot 

This utility allows you to capture an Intellispec screen image. This is different from saving individual part 
images through the Save Image (see "Saving Images Through the Sensor Menu" on page 126) function. 
A screen shot is useful to illustrate a problem to technical support, or to capture settings for future 
setup. 

 To capture the current full Intellispec screen: 

1. Click the Favorites button  to access the Favorites menu. 

2. Select the Take Screen Shot option. An onscreen keyboard is displayed with a default image name. 

3. Re-name the screen shot if desired. 

4. Click OK to save the image. The image is saved as a Portable Network Graphic (.png) file to 
C:\Pressco\DataExport\ScreenShots. 

 

Background Tasks 

You can control the Intellispec system's background tasks. If you are saving or copying several images, 
especially to a USB device, this process is slow. Therefore the Intellispec considers it a background task. 
The system will continue to inspect and perform regular tasks in the foreground. You may stop or 
remove certain background tasks if desired. 

Background task management is found under the Favorites icon (except in System Overview mode). You 
may see different icons depending on whether the system is performing background tasks.  

1 

 

Normal. No background tasks in use. 

2 

 

One or more background task is running. None is complete. 

3 

 

One or more background task is running. At least one is complete. 

4 

 

All background tasks are complete. This icon will appear on screen until you "Remove All" 
tasks from the system using the Manage Background Tasks menu. 
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When at least one background task is active, the Manage Background Tasks menu item becomes active 
in the Favorites menu. Click either icon [item 2 or 3 above] to access the menu. 

 

Select the Manage Background Tasks option from the Favorites menu to cancel or remove one or more 
tasks. Removing a task gets rid of all information about the task. 

 

Notes: 

 Each lane maintains its own list of background tasks. If you start a task on Lane 1, you must manage 
the task from Lane 1. 

 You will not be able to close the dialog box until the task is complete or canceled. This prevents 
errors from occurring in the system. 

Saving images to USB using the Retro-Spec interface 

When you are editing an inspection, you might save image sets to a USB device. This is not a background 
task, and you will not be able to perform other tasks while saving the images. However, you can cancel 
the task if necessary (see menu shown below). You will not be able to close the dialog box until the task 
is complete. This prevents errors from occurring in the system. 
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The sequence to save the images is (see illustration below): 1 - click the Save button. 2 - Choose the USB 
device. 3 - Save a data set (A or B). For more information about this menu see Saving Images through 
the Retro-Spec interface (on page 129). 

 

You may cancel the task if necessary. 
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Lighting and Imaging 

This section includes how to adjust lighting, how to save and load images, how to use Offline imaging, 
and how to use Image Analysis. 

 

Sensor menu 
The Sensor Menu provides access to part tracking, lighting, and image options. Right-click the Sensor 
button to view the Sensor menu from the Lane Overview or Sensor Overview mode. The items at the 
bottom of the menu are only available in Sensor Overview mode. 

 Note: the lane must be offline to access the items in the Sensor menu. 

 

The items in the Sensor menu are as follows: 

Reject Enabled 

(Toggles to Reject Disabled) This option enables or disables the rejecter for the Sensor only. If you 
disable a sensor and put the system online, you will see a message that a rejecter is disabled. 
See also Rejector Enable/ Disable (on page 78). 

Camera Focus and Aperture (on page 112) 

Calibrate the focus and aperture of some cameras. This menu item will be grayed out if your system 
does not have cameras that can be adjusted through the software. 

Camera Gain and Offset 

 Note: This menu normally should not be adjusted. It is usually set by the Pressco installer. Improper 
adjustment of these parameters can cause a distortion of the image. 

 Camera gain is the amplification of the video signal 

 Offset adjusts the grayscale reference values 

Part Tracking  

Opens Part Tracking options for: 

 Part Present Delay Calibration (on page 85) 

 Part Present Delay with Encoder (on page 87) 

 Reject Delay Calibration (on page 88) 

 Reject Confirm Calibration (see "Reject Confirm Calibration (Optional)" on page 95) 

 Part Width Calibration (on page 68) 

Chapter 8 
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Offline Imaging (on page 113) 

Choose how the Intellispec acquires images when the lane is offline. 

Image Analysis (on page 114) 

This tool displays the gray shade value for any pixel or group of pixels in your image. This is useful in 
programming part programs or setting up lighting. You can measure grayscale values of pixels in 
horizontal or vertical lines, or over a circle. Image Analysis also allows you to calibrate the pixel scale 
for the sensor. 

Lighting 

Opens lighting options: Basic Adjust Lighting (on page 117) and Advanced Adjust Lighting (on page 
118). 

Review Camera Calibration (on page 120) 

This tool shows how the current camera is calibrated - the number of image pixels to an actual 
measurement on your part. Calibration is used in measurement inspections. 

Save Images (see "Saving Images Through the Sensor Menu" on page 126) 

Allows you to save captured images to disk. 

SmartCAL 

SmartCAL is a tool that allows you to load a set of images, run them with the current part program, 
and make sure the part program is passing or rejecting parts as you expect. 

Image Source (on page 121) 

Allows you to choose which images to display, and select between live sensor images or saved 
images. 

The two following options are available from Sensor Overview mode. 

Options (see "Options (sensor menu)" on page 153) 

Provides different inspection tree views. 

Part Program Change Log (on page 150) 

Display the Part Program Change Log. This lists the inspections and the edit history for each. You can 
view all inspections from one sensor, other sensors, or other part programs. 

 

Camera Focus and Aperture 

This menu allows you to adjust the focus and aperture of some cameras. It is only available when the 
lane is offline. 

 Note: only some cameras support this feature. They contain built-in motors to make these 
adjustments. The Camera Focus and Aperture menu item will be grayed out in the Sensor menu if 
your system does not support this feature. 
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 To get to this screen: 

From the Lane or Sensor Overview screen, right-click the Sensor button to see the Sensor menu, then 
select Camera Focus and Aperture from the menu. 

 

Make adjustments as necessary. 

Focus slider 

Sets the focus position of the lens. 

Aperture slider 

Sets the aperture position of the lens. 

Recalibrate/ Calibrate Focus 

Determines and sets the usable range of focus positions for the lens. 

Recalibrate/ Calibrate Aperture 

Determines and sets the usable range of aperture positions for the lens. 

Auto Focus 

Automatically determines and sets the best focus position for the image. 
 

Offline Imaging 

Choose how the Intellispec acquires images when the lane is offline. 
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Triggered Mode 

 Single Image – using the part detect sensor, an individual picture is taken every time the button is 
clicked. 

 Run – using input from the part detect sensor, pictures are taken continuously at the rate set in 
"Image Update Interval." 

Immediate Mode 

 Single Image – NOT using the part detect sensor, an individual picture is taken every time the button 
is clicked. 

 Run – the camera takes a continuous picture, the light array is on, and you instantly see whatever is 
under the camera. 

 

Image Analysis 

This tool displays the gray shade value for any pixel or group of pixels in your image. This is useful in 
programming part programs or setting up lighting. You can measure grayscale values of pixels in 
horizontal or vertical lines, or over a circle. Image Analysis also allows you to calibrate the pixel scale for 
the sensor. 

 To get to Image Analysis: 

 Make sure the lane is offline. Image Analysis is not available in online mode. 

 Right-click an image in the Sensor Overview screen to display the zoom and image options. Choose 
Image Analysis from the menu. 

 

- OR - 

 Right-click the Sensor menu (on page 111) and choose Image Analysis from the menu. 

 Note: you must have proper user access to use Image Analysis; otherwise, the option will be grayed 
out 
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The Image Analysis screen is displayed. The components of this screen are described below. 

 

 

1  Image analysis graph displays gray shade value for each pixel along the line or circle. The gray shade values 
of the line, or unwrapped circle, are displayed directly below the graph. 

2 Circle marker - click and drag the circle to any point on the line or circle (either in the image or in the graph) 

3 Square marker - click and drag the square to any point on the line or circle (either in the image or in the 
graph) 

4 Measure your actual part with a ruler or calipers and enter the measured value in this box. Place a line or 
circle on the image, covering the same area you measured. 

If using a line: place the end boxes of the line on the same area on the image that you used to measure the 
part. This will measure length. 

If using a circle: place the circle on the image over the same location you used to measure your part. This 
will measure the part's diameter. 

5 Choose your calibration units that you used to measure your part 

6 This is a computed number that is updated after you click the Compute Scale button. It computes the units 
of measure per pixel, and shows the number of pixels measured by the line or circle. 

7 Use this keypad to enter the measured value of your part. 

8 Save Scale - (available after you Compute the scale) Click this button to save the number of pixels per unit of 
measure to the sensor file. This calibration unit can then be used in inspections such as Measurement or 
Distance. 
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9 Compute Scale - Click this button after you have entered your measured valued [item 4] and set up your 
line or circle. The system computes the units of measure per pixel. 

10 Click Snap to acquire one new image. This option is only available if you accessed Image Analysis by 
right-clicking the Sensor button. 

11 Click Run to continually snap new images. Different images are only displayed if your production line is 
running. This option is only available if you accessed Image Analysis by right-clicking the Sensor button. 

12 Click the circle button to view gray shades along a circle 

13 Click the line button to view gray shades along a line 

14 Click and drag an end square to change the size or location of the line. If you are using a circle for image 
analysis, use the middle yellow square to re-position the circle on the image. 

15 Values for each image are displayed so that you can see the difference between images 

16 The lowest gray shade value along the line or circle 

17 The highest gray shade value along the line or circle 

Under the graph, the information displayed is as follows: 

Marker Positions 

The distance in pixels that the square or circle markers are from the beginning of the reference (red) 
line or circle. 

Marker Value Difference 

The difference in gray shade between the values of the two markers. 

Marker Values 

Gray shades of markers. 
 

Calibrating the Image Pixel Scale 

Using Image Analysis 

Image Analysis can be used to enter your actual measured values of your part and compute the units of 
measure per pixel. This is called Pixel Scale. This calibration can be used for any inspection on that 
sensor. 

 To compute the pixel scale (refer to the illustration for Image Analysis (on page 114)): 

1. Using a known good part, measure the length or diameter of an area on your part. 

2. Enter that value into the Measured box [item 4]. 

3. Place a line or circle on the part image in Image Analysis over the same location used to measure 
your part. Place the markers of the line, or a circle at the edges where you want the system to 
measure your part. 

4. Click the Compute Scale button [item 9]. The system computes the pixel scale and displays the 
values [item 6]. 

5. To save the scale to the Sensor file, click the Save Scale button. The pixel scale is saved with the 
sensor and can be used for any inspection on that sensor. 

 

Using an inspection 

Pixel scale can be calibrated for an individual inspection or sensor. When Save Calibration is used in 
these inspections, you can use the calibrated information in other inspections for that sensor. The 
inspections that use pixel scale calibration are: 
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 Measurement (on page 238) 

 Fill Height (on page 245) 

 Distance (on page 262) 

See the descriptions for the individual inspections using the links provided. 
 

Basic Adjust Lighting 

The Basic lighting provides most of the lighting adjustments you will use. 

 Note: lighting must be adjusted while the lane is offline. 

 To get to this screen: 

1. From the Lane Overview or Sensor Overview screen, right-click over the desired sensor button. 

2. Select Lighting, then select Basic Adjust Lighting. The Basic Lighting screen is displayed. 

 

 

1 Upper right corner displays each zone. Click a zone to adjust it. You can select a single zone or multiple 
zones at any one time. As lighting is changed, the zone and the button next to it change color. 

2 Separate slider bars for each color (red, green, blue, and infrared) allow individual adjustment. 

3 Incremental mode 

Proportional % - Moving the slider bar adjusts all colors but maintains the current percentage of each color. 

Equal % lighting - Each color is adjusted by the same amount. 

4 Click any image (if applicable to your system) to select the camera to adjust its lighting. 

5 Enable Normalization - (in some systems, Disable Normalization). For most applications leave normalization 
disabled. If you are modifying a part program that has normalization enabled, then leave it enabled. This 
function was previously used to limit the brightness of certain LEDs. It is no longer required. 
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Advanced Adjust Lighting 

This screen provides additional lighting setup. This is mostly used by Pressco engineers, or for making 
infrequently performed specialized settings. 

 Note: lighting must be adjusted while the lane is offline. 

 To get to this screen: 

1. From the Lane Overview or Sensor Overview screen, right-click over the desired sensor button. 

2. Select Lighting, then select Advanced Adjust Lighting. The Advanced Lighting screen is displayed. 

 

 

1 Opens a color palette and allows you to choose preselected colors. 

2 If your inspection module has different lighting arrays, click one of the array buttons to adjust lighting by 
zone. 

3 By Section - Allows you to change lighting by each individual section. 

By Color - Allows you to change lighting for multiple sections at once. 

4 Enable Normalization - (in some systems, Disable Normalization). For most applications leave normalization 
disabled. If you are modifying a part program that has normalization enabled, then leave it enabled. This 
function was previously used to limit the brightness of certain LEDs. It is no longer required. 

5 Pixel Smear - The Intellispec computes the amount of pixel smear based on lighting, image size, and part 
rate. It should be kept below one. 

6 On-screen keypad (OSK) - enter the percentage of color. Type the number in the empty box (using the 
onscreen keypad). This also moves the percentage slider. 

7 A/B buttons - Allows you to set up two different lighting settings for the same part so you can view each 
and compare. 
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Advanced adjust lighting - zones 

When you select one of the array buttons from the Advanced Lighting screen, you can adjust each zone 
independently. 

 

 

8 Adjust any zone within the light array. Options: 

 Adjust any zone with the slider or arrows 

 Select several zones by checking their gray box to adjust those zones as a group (intensity will be 
the same for the whole group) 

 Right-click over any zone for options to add all zones to the group, remove all zones from the group, 
or reset all zones to zero 

9 Click another array button to adjust lighting zones for that array 

10 Enable Normalization - (in some systems, Disable Normalization). For most applications leave normalization 
disabled. If you are modifying a part program that has normalization enabled, then leave it enabled. This 
function was previously used to limit the brightness of certain LEDs. It is no longer required. 

11 Set Delay (see "Advanced adjust lighting - set delay" on page 119) is only available in a BNS application. 

12 Click the Back to Camera Lighting button to go back to the main Advanced Adjust lighting screen 

13 1X - 2X is an intensity multiplier. 1X is the normal setting. 2X doubles the intensity without having to adjust 
the intensity through the sliders. Maximum intensity is 100% - if a slider is already at 100%, then the 
intensity will not be doubled. 

 
 

Advanced adjust lighting - set delay 

Setting the zone delay is only available in a BNS application. It provides a strobe delay on the light 
control board for the Neck camera, so that the Neck lighting fires after the Base camera (and not at the 
same time). Since the Base and Neck part present signal occurs at the same time, a lighting delay is 
required so that the Base is lit separately from the Neck. 

 Note: this setting is normally done in the Pressco factory. You should not need to adjust it. 
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 To get to this screen: 

1. From a Lane Overview or Sensor Overview screen, right-click over a Sensor button to see the 
sensor menu. 

2. Select Lighting > Advanced Adjust Lighting. 

3. In the upper right corner of the lighting screen, click one of the array buttons to go to the zone 
adjustment screen. 

4. Click the Set Delays button. The Zone Delays menu is displayed. 

 

 To adjust zone delay: 

1. Enter the number of microseconds for each zone with the OSK. The normal setting for the Neck 
camera is 350 microseconds on each zone. 

2. Click the OK button  to save changes and exit the menu. 

 Note: this delay is separate from the Strobe Delay set in Part Present Delay Calibration (on page 85).  

 

 
 

Review Camera Calibration 

This menu allows you to switch between inches and millimeters, select a custom scale, or go back to 
pixels. If you switch between inches and millimeters, the pixel scale is automatically converted. 
Calibration to pixel scale is performed in Image Analysis (on page 114) or some inspections such as 
Measurement or Fill Height. Calibration is used to compute measurements on a part. 

The unit you select in this menu is displayed in the Inspection menus:  for pixels, mm for millimeters, 
" for inches, or [ ] blank for custom units. 
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To see this menu, right-click over the Sensor button in Lane Overview or Sensor Overview modes > select 
Review Camera Calibration. 

 

Notes: 

 If you switch from mm to inches, or inches to mm, the scale is converted for you. However, if you 
switch to custom or pixels between mm and inches, then the scale is not adjusted for you. 

 If you switch to pixels, the scale is set to 1.0. The scale will revert back to your calibrated value if you 
switch from pixels to another unit. 

 The Reset Scale button sets the scale to 1.0 for any unit you have selected. 
 

Image Source 

This tool allows you to choose which images to display for the lane or sensor. You can load images to 
simulate inspection if your production line is not running, or choose live images from the sensor. 

To see this menu, right-click the Sensor button from Lane Overview or Sensor Overview mode, then 
select Image Source. 

 Note: you can also see most of the items from this menu by clicking the Tools button in Lane 
Overview mode, selecting Lane Setup, then selecting Image Source. 

 

From Sensor 

The system displays the live images from the current sensor. 

Simulated 

The system displays images you have previously saved to disk. When you select Simulated Images, 
the following happens: 

 All rejectors for the current lane are disabled. 

 The name of the sensor(s) is displayed in red to indicate that the rejector is disabled. 

 You must specify images through one of the following options: Select Simulated Lane Images 
(PDL), Manage Simulated Lane Images (PDL), or Select Sensor Images. 

Select Simulated Lane Images 

Load a PDL file (on page 123) 

Manage Simulated Lane Images (see "Manage Simulated Lane Images (PDL)" on page 122) (PDL) 

Select Sensor Images (on page 125) 
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Manage Simulated Lane Images (PDL) 

Create a Pressco Data List file [.PDL] that lists the images to load. This way, you can easily load the same 
images another time. It allows you to save and load images for all sensors within the lane. 

First, you must save a set of images; choose from one of the options: How to Save Images (see "Saving 
Images" on page 126) 

To see this menu, right-click on a Sensor button in Lane or Sensor Overview mode to see the Sensor 
menu (on page 111), then choose Image Source (on page 121), then choose Manage Simulated Image 
Files from the menu. 

 

 To create a new PDL file: 

 Note: this process creates one file where you can load images from all sensors within the lane. 

1. Click the disk icon  under Image Set. 

2. In the Select Lane Simulation File screen, click the New button. An on-screen keyboard is 
presented. 

 

3. Type a name for the image file and click the OK button from the on-screen keyboard to save the 
file. A file is created and saved in the default directory for the sensor (example: C:\Pressco\Lane 
1\Images). The file path will be displayed in the Image Set drop-down menu. 

4. To add images to the set, highlight the file name in the Select Lane Simulation File screen. The 
Edit button becomes active. 
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5. Click the Edit button. The Select Lane Simulation File screen closes, and the selected file name is 
displayed in the Manage Simulation Image Files screen. 

6. Check the Enable Modification box, then click the disk icon  next to the 'Repeat Sequentially' 
drop-down menu. The Select Sensor Images screen is displayed. 

7. Select images for the set using the instructions under the Select Sensor Images (on page 125) 
section, and click the OK button to save. 

8. Choose how to display the images using the drop-down menu on the right of the screen.  

 Repeat Sequentially - displays the images in order by file name, starting from the first image file, 
repeating as long as the lane is online. 

 Repeat Randomly - displays the images in a random order, repeating as long as the lane is 
online. 

 Run Once - not currently supported. 

9. Click the Make Active button. A check mark is displayed next to the PDL file name, and the file is 
activated.  

10. Exit from the Manage Simulation Image Files screen. 

Next, display the list of images. 

 To display the simulation images: 

1. Make sure Simulated is selected in the sensor menu: Right-click over a sensor button > choose 
Image Source > Simulated. A check mark next to Simulated indicates the system will display 
images from disk, and not the camera. 

2. To clear the previous images from the lane, right-click over the Statistics menu (on page 17), and 
select Clear Lane Statistics and Clear Images. 

3. The next time you put the lane online, the selected PDL images will be displayed. 

 
 

Load a PDL file 

This topic assumes that your system already has PDL files on the hard disk. If not, create a new PDL file: 
Manage Simulated Lane Images (see "Manage Simulated Lane Images (PDL)" on page 122). 

 To load a previously created PDL file: 

1. Take the lane offline (if necessary). 

2. In Lane Overview or Sensor Overview mode, right-click a sensor button to see the Sensor menu 
(on page 111). 

3. Make sure Simulated is selected in the sensor menu: Choose Image Source > Simulated. A check 
mark next to Simulated indicates the system will display images from disk, and not the camera. 

4. Right-click over the sensor button to view the sensor menu again. Choose Image Source > Select 
Simulated Lane Images. The Select Lane Simulation File screen is displayed. 
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5. In the right side of the screen, select the PDL file to display. Browse to a different directory (in the 

left side of the screen) if necessary. Click the OK button  to save the selection and exit the 
screen. 

6. To clear the previous images from the lane, right-click over the Statistics menu (on page 17), and 
select Clear Lane Statistics and Clear Images. 

7. The next time you put the lane online, the selected PDL images will be displayed. 

 
 

Edit a PDL file 

You can edit an existing PDL file by adding or deleting images. If your system does not already have a PDL 
file, create one: Manage Simulated Lane Images (see "Manage Simulated Lane Images (PDL)" on page 
122). 

 To edit an existing PDL file: 

1. Go to the Manage Simulation Image Files screen: Right-click a sensor button > choose Image 
Source > Manage Simulated Lane Images. 

2. In the Manage Simulation Image Files screen, click the drop-down menu under Image Set, and 
select the PDL file to edit. The PDL file name is displayed in the Image Set box. 

3. Check the Enable Modification box. The list of images in the PDL file is displayed in the drop down 
menu next to the sensor name. You can add or delete images as desired. 

 

 To delete images: 

1. Follow the instructions "To edit an existing PDL file" above. 

2. Click the drop-down menu next to the sensor name to display the list of images in the PDL file, and 
select an image name to delete. Release the trackball buttons or click outside of the menu to 
collapse the drop-down menu. 

3. Right-click over the drop-down menu next to the sensor name to see the Selected List Options 
menu. 

 

4. From the menu, choose to delete the currently selected image or all the images in the PDL file. The 
image(s) is deleted. 

5. Click the OK button  to save the changes and exit. 

 

 To add images: 

1. Follow the instructions "To edit an existing PDL file" above. 

2. Click the disk icon  next to the 'Repeat Sequentially' drop-down menu. The Select Sensor 
Images (on page 125) screen is displayed. 

3. Add or remove images by browsing through the directories, using the Add or Remove buttons. 

4. Exit from the Select Sensor Images screen. The modified list of images is displayed in the 
drop-down menu next to the sensor name in the Manage Simulation Image Files screen. 

5. Click the OK button  to save the changes and exit. 
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Select Sensor Images 

Select individual images or a group of images to display on the sensor. (To select images for all sensors 
within a lane, use Select Simulated Lane Images (see "Image Source" on page 121)) To see this menu, 
right-click on a Sensor button to see the sensor menu, then choose Image Source, then choose Select 
Sensor Images from the menu. (It is also displayed when you check the Enable Modification box in the 
Manage Simulated Lane Images screen.) 

 

 To select images: 

1. Browse through the directories using the drop-down menu at the top of the screen. The list of 
images in the selected directory is displayed on the right side of the screen. 

2. Select an image name from the right side of the screen. Click the All button to select all images in 
the directory, or click None to de-select all the images. 

 To select a subset of common images, click the Filter button. This allows you to specify a portion 
of the file name. 

o A wild card (asterisk [*]) is required in the filter name 

o An example is using "*good*" as a filter. Since many images are saved as either good or bad 
parts, this allows you to select the set of images you want. 

o Another example is using "*.bmp" as a filter. The Intellispec system can only load bitmap 
(.bmp) images. If your directory has different image types, you can use the filter to select 
only the .bmp files. 

3. The Selected Images drop-down menu contains the set of images you have chosen. Use the 
Remove button to remove an image from the set. 
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 You can add images from more than one directory. After adding selected images from one 
directory, browse to another directory in the left panel and add more images. The drop-down 
menu below Selected Images shows all the image files you have selected. 

4. Click the OK button  to save the set of images. The next time you put the lane online, it 
displays the set of images you have selected. 

 
 

Saving Images 
There are a number of ways to save an image within the Intellispec system. Through most of these 
options, you can save images to create a PDL (see "Manage Simulated Lane Images (PDL)" on page 122) 
file to load at any time, to create or troubleshoot part programs. Images can be saved whether the lane 
is online or offline, except the option: "Saving Images Automatically" - that option allows you to save 
information while the lane is online. 

Save any image: In most parts of the system, right-click over any image to save it. A Save Image menu 
item will be displayed. Select the desired type of image, and save it. When the system asks you where to 
save it, use the disk icon to browse to a location. If you are using a USB device, insert the device and 
browse to it. This is useful to save images to include with a Support Package. 

More information about how to save images from different locations can be found through the links 
below: 

Saving Images Through the Sensor Menu (on page 126) 

Saving Images Automatically (on page 127) 

Saving Images through the Retro-Spec interface (on page 129) 

Saving Individual Images While Editing an Inspection (on page 133) 

Saving Reject Images (on page 134) 

Saving a Region of Interest (Unwrapped) Image (on page 138) 
 

Saving Images Through the Sensor Menu 

This tool allows you to quickly save a set of images from one sensor (up to 100 images). You can use 
these images to set up and test part programs. You can save images whether the lane is online or offline. 

 Note: Some menu items are only available to advanced level users. 

 To save images: 

1. Right-click over the Sensor button in Lane Overview or Sensor Overview mode to see the Sensor 
menu. 
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2. From the Sensor menu, select Save Images, then choose whether to save the last 100 images, the 
latest sensor defect images, or auto-save images. (See Saving Images Automatically (on page 
127)). 

 

 

3. For the last 100 images or latest sensor defects, a dialog box prompts you to change directories. 

Click the disk button  to browse to a different folder if desired. 

4. Type a prefix for the set of image files, if desired. The default "Defects" prefix is provided for you. 

5. Click the OK button  to save the images. 

Save Last 100 Images 

Save the last 100 images captured by the current sensor. 

Save Latest Sensor Defects 

Save the latest defect images shown in the Reject Images thumbnails, up to 100 images. 
 

Saving Images Automatically 

This feature automatically saves images from one sensor when the lane is online. You can set up this 
feature to save up to 1000 images, and specify which images to save. The images can be related to an 
inspection in the current part program, and they can be images from parts that pass, fail, or both. 

 To get to this menu: 

1. Right-click a sensor button. The sensor menu is displayed. 
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2. Select Save Images > Auto-Save Images. The Image Auto-Save menu is displayed. The menu items 
are described below. 

 

 

1 Selected Sensor - Select the sensor in the current lane from which to save images 

2 File Name - Create a file name, preferably something descriptive of the part you are inspecting. When you 
click in the file name box, an on-screen keyboard is provided. The system automatically appends and 
increases a number in the name, and indicates whether the part passed [P] or failed [F]. An example name is 
"Auto0001_S1_P.bmp." This name indicates the first image saved [0001], from sensor 1 [S1] and it passed 
inspection [P]. 

3 Quantity - Select how many images to auto-save, between 1 and 1000. Use the numeric keypad [item 11] to 
enter a number. 

4 Save Online - Check the box to enable auto-save. Images will only be saved when the lane is online. 

5 Skip N Parts Between Saves - Check the box if you do not want to save consecutive images. Place the cursor 
in the number box and use the numeric keypad [item 11] to enter the number [N] of parts to skip between 
saved images. 

6 By Inspection - This is only available when you have one sensor selected [in item 1]. Check the box to enable 
saving images related to a specific inspection. Use the drop-down menu to select the inspection from the 
current part program. 

7 Part Status - Select whether to save images that pass or fail inspection, or both. When images are saved, the 
file name contains [P] for passing or [F] for failing. 
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8 Registration - Select whether to save images that failed registration [Not Registered], had a found center 
[Centered], or had a found center and orientation [Centered and Oriented]. 

9 Use Correlation - [available if the correlation option is installed] Check this box to enable saving images 
correlated to specific machine parts. 

10 Machine parts - if Use Correlation is enabled, select the machine part(s) to which the saved images are 
correlated. Also enter a machine part number in the box provided. 

11 Start Auto-Save - Click the Start Auto-Save button to begin automatically saving images. Note that images 
are only saved when the lane is online. To stop the automatic saving of images before the process is 
complete, click the button when it reads Stop Auto-Save. If all the specified images have been saved, the 
button returns to the default Start Auto-Save state. 

12 Numeric keypad - Use the numeric keypad to enter values for quantity of images to save [item 4], or to skip 
a number of images between saves [item 6]. 

13 Status - This area displays the status of the auto-save process. 

 
 

Saving Images through the Retro-Spec interface 

This topic covers how to save images through the Retro-Spec interface. You may want to save images to 
reference later, to send to Pressco for troubleshooting help, or to set up a part program. Saving images is 
done through the Retro-Spec interface from Registrations, Orientations, or Analyses. You must first have 
at least a temporary Part Program (see "How to Create, Copy, or Import a Part Program" on page 144) 
loaded. You must have user permissions to edit part programs. 

Images can be saved whether the lane is online or offline. Images are saved as grayscale bitmap images, 
at 302 KB in size. No graphics are saved with the images. 

 To save one or more images: 

1. Go to Sensor Overview mode [from Home, click Lane button, then Sensor button]. 

2. Put the lane online for a while to acquire several part images. 

3. Take the lane offline to stop acquiring images (if desired). 

4. Double-click the name of any Registration, Orientation, or Analysis in the inspection tree to view 
the Retro-Spec interface. Note: you cannot save images through a Region of Interest (ROI). 

5. Right-click the Retro-Spec graph to see the Retro-Spec options (on page 164) menu. 

  

6. Select an option for Data Set A and/or Data Set B (from Select Data Set A and Select Data Set B). 
The Retro-Spec graph is updated with the selected part data. 
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7. In the Retro-Spec graph, click the bar corresponding to the image you want to save. 

 

 Note: You can save a whole data set from the Save Image Files menu. 

8. Click the disk icon  on the Retro-Spec graph. The Save Image Files menu is displayed. 

 

9. Choose which images to save under the "Save What?" column. Save only the selected part image, 
or all the images from Data Set A or Data Set B. 

10. Choose the type of image to save under the "Save Type" column. Save the image only, the image 
with the graphics overlaid, or two separate images (both). 

11. To name the image files, enter a prefix in the "File names start with" box. The default prefix is "I" 
for "image." This step is important if you already have saved images and you do not wish to 
overwrite them. 
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12. Use the disk icon  under "Where to Save?" to browse to the location where you want to save 
images. Use the Select Location menu to save images to the Intellispec hard drive or to a USB 
device. Create a new directory, if desired, for your images. 

 

13. Click the OK button  twice to save the image(s). The images are saved. 

 Note: all images in a data set will be named with unique file names. However, if you save another 
data set to the same folder at a later time using the same prefix, the original images will be 
overwritten. See Recommendations for Image File Management (on page 131). 

14. To save subsequent single images to the same location, click the bar on the Retro-Spec graph for 

another part, and then click the disk icon on the graph. Click the OK  button. The part image 
will be saved. 

You can load (see "Loading Saved Images" on page 139) saved images at a later time for reference, 
setting up a part program, or testing. 

 Note: Part images can be dragged to the disk icon  and saved if the Lock/Move Parts button is 

unlocked:  See more information about this button in the Retro-Spec Population View 
Graph (on page 162). 

 

Recommendations for Image File Management 

When you save the images for data sets to a folder, each image is given a unique name. However, if you 
save another data set to the same folder, those original images are overwritten. Therefore we 
recommend that you create new folders when you save data sets. Our recommendations are: 

 Make new folders and give them meaningful names 

 Add the word Defects (or Good) to the folder name to indicate that you are storing defects (or good 
images) for that inspection 

When you are saving images (see "Saving Images through the Retro-Spec interface" on page 129), you 
can create new folders (directories). 
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 To create a new folder while saving images: 

1. Click the disk icon  on the Retro-Spec graph. The Save Image Files menu is displayed. 

 

2. Click the disk icon  to browse folders. The Select Location menu is displayed. 

 

3. Click the button at the top of the menu to browse to the location that makes sense to the sensor 
(example, "C:\Pressco\Lane 1\Images\Sensor 1\"). Note that you can also save images to a USB 
device. 

4. Click the Create Directory button to create a new folder. Rename the folder something 
meaningful, such as the area of inspection (example, Countersink). If you are saving images of 
defects, use Defects in the folder name. 

5. Click the OK  button to complete browsing and return to the Save Image Files menu. 

6. Click the OK  button to save the images. Depending where the images are being stored, it may 
take up to a minute to complete, especially if a USB device is used. 

 



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Lighting and Imaging  133 
© 2014 Pressco Technology Inc. Proprietary 
 

 

Saving Individual Images While Editing an Inspection 

You can save one image while editing an inspection. To save the image, right-click over the image to see 
the Image Options menu. Select Save Image from the menu, then choose the desired option. The image 
can be saved whether the lane is online or offline. 

 

The options are shown below. 

 

 Image Only - Saves a bitmap (.bmp) image with no graphics. 

 Note: only bitmap images can be loaded back into the Intellispec 

 Image with Graphics - Saves the current image with inspection graphics on the image. It is saved 
as a Portable Network Graphic (.png) file. 

 Both - Saves both files - (.bmp) with no graphics, and (.png) with graphics. 
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When you save an image, a dialog box, as shown below, provides options for saving the image. The 
image is saved to the default location shown in the box, unless you click the disk icon and specify a 
different location. A default file name including Lane name, date, and time is provided for you. You 
can rename the image by clicking on the keyboard icon and typing a new name using the on screen 
keyboard. 

 
 

Saving Reject Images 

You can save images from parts that were considered defective, either from Lane Overview or Sensor 
Overview mode. This can be done when the Reject Images button on the right side of the screen is 
selected. Up to 100 images can be saved at a time. These images can be loaded at a later time as 
simulated images to assist in programming inspections or training. 

Images can be saved whether the lane is online or offline. 

 

 To save reject images: 

1. Right-click over any image displayed in the reject image area on the screen (Images in Sensor 
Overview mode shown below). The Defect Image Options menu is displayed. 

  

 

2. Select Save Defect Images from the menu. The Save Image menu allows you to change the 
directory or name of the images to be saved. A default name and directory are provided for you. 

3. Change the directory or file name if desired and click the OK button to exit. The images are saved 
as bitmap (.bmp) images. Each image is given a unique name. 
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Saving Reject Images by Inspection 

You can save images that failed a specific inspection in Sensor Overview mode [from System Overview 
mode, select a lane, then click a Sensor button [item 1] to go to Sensor Overview mode]. There are two 
ways to save inspection-specific images. Refer to the illustration below. 

 Note: If you select an inspection that did not fail any parts, all reject images from that sensor, up to 
100 images, are saved. 

 If the Reject Images button [item 4] is selected on the right side of the screen: 

1. Click the name of an inspection [item 3] in the inspection tree. The images associated with that 
inspection are displayed in the thumbnail image area. 

2. Right-click over the set of images to see the Defect Image Options menu [item 2]. 

3. Select Save Defect Images from the menu. The Save Image menu allows you to change the 
directory or name of the images to be saved. A default name and directory are provided for you. 

4. Change the directory or file name if desired and click the OK button to exit. The images are saved 
as bitmap (.bmp) images. Each image is given a unique name. 

 

 

  

1 Sensor button 

2 Right-click over image thumbnails to see Defect Image Options menu 

3 Select one inspection to view defect images associated with that inspection 

4 Select the Reject Images button to view thumbnails of images from defective parts 

 

 If the Statistics button [item 4a] is selected on the right side of the screen (refer to the 
illustration below): 

1. Click the name of an inspection [item 3a] in the inspection table. The images associated with that 
inspection are displayed in the thumbnail image area. 

2. Right-click over the set of images to see the Defect Image Options menu [item 2]. 
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3. Select Save Defect Images from the menu. The Save Image menu allows you to change the 
directory or name of the images to be saved. A default name and directory are provided for you. 

4. Change the directory or file name if desired and click the OK button to exit. The images are saved 
as bitmap (.bmp) images. Each image is given a unique name. 

 

 

 

1 Sensor button 

2 Right-click over image thumbnails to see Defect Image Options menu 

3a Select one inspection to view defect images associated with that inspection 

4a Select the Statistics button to view detailed inspection statistics 
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Saving Reject Images by Machine Part 

You can save images that failed inspection and are associated with specific machine parts. 

 To save images associated with a machine part (refer to the illustration below): 

1. Go to Sensor Overview mode: from System Overview mode, select a lane, then click a Sensor 
button [item 1] to go to Sensor Overview mode. 

2. Click the Machine Parts button [item 4b] on the right side of the screen. The images associated 
with machine parts are displayed in the thumbnail area. 

3. Select a different machine part from the drop-down menu [item 3b], if desired. 

4. Select a specific machine part from the graph [item 5]. The name of the machine part is displayed 
in the button above the V-axis selection. 

5. Right-click over the set of images to see the Defect Image Options menu [item 2]. 

6. Select Save Defect Images from the menu. The Save Image menu allows you to change the 
directory or name of the images to be saved. A default name and directory are provided for you. 

7. Change the directory or file name if desired and click the OK button to exit. The images associated 
with that machine part are saved as bitmap (.bmp) images. Each image is given a unique name. 

 

 

 

1 Sensor button 

2 Right-click over image thumbnails to see Defect Image Options menu 

3b Select a machine part type 

4b Select the Machine Parts button to view thumbnails of defective parts associated with specific machine 
parts 

5 Select a specific machine part from the graph 
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Saving Individual Reject Images 

You can select any thumbnail image in Sensor Overview mode and save it. 

 To save an image (refer to the illustration below): 

1. Go to Sensor Overview mode: from System Overview mode, select a lane, then click a Sensor 
button [item 1] to go to Sensor Overview mode. 

2. Click any thumbnail image [item 3c] (available when Reject Images or Statistics button is selected). 
The Reject Images button becomes selected after you select the thumbnail image. 

3. Right-click over the large image at the bottom of the screen to see the Image Options menu [item 
2c]. 

4. Select Save Image from the menu. Choose to save the Image Only, Image with Graphics, or Both. 
For information about these options, refer to Saving Individual Images While Editing an 
Inspection (on page 133). The image is saved. 

 

 

 

1 Sensor button 

2c Right-click over the image to see Image Options menu 

3c Select a thumbnail image 

4c When you select a thumbnail image, the Reject Images button becomes selected for you 
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Saving a Region of Interest (Unwrapped) Image 

You can save the unwrapped region display while you are editing an inspection. The image will be saved 
as a Portable Network Graphic (.png) file. An example unwrapped image is shown below. The image will 
be the same dimensions as the defined region of interest. Note that the Intellispec stretches some 
images to fit the region of interest window. 

The image can be saved whether the lane is online or offline. 

 

 Note: whether regions, edges, or other graphics are saved depends on the settings when you save 
the image. If diagnostics are on, or if Show Graphics is enabled, those items are saved with the 
image. 

 To save the unwrapped image while editing an inspection: 

1. Right-click in the unwrapped image area to view the ROI Options menu. 

 

2. Choose Save Image from the menu. The Save Image menu allows you to change the directory or 
name of the image to be saved. 

3. Change the directory or file name as desired and click the OK button to exit. The image is saved as 
a .png file. 

 
 

Loading Saved Images 
This topic covers how to load images through the Retro-Spec interface. You can also choose an Image 
Source (on page 121) through the Sensor menu. 

You can load images previously saved (see "Saving Images through the Retro-Spec interface" on page 
129) on the Intellispec to use as reference, test part sets, or to set up a part program without the 
production line running. You must have user access to edit part programs. 

 To load images: 

1. Go to Sensor Overview mode [from Home, click Lane button, then Sensor button]. 

2. Double-click the name of any Registration, Orientation, or Analysis in the inspection tree to view 
the Retro-Spec interface graph. A partial graph is shown below. 
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3. Click one of the left or right arrow buttons  to view the Select Data Sets menu. 

 

4. Click the Image Files button for either Set A or Set B. 

5. Click the disk icon  to browse to the folder where the images were saved. The Select Location 
menu is displayed. 

 

6. Browse to and select the folder that contains the images you want to load. 

 To preview the images in the folder, browse through the file names in the window on the right of 
the Select Location menu. 

7. Click the OK button  twice. The Intellispec loads all the bitmap images that were previously 
saved in the selected folder. 
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Image Options 
While viewing an inspection screen, right-click in the part image to see the Image Options menu. A small 
check indicates that the option is currently active. Click an option to make it active or toggle it to 
inactive. The default Image Options menu is shown below. 

 Note: some menu items are not shown when you are viewing a registration or orientation. 

 

There are options for certain regions. Options are grayed out if they do not apply to the current 
inspection. 

Zoom - 6X, 4X, 2X 

Magnify the image by the specified amount. 

Normal Resolution 

Return the image to normal size. 

Save Image 

Save an individual image. Refer to Saving Individual Images While Editing an Inspection (on page 
133). 

Image Analysis 

Not available from this menu as of this printing. 
Image Analysis (on page 114) 

Show Graphics 

Display the region and graphics for the current inspection. 

Show Regions 

Display the region(s) from other inspections in the same part program. 

Hide Region Shading 

Remove the shaded graphics from the screen so that you can see more of the part image. 

Show Defects 

Not available from this menu as of this printing. 

Enable Region Editor 

Change the shape and placement of the region directly on the image. 



142  Lighting and Imaging Software User's Guide INTELLISPEC™ (Software Version 5.0.501) 
   © 2014 Pressco Technology Inc. Proprietary 
 

 

Display Large Region Editor 

Display a large part image on which you can change the shape and placement of the region. Check 
Enable Region Editor to make the changes to the region. Un-check this option to return the image to 
normal size. 

Enable Moving Center 

[Available when you are editing a region] Change the center of the region when you are using Region 
Editor directly on the image. 

Enable Region Resizing 

Resize the region directly on the image. 

Enable Set Region Direction 

[Available in certain inspections such as Measure ROI] When this feature is enabled, click on the 
region in the image. The region box will be displayed in yellow with diamonds around the box. Click 
on one of the diamonds to make the inspection search in the direction of the selected diamond. The 
selected diamond is filled in solid yellow. 

Center Ring 

[Available when you are using Region Editor directly on the image and Enable Moving Center is 
checked.] Click Center Ring to re-center the region on the image using the current parameters. This is 
a command; there will be no check mark next to this option. 

Edit Mode 

A Polygon inspection has the option to “Complete Build Mode” to add points to the polygon. Edit 
Mode becomes available after a Build Mode is complete. Options below are only active if a check 
mark appears next to the option in the menu. 
Delete - Click all polygon points that you want to delete. To stop deleting points, right-click to see 
Image Options menu. Select Edit Mode > and un-check Delete. 
Add - Click anywhere between two points to add another point. To stop adding points, right-click to 
see Image Options menu. Select Edit Mode > and un-check Add. 
Move - move one point in the polygon. Move the cursor over the point you want to move, then click 
and drag the point.  
Enable Moving Region - [only available when Move is enabled] Move the entire region at once. To 
move the polygon, click anywhere on the image except on one of the yellow polygon points. Click 
and drag the polygon to move it. 
Enable Rotate Around Center - [only available when Move is enabled] Rotate the entire polygon with 
respect to the center. To rotate the polygon, click anywhere on the image except on one of the 
yellow polygon points. Click and drag the polygon to rotate it. 
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Inspection Overview 

This section includes basic information about part programs, part tracking, and Retro-Spec graphs. For 
detailed information about adding or adjusting inspections, see the section about Inspections (on page 
167). 

 

Inspection Terminology 
The following terms are used throughout this manual and the software. A basic understanding of this 
terminology will help you understand how the system operates. 

 

Term Description 

Analyses (on page 227) An analysis usually analyzes the pixel shade information within a region and compares 
it to programmed reference values. The inspection passes or fails based on these 
comparisons. There are also several analyses that make measurements. You may have 
many analyses for each inspection region. 

Dimensions (on page 261) The dimension inspection type is special in that it connects the results of two other 
inspections to do the analysis. For example, a distance inspection can connect two 
registrations to measure the distance between centers of two features. 

Enhancements (on page 
179) 

Enhancements are used to alter images for the purpose of better defect detection, or 
for making certain features stand out. 

Inspection Module The housing, camera, cables, and associated electronics that are installed on or over 
the production line to acquire an image of your products. Sometimes referred to as a 
tunnel. The inspection module can consist of a different sensor than a camera to 
make measurements of your product. 

Lane A lane usually refers to one production line, and can contain multiple sensors. 

Orientations (on page 220) An orientation compensates for part rotation by finding a grayscale pattern. An 
analysis which must rotate with the part must follow an orientation. 

Part Program The list of regions, analyses, registrations, etc. programmed specifically for your part 
to detect defects or make measurements. 

Part Tracking (on page 144) Part Tracking refers to the monitoring of parts from the part detect sensor to reject 
station. This ensures that the correct parts are rejected at the correct time, and that 
good parts remain in the part stream. 

Region The Region indicates where on the part the analyses will take place. You may have as 
many analyses, enhancements, registrations, or orientations as you like in one region. 

Registrations (on page 191) A registration compensates for part movement by calculating the reference point on 
the part. All analyses follow a registration. 

Reject A part that failed one or more inspections from any sensor. The part can be physically 
rejected, or simply counted in the statistics. 

Retro-Spec The graphical interface used in inspections that allows you to make quick changes to a 
part program. It also allows you to experiment with different parameter settings to 
see how changes would have affected the most recent inspection population, without 
unnecessarily rejecting parts. 

Chapter 9 
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Sensor A camera, Intellimass, or other sensor that acquires images, measurements, or other 
data from your product. 

 
 

Sequence of Events During Inspection 
The following illustration demonstrates a typical inspection sequence of events. Note that your system 
configuration may involve more components, and may be different than pictured here. 

 

 
 

Part Tracking 
Part Tracking refers to the monitoring of parts from the part detect sensor to reject station. This ensures 
that the correct parts are rejected at the correct time, and that good parts remain in the part stream. 

Part Tracking includes: 

Part Present Delay Calibration (on page 85) 

Part Present Delay with Encoder (on page 87) 

Reject Delay Calibration (on page 88) 

Reject Confirm Calibration (see "Reject Confirm Calibration (Optional)" on page 95) 

Part Width Calibration (on page 68) 
 

  



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Inspection Overview  145 
© 2014 Pressco Technology Inc. Proprietary 
 

 

How to Create, Copy, or Import a Part Program 
A new Part Program can be created from scratch, imported or exported to/from disk, or copied from an 
existing part program. A Part Program is created in the Lane Overview or Sensor Overview screen. 

 You will need: 

 User access to create part programs 

 To create a Part Program: 

1. Go to a Lane Overview or Sensor Overview screen [from Home: Lane button > Sensor button]. 

2. Right-click over the part program drop-down menu. The Manage Part Programs menu is displayed. 
Choose from the available options described below. 

 

Right-click 

 

 To create a new program: 

1. Click the New button. An on-screen keyboard is presented. 

2. Name the new part program. We recommend that you use your part's name and size in the part 
program name. 

3. Click the OK button  to save the new part program. The new part program is automatically 
loaded and displayed in the drop-down menu below the traffic light. No inspections are created 
yet. 

4. Click the OK button again to close the Manage Part Programs menu. 

5. Add inspections as appropriate for your part. Use inspections recommended by Pressco 
technicians to best inspect your part. 

 To copy a program: 

You can use a copy of a part program to modify it to inspect a slightly different part, or modify the 
copied part program without changing the original program. 

1. Right-click over the part program drop-down menu (under the traffic light). The Manage Part 
Programs menu is displayed 

2. Select one of the available part programs, then click the Copy button. A copy of that part program 
is saved under a default name such as "(1) Penny."  

3. Select the new part program, and use the Rename button to rename the program to something 
more meaningful to you. 

 To import an existing program: 

You may have used a part program in another Intellispec system, or Pressco may have sent you a part 
program to use. Import that program to use it on your current system. 

1. Right-click over the part program drop-down menu (under the traffic light). The Manage Part 
Programs menu is displayed 
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2. Click the Import/Export button. An "Import or Export Part Programs" menu allows you to choose a 
part program from disk. 

 

3. To browse to another location on the computer, click the disk icon . 

4. Locate the desired folder and click OK in the menu. The Intellispec will only choose part program 
names with a ".PPP" extension. You will not be able to see the names nor extensions when 
choosing through this menu. 

 In this example, we clicked the Part Programs folder, then clicked OK to view the available part 
programs. 

   

5. To import the part program, highlight the name in the right side of the menu under "Disk." 

6. Click the left arrow. The part program is imported into the "Current Part Programs" list. 

7. Click the OK button to exit the menu. 

 To load the new program: 

1. Highlight the program name in the Manage Part Programs menu, then click the Load button. The 
program name will appear in the Part Program drop-down menu on the Lane Overview or Sensor 
Overview screen. 

2. Click the OK button  to exit the Manage Part Programs menu. 

See also Export a part program (on page 75) 
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Part Changeover 
When you change your production line from one part type to another, you can quickly change the part 
program. 

 Note: Some menu items are only available to advanced level users. 

 What you need: 

 User permission to Switch Part Program 

 To change parts: 

1. Log in (see "Logging in and logging out" on page 23). 

2. Click the part drop-down menu. 

 

3. Click the name of the new part to inspect. The new part program is loaded on the Intellispec. 

4. Put the lane online to begin inspecting new parts. 

 

Lane-specific information is contained in each Part Program. Everything you set up have previously set 
up is stored: camera information, lighting information, calibration information, regions, enhancements, 
and analyses. 

 

Lane Specific Information Definition 

Cameras (or other sensor) All information for each camera or other sensor is contained in the Part 
Program. 

Lighting Each camera has different lighting settings for each part. When you load your 
Part Program after a Part Changeover, the lighting will be specific for that 
part and save any changes you make. 

Calibration Calibration setup for Part Present Delay and Reject Delay is saved for each 
part you will run. Part Present and Reject Delay will only need to be set up 
once. 

Regions, Registrations, 
Orientations, Enhancements, 
Analyses, Dimensions, and 
Correlations 

All Inspections will be contained in your Part Program. Also, parameter 
changes are saved for each Part Program. 
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Inspection menu 
The Inspection menu is used to create and edit part programs. Right-click over any analysis, region, 
orientation, or registration name to see the Inspection menu. A menu similar to the one shown below is 
displayed. 

 Note: For simplicity, we use the term 'inspection' to include analyses, regions, enhancements, 
registrations, etc. 

 Note: some items may be grayed out if you do not have user access to those items, or if they do not 
apply to the current menu. 

 

The items in the Inspection menu are as follows: 

Info 

Display general information about the inspection. 

 

 

1 Name - the name you have given the inspection 

2 General type - Analysis, Region, Orientation, etc. 

3 Specific type - sub-category (example, Ring, Polygon, or Measurement Region) 

Edit Analysis/ Region/ Orientation/ Registration 

Open the Inspection Editor - performs the same action as double clicking. 

For the items below, the name of the inspection becomes color-coded. See the illustration below. 

Is Inspection Enabled? 

You can temporarily turn off the inspection by clicking this option. If "Yes" is checked, then inspection 
is enabled. 
Click the menu item to disable the inspection; "No" becomes checked in the menu. If an inspection is 
disabled, all of its dependent inspections will be disabled as well. The inspection name is grayed out 
in the inspection tree when it is disabled [item d in the illustration below]. 
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Is Inspection Reject Enabled? 

You can temporarily pass all parts regardless of whether they pass or fail the current inspection (if 
Reject is disabled). If "Yes" is checked, then inspection reject is enabled. 
Click the menu item to disable the inspection reject; "No" becomes checked in the menu. The 
inspection name is displayed in red when the inspection reject is disabled [item c in the illustration 
below]. 

Is Empty Pocket (on page 167) Check? 

Is the current inspection used as an Empty Pocket check? If "Yes" is checked, then inspection is being 
used as an empty pocket check. 
When the Empty Pocket Check is enabled, the inspection is highlighted in blue in the menu as shown 
below [item b]. 

 

 

a Inspection in normal state 

b Inspection is an empty pocket check 

c Inspection reject is disabled 

d Inspection is disabled 

e Inspection is currently selected by the cursor 

Rename 

Rename the inspection to something that makes sense to you. This name will appear in the 
inspection tree, graphs, and anywhere else the inspection name occurs. 

Insert 

Choose from the available list to add one item above the currently selected item. 

Add 

Add an item from the available list. The list varies, depending on the current item. 

Replace 

Replace the current item with a similar item. Regions can be replaced with other regions, 
registrations replaced with other registrations, etc. 

Delete Analysis/ Region/ Orientation/ Registration 

Delete the current item from the inspection tree list. If the item has other items below it (at a lower 
hierarchy), those items are deleted as well. 

Delete All Inspections 

[only shown when you right-click on "Inspections" at the top of the inspection tree] Delete all 
inspections from the current part program. 

Part Program Change Log (on page 150) 

Display the Part Program Change Log. This lists the inspections and the edit history for each. You can 
view all inspections from one sensor, other sensors, or other part programs. 

Copy 

Copy the current item and descendants (if applicable). The items are copied to the clipboard. Use 
Paste to place them in the inspection list. You may copy a part program to the same sensor, a 
different sensor, or different lane. 
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To copy the part program to another Intellispec system, use the Export function. See Export a part 
program (on page 75). 

Paste 

Paste the contents of the clipboard into the inspection list. The contents are pasted below the 
currently selected item. 

Collapse All 

[only shown when you right-click on "Inspections" at the top of the inspection tree] Collapse the 
inspection tree to the top level inspection. This does not affect inspection. 

 

Part Program Change Log 

The part program change log lists the inspections and the edit history for each. You can view all 
inspections from one sensor, other sensors, or other part programs. This is helpful if you want to see the 
previous settings for an inspection. 

 

 To view the part change log: 

1. Click a sensor button  to go to Sensor Overview mode. 

2. Right-click over a sensor button or inspection name and select Part Program Change Log from the 
Inspection menu. If you right-clicked over an inspection name, and the current inspection has 
never been changed since it was set up, no data is displayed. 

3. Click any of the available check boxes to view other inspections, inspections from other part 
programs, or inspections from other sensors. Some boxes are dependent on others; for example, 
you must click a dark gray check box before a light gray check box becomes active. 

To view a full column width, click and drag the column title to re-size that column. 
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Click the Details button to see more information about the highlighted item. A pop-up window displays 
more information, including the number of times the inspection was modified. 

 

Click the Filter button to choose the items to display in the log. As soon as you select any option, the 
Change Log is updated. Some options are dependent on others; for example, if you want to see the 
Historic Names for the Sensor, you must choose Historic Names for Inspection first. 

 

 To see inspection differences: 

1. Click the Difference button to see a list of differences in inspections. A Mark Start/ Mark Stop 
menu is displayed, and the inspections in the list are highlighted in magenta (depending where 
your cursor is). 

 

2. Click the Mark Start button. 

3. Click on the first item in the list where you want to begin viewing inspection differences. (this is 
similar to holding the Shift key and selecting multiple items in a list) 

4. Click the Mark Stop button.  

5. Click on the last item in the list where you want to view inspection differences. Your selected items 
are highlighted in magenta. 
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6. Click the OK button  in the Mark Start/ Mark Stop menu. A Differences table is displayed. This 
allows you to view a shorter list of items, only those of which have been changed. Only edited (not 
created) inspections are included. 

 

Rollback 

This feature allows you to restore the part program to a previous state, allowing you to undo several 
changes at once. 

 To use the Rollback feature: 

1. Check the box next to the Rollback button at the top of the Part Change Log Viewer screen. 

2. Scroll down towards the bottom of the inspection list. The latest changes are at the bottom of the 
list. 

3. Choose a line where you want to delete the latest changes, including the selected line. 

4. Click the Rollback button near the top of the screen. A Rollback Preview is displayed so that you 
can see what will be deleted. 

 

5. If desired, click the Details button to see the inspection change details of each line. 

6. If you are ready to delete the displayed lines, click the OK button . The lines are deleted, and 
the part program is changed back to a previous state. 
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Inspection type icons 

In the Inspection tree, you may see icons or symbols that indicate the General Type of inspection for 
each item. These allow you to quickly identify these inspections, without the need to view more 
information through the menus. 

 Note: these are options. To enable icons or symbols, right-click on a Sensor button in the Sensor 
Overview mode and select Options >> check Show Icons or Show Symbols. 

    

Icon Symbol  General Inspection Type 

 
 

Region - location of inspection 

 
 

Registration - to find part center or point of reference 

 
 

Analysis - inspection 

 
 

Correlation - inspection to correlate a part to the machine part where it was 
made 

  
Orientation - to place an inspection on the same location on each part, 
regardless of part rotation 

  
Enhancement - to add image processing to make defects or part features stand 
out better 

 
 Intellispec Mass inspection 
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Options (sensor menu) 

The Sensor Options menu allows you to display the inspection tree the best way for you. Some options 
hide objects from the inspection tree which makes it easier for adjustments. Other options display icons 
or symbols to help you quickly identify inspection types. 

 Note: these settings apply to the current sensor view only. 

 To enable an option: 

1. From the Sensor Overview mode, right-click a Sensor button. 

2. Select Options >> then select one of the options described below. An option is enabled when a 
check mark is displayed next to the option. 

 

Show Icons 

Displays icons that reflect the different inspection types (see "Inspection type icons" on page 152). 

 

Show Symbols 

Displays symbols that reflect the different inspection types (see "Inspection type icons" on page 
152). 

 

Show Standard Names 

Displays the default Intellispec inspection names. You may have other inspection names that make 
sense to the inspection of your part. Showing Standard Names is useful to Pressco engineers or to 
someone troubleshooting your machine, so that they quickly know the exact inspection type. 
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Inspection Tree Relationships 
The inspection tree shows the relationship of each inspection. Indented objects are dependent on the 
object above it. Indented objects are created when you "Add" an item from the Inspection menu. 

 

Some items in the menu may be turned off. The ability to access some items depends on your user 
access. 

Inspection tree items may be highlighted in different colors. Below is a key. 

 

 

a Inspection in normal state 

b Inspection is an empty pocket check 

c Inspection reject is disabled 

d Inspection is disabled 

e Inspection is currently selected by the cursor 
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Design Mode Icon 

The Design Mode icon provides additional part program restrictions. Click the icon to see the options. 

 

 If you select Edit Only, then users are allowed to edit, but not add, the inspections. This also 
restricts access to regions. 

 If you select Design and Edit, then users are allowed to edit and add inspections, as well as add and 
edit regions. 

 Note: some users (for example, Operators) cannot edit or add inspections regardless of this setting. 
To add and edit inspections in Design and Edit mode, users must also have proper permissions. See 
Managing Permissions. 

See also how to create a part program (see "How to Create, Copy, or Import a Part Program" on page 
144) 

 

Adding Regions and Inspections 
To add an Analysis, Enhancement, etc., you must first add a Region. The Region indicates where on the 
part Analyses or Enhancements are applied. Right-click over the inspection tree, select Add, then choose 
an item to add. You may add as many inspections underneath the region as you wish. 

 



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Inspection Overview  157 
© 2014 Pressco Technology Inc. Proprietary 
 

 

Region Editor 
This view is available when you are editing a region. If you have proper user access, you can edit a region 
by double-clicking the region name, or right-clicking the region name, then selecting Edit Region from 
the pop-up menu. 

 

 Note: In Region editor, you will not see anything happen if you click numbers 5, 6, or 7. The data set 
is changed, but you will not see the data set until you view the Inspection Editor (on page 158). 

 

1 Unwrapped Region of 
Interest 

Displays a linear view of the region from the edited inspection. 

2 Part Image Displays a view of the part with the editable region on the part. 

3 Editable Region This is the region on the image that can be edited. When the lines are yellow, 
they can be edited. To enable region editing, right-click on the region and 
check "Enable Region Editor." The region can be sized and moved using the 
track ball and buttons or by using the optional touch screen. 

4 Previous and Next 
Image 

Allows you to select the next or previous image. 

5 Get 100 images Takes up to 100 images with the current sensor and replaces Data Set A. 

6 Refresh Data Set Takes up to 100 images with the current sensor and replaces Data Set A. 
When you click this button, the images are refreshed. They will continue to 
be refreshed until you click the button again. 

7 Snap Image Takes one image with the sensor and adds it to the end of Data Set A. 
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8 Editable Parameters Adjust different parameters associated with the current region. 

9 Parameter Description 
Window 

Gives a brief description of the selected parameter. 

10 Undo, Redo, Accept, 
and Cancel 

Allows you to undo, redo, accept or cancel any changes made throughout the 
process of editing. 

 
 

Inspection Editor 
The following illustration shows the various parts of the screen displayed when you edit an inspection. 

 Note: the Retro-Spec graph (see "Retro-Spec Population View Graph" on page 162) at the top of the 
screen is described separately. 

 

 

1 Unwrapped Region of 
Interest 

Displays a linear view of the region from the edited inspection. This region is 
marked with two directions: "S" for "Slow direction" and "F" for "Fast 
direction." These designations are used in some inspection descriptions to 
help you understand how they work. 

2 Part Image Displays a view of the part with the editable region on the part. 

3 Previous and Next 
Images 

Allows you to select the next or previous image. 

4 Get 100 images Takes up to 100 images with the current sensor and replaces Data Set A. 
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5 Refresh Data Set Takes up to 100 images with the current sensor and replaces Data Set A. 
When you click this button, the images are refreshed. They will continue to 
be refreshed until you click the button again. 

6 Snap Image Takes one image with the sensor and adds it to the end of Data Set A. 

7 Inspection Parameters Displays the available parameters for the selected inspection. Note: there 
can be multiple tabs; the parameters will vary per inspection. 

8 Parameter Description 
Window 

Gives a brief description of the selected parameter. 

9 Results Box Shows the results from the current inspection with the option to see results 
from other inspections and timing information. 

Right-click over the various areas of the menu to see image options, editor options, result options, and 
region of interest options. 

 

Editing Parameters 

You can change values, display settings, and options that will alter the outcome of an inspection. For the 
purpose of this discussion, we refer to inspections, but the information applies to regions, registrations, 
orientations, enhancements, measurements, and correlations as well. 

 Note: you must have appropriate user permissions to edit parameters 

 To edit parameters: 

Open the inspection from the Sensor Overview screen: 

 Double-click the inspection name in the inspection tree. Or: 

 Right-click the inspection and select Edit Inspection from the pop-up menu. 

 

 

1 Select a tab to adjust parameters. The orange tab contains the parameters that can be adjusted with the 
bars on the Retro-Spec graph. The tabs displayed depend on the inspection itself, and its relationship within 
the inspection tree. 

2 Numeric value can be adjusted by Large Slider or Numeric Text Entry [described below] 

3 Check box to enable or disable the feature 

4 Backwards R indicates the current parameter that can be adjusted in the Retro-Spec graph (example: the 
red and yellow limits bars). Note that you can also adjust parameter limits by right-clicking over the 
Retro-Spec graph. 
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5 Column division for parameter settings (this line is not actually displayed in the Intellispec). You can see 
Large Slider AND numeric entry pad if you click in the left column, or just the numeric entry pad if you click 
in the right column (this only applies if Numeric Input setting = both). 

There are several ways to change parameters: 

 Numeric values 

 Check boxes 

 Drop-down menus 

 Buttons 

 Adjusting the bars on the Retro-Spec graph 

 Note: Drop-down menus and buttons are discussed separately in the inspections where they are used 
 

Editing Numeric Values 

There are a few ways in which to change values and settings which include large slider, numeric text 
entry, or drop down. The method available depends on Editor Options as described below. 

Large Slider 

Allows you to make changes using a sliding bar. It displays the value in the menu as you slide the bar. 
Changes made on the Large Slider are reflected in the Numeric Text Entry as well if both are open. 
Changes are also applied to the red and yellow sensitivity bars in the Retro-Spec graph. 
If the parameter has an upper and lower limit, portions of the bar are displayed in different colors, as 
shown below: 

 

 Red = failure limit. Any part whose parameter value falls in the red zone fails inspection. 

 Yellow = warning limit. Any part whose parameter value falls in the yellow zone is tagged as a 
warning level part. 

 Green = passing. Any part whose parameter value falls in the green zone passes (at least this 
parameter). 

Numeric Text Entry 

Allows you to type in a specific number. You can use the +1 and -1 feature to make minor 
adjustments. Changes made on the Numeric Text Entry are reflected in the Large Slider as well if both 
are open. 
For more information about the numeric keyboard, see On Screen Keyboard (OSK) (on page 10) 

 

Editor Options 

The information displayed when you are editing parameters depends on the Editor Options settings. 
Right-click over the parameters menu to see the Editor Options. 

 

Editor Access 

Choose how menus are displayed: 

 Normal - display the normal menus (for most users) 

 Advanced - display the advanced parameters (for power users) 
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 Note: you must have the appropriate permissions to see the advanced parameters: "Access 
advanced inspection parameters" 

 Show Generic Text - default Intellispec names. Some parameter names were changed in 
templates to make more sense for a particular application. 

Enable Region Editor 

Available when the inspection has an associated region that can be modified. 

Numeric Input 

 Slider = Large Slider as described above 

 Text Entry = Numeric Text Entry as described above 

 Both = both Large Slider and Numeric Text entry. After you make changes to either input, you 

must click the OK button  on both to close them. 

 Text entry on click on value side = if you click an item the right column of the menu, you will see 
only the Numeric Text Entry box, even if you have Both checked 

 

Result Options 

There is additional display information for the Results Box. Right-click to see the menu. To stop 
displaying the other inspections, right-click the menu again, then un-check the option. 

 

Show Other Inspections 

Displays whether a part has passed or failed other inspections on the current sensor. Right-click the 
menu again to see the option to hide good inspections. If that option is checked, then only the failed 
inspections are displayed. 

 

Display Timing Information 

Displays timing information for each inspection on the current sensor and the total time in 
milliseconds. 
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Unwrapped Region of Interest Options 

Right-click in the Unwrapped Region of Interest to display the region of interest (ROI) options menu. To 
stop displaying either option, right-click the menu again and un-check the option. 

 

Save Image (see "Saving a Region of Interest (Unwrapped) Image" on page 138) 

Save the Region of Interest image. 

Show Graphics 

Displays any graphics that are selected, like vectors or edges, on the Unwrapped Region of Interest. 

Region Display Mode 

Gives you the option to show the original region, or the enhanced region, if it has an enhancement. 
 

Retro-Spec Population View Graph 
The Retro-Spec graph is displayed when you edit a Registration, Orientation, or Inspection. 

The Retro-Spec Graph can display up to 200 parts at a time, 100 in each set. Each bar on the graph 
represents a different part. A green bar means that the part has passed. A yellow bar means that the 
part has exceeded the warning limit but not the reject limit. A red bar means that the part has exceeded 
the reject limit. A lighter shade of green, red or yellow will be displayed when a part is selected. To select 
a part, simply click on a bar in the graph. When you click a bar, the part's unique Part Image, Unwrapped 
Region of Interest, and Results will be displayed. 

Population View 

Displays details for up to the last 200 parts. The parts can be the last 100 run, the latest 100 defects 
for the inspection, or a set of parts previously saved to the hard drive. 

Graphs with One Reject Bar 

Some inspections have one reject bar on the Retro-Spec Graph. The Warning/Reject Bar can be a 
minimum requirement where the part Retro-Spec value must be higher than the reject bar in order 
to pass. The Warning/Reject Bar can also be a maximum requirement where the part Retro-spec 
value cannot exceed the reject bar in order to pass. 

Graphs with Two Reject Bars 

Some inspections have two reject bars. The part’s value must be between the two reject limits to be 
considered a good part. The example below shows an ambient inspection with two reject bars (red) 
and two warning bars (yellow). 

 



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Inspection Overview  163 
© 2014 Pressco Technology Inc. Proprietary 
 

 

The components of the Retro-Spec graph are as follows: 

 

 

1 Selected View Shows which Retro-Spec graph view is being displayed. 

2 Selected Inspection Shows the type of inspection. 

3 Reject Bar (red) Shows the inspection limits. Parts that fall outside the reject limits are considered 
defective. 

4 Warning Bar (yellow) Shows the inspection warning limits. Parts that fall outside the warning limits are 
not considered defective, but are approaching reject status. 

5 Reject Part Reject Parts are displayed in Red. 

 Warning Part Warning Parts are displayed in Yellow. [not shown in this example] 

6 Passing Part Passing Parts are displayed in Green. 

7 Other Results Indicator Indicates whether a part has failed or had a warning on a different inspection. A 
small red box will appear under a part that has failed a different inspection. A 
small yellow box will appear under a part that has had a warning from a different 
inspection. 

8 Save Parts Allows you to save a set of parts which can be reloaded later. You can save the 
Selected Parts, Set A, or Set B. You can also choose where to save them by 
clicking the Save Parts button under "Where to save?" 

9 Select Parts Allows you to select a set of parts, set A or Set B, to be displayed in the 
Retro-spec Graph. Clicking on either the left or right arrow will bring up the Select 
Parts Menu below. You can choose from Last 100, Latest Defects, or Custom Set.  

10 Delete Part [Trash can 
icon] 

Gives you the ability to delete a single part. Can only be used when the lock [item 
11] is unlocked. To delete a part: highlight the part, then click the trash can icon, 
or highlight the part then drag it to the trash can icon and release the trackball 
button. A message appears above the icon stating that the part has been deleted. 

11 Lock/ Move Parts 

Toggles to: 

 

When the graph is locked, parts cannot be moved or deleted. When the graph is 
unlocked, part sets can be modified. Parts can be saved, moved within the same 
set, moved to the set on the other side of the divider, or deleted. Dragging the 
part to the Select Parts arrows [item 9] will move the part into the corresponding 
side. Dragging the part to the Save Parts button will allow you to save the part. 
Dragging the part to the Delete Parts button will delete the part. 

12 Data Set B The parts on the right side of the divider make up data Set B. 
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Once a part has been deleted or moved, the term **Scratch Parts** is displayed at the top of the data 
set. To save the data set with your changes, click the Save Parts icon [item 8]. This will allow you to save 
the data set on either side of the divider, or just the selected parts. 

 

Retro-Spec Options 

Right-click the Retro-Spec graph to see the Retro-Spec options menu. 

 Note: some options are not displayed if they are not applicable to the current inspection. 

 

Population View 

When this is checked, the Retro-Spec population view graph (on page 162) is displayed.  

Part View 

When this is checked, the Retro-Spec part view graph is displayed. 

Symmetric Limits 

When the Retro-Spec graph has upper and lower limits (two red bars and two yellow bars), this 
option keeps the upper and lower limits the same distance from nominal. 

Lock Warnings to Errors 

Locks the yellow warning bar to the red reject bar in the Retro-Spec graph, keeping them the same 
distance apart. 

 

Auto Select Limits 

Automatically adjusts warning and reject levels to make all parts in the data set pass. 

Enable Warnings 

Provides a warning level (yellow) sensitivity bar. A warning level does not reject parts, but indicates 
that the process is approaching the reject status. When you enable warnings, they are enabled for all 
inspections for the current sensor. 

Graph Scale Mode 

Change the height scale of the graph. 
Limits Only displays part parameter values up to and including the current inspection limits. This is 
useful when you want to zoom in on data without extra lines on the graph. Note that the limit lines 
may not be displayed on the graph. As soon as you change the parameter limits from the menu, the 
limit lines are displayed again on the graph. 
Limits and Data is the default mode that displays all the inspection data plus the limit lines. 
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Select Data Set A or B 

For each Data Set, you can select what you want to display. You can choose to display Nothing, Last 
100 Parts, Latest Defects, a Freeze on Defect image, or a set of Image Files that have been previously 
saved to the computer. 
See information about Saving Images (see "Saving Images through the Retro-Spec interface" on 
page 129). See also Freeze on Defect Image in Retro-Spec. 

 

Select Parameter 

Choose a graph to display. This is available for some inspections where you have a choice to display 
different graphs. An example is Measurement Analysis, where there are several different 
measurement graphs available, as shown below. Another example is in the BMID inspection. 

    
 

Retro-Spec Part View Graph 
The Part View shows specific information unique to each part. To display the Part View, right click on a 
part and choose Population View, or double-click a part from the Population View. There are different 
types of Part Views that vary by inspection. 

 Note: not all inspections have a Part View graph available. 

Shown below is the Part View of a Contrast inspection. It has a reject bar and an Unwrapped Region of 
Interest. Any type of damage to the surface of the part, which can be seen in the Unwrapped Region of 
Interest, will have a corresponding value on the graph. If any part of the graph exceeds the Reject Bar, 
the whole part will be considered a defective image. The Reject Bar can be dragged, changing the actual 
reject threshold. 
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Shown below is a Part View of an Ambient inspection. This Part View does not have a reject bar but does 
have an Unwrapped Region of Interest. The graph does not correspond to Gray Shades on the 
Unwrapped Region of Interest. The graph represents how many pixels of each Gray Shade are found on 
the part. 
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Inspections 

This section covers regions of interest, registrations, orientations, enhancements, analyses, dimensions, 
and correlations. We use the term inspections to include all of these items, for simplicity. 

The information in this section is valid as of software version 5.3.007. 
 

Empty Pocket 
The Empty Pocket feature checks to see whether a part is present or not. This is used for applications 
where you must determine whether a part is present before proceeding with inspection. A common use 
for this test is in Starwheel applications where the encoder is used, based on pocket position, rather 
than a part present signal. Locating an empty pocket is important for production numbers to be 
accurate. If an empty pocket is found, no inspection takes place for that pocket. Otherwise, an empty 
pocket would be recorded as a defect. 

Notes: 

 You may run the Empty Pocket check on any inspection. We recommend that you use it with an 
inspection that has pass/fail criteria. Ambient and Contrast inspections are most commonly used. 

 You may add as many empty pocket checks to the part program as desired. 

 To add an Empty Pocket check to an existing part program: 

1. In the inspection tree, right-click over the name of the inspection to which you want to add the 
Empty Pocket check. 

2. From the Inspection menu, select the "Is Empty Pocket Check?" menu item. The "Yes" item will be 
checked. That inspection is highlighted in blue, and will remain highlighted unless you disable the 
Empty Pocket check. The item toggles between Yes and No to enable or disable the feature. 

Enable the Empty Pocket check Inspection with Empty Pocket check 
is highlighted in cyan 

 

 

Statistics updates using Empty Pocket 

To make sure that the statistics totals do not count empty pockets as defects, you must set up an Empty 
Pocket check for all sensors in each lane. For example, if you have three sensors in Lane 1, all three 
sensor part programs must contain an Empty Pocket check. 

Chapter 10 
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The statistics are counted as an OR function. If any of the sensors within a lane detects an empty pocket, 
then that part ID is not counted in the defect statistics. 

 

Regions of Interest (ROI) 
Regions of Interest (ROI) are the locations where the registrations, analyses, and orientations take place. 
There is no inspection done in a Region of Interest. However, there is no limit to the number of 
inspections that can be placed in one Region of Interest. 

There are up to five region types available to set up the region of interest on a part. All regions can be 
edited directly on the image (after adding them to the inspection list). 

 Note: Your system (and this book) may show only those items that apply to your application. 

 Ring Region (on page 169) 

 Polygon Region (on page 170) 

 Ribbon Region (on page 172) 

 Measure ROI (on page 174) 

 Adaptive Region (on page 176) 
 

Region of Interest Compatibility Chart 

The following chart shows whether each inspection is compatible with each region type. 

 

Region Type: Ring Polygon Ribbon Measure 
ROI 

Adaptive 

Enhancements (All) Yes Yes Yes Yes Yes 

Registrations  

Feature Yes Yes  Yes Yes 

Center of Mass Yes  Yes  Yes 

Hough Yes     

Radial Edge Yes     

Centerline   Yes   

Finish Location   Yes   

Template Registration Yes Yes  Yes  

Support Ring Registration    Yes  

Orientations  

Pattern Match Yes     

Template Orientation Yes     

Analyses  

Ambient Yes Yes Yes Yes Yes 

Shape Check     Yes 

Contrast Yes Yes Yes Yes Yes 

Measurement Yes  Yes  Yes 

Light Meter Yes Yes Yes Yes Yes 
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Region Type: Ring Polygon Ribbon Measure 
ROI 

Adaptive 

Fill Height    Yes  

Measure Extract Yes Yes Yes Yes Yes 

Distribution Yes Yes Yes Yes Yes 

Label Skew Extract Yes Yes Yes Yes Yes 

Feature Detect Yes Yes   Yes 

Dimensions (All) Dimensions do not use regions; they get data from other 
inspections. 

 
 

Ring Region 

The Ring region is circular or donut-shaped. You can create arcs or multiple arc segments in the region. 
The inner and outer radii are adjustable, and the region's position is adjustable.  

 

 To add a Ring Region: 

1. If you plan to use Arcs for the Ring Region, place an Orientation (see "Orientations" on page 220) 
in the inspection tree. If you want the region to be circular or donut-shaped, skip the Orientation. 

2. Highlight the Orientation name in the inspection tree (if applicable). 

3. Right-click on the item you just added. 

4. From the Inspection menu, select Add > Region > Ring. Re-name it to something more meaningful 
to you. 

5. The Ring Menu is displayed and the ring is shown on the image. (The menu is described below) 
Adjust the placement of the ring and parameters as necessary. 

Ring menu 

 

The following parameters can be set graphically (on the image), or through a slider bar or numeric 
keypad, which pop up when you click on a numeric value. Also refer to more information about Editing 
Parameters (on page 159). 

X and Y position 

Horizontal and vertical position of the center of the ring on the image. 



170  Inspections Software User's Guide INTELLISPEC™ (Software Version 5.0.501) 
   © 2014 Pressco Technology Inc. Proprietary 
 

 

Inner Radius 

Size of the inner ring. 

Thickness 

The thickness of the ring; outer radius minus inner radius. 

Use Arcs 

Allows you to inspect an arc instead of the whole region. The system will inspect a segment of the 
region between the Start and Stop angles. Make sure you have an Orientation in the job prior to 
using arcs. This will ensure that the inspection region is placed on the same location of the part 
regardless of the part’s orientation. 

The following parameters are available when Use Arcs is enabled. 

Start Angle 

The start angle of the region. 

Stop Angle 

The stop angle of the region 

Arc Count 

Set the number of segments you want to create in the region. 

Arc Alignment 

Not currently used. 
 

Polygon Region 

Similar to the Ribbon Region (on page 172), the Polygon Region is a customizable region that is used for: 

 free-form inspection areas on a part 

 areas that do not fit a circle or other standard inspection region 

 Note: we recommend that you place a Registration and Orientation (if applicable) prior to adding a 
polygon region. This will ensure that the polygon is placed correctly on the part, regardless of the 
part's placement or rotation. 

 

 To add a Polygon Region: 

1. Make sure that the part program has a registration and/or orientation in place to ensure proper 
placement of the polygon on all inspected parts. 

2. Highlight the Registration or Orientation name in the inspection tree. 

3. Right-click on the item you just added. 

4. From the Inspection menu, select Add > Region > Polygon. Re-name it to something more 
meaningful to you. 
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5. A "NEW POLYGON: Click to add points" message is displayed in the large image area, and the 
Polygon Menu is displayed. (The menu is described below) Click anywhere in the image to start the 
polygon. 

6. Continue clicking with the yellow boxes (polygon points) to create a polygon region. You may 
create as many points as you like. 

7. When you want to close the region, click on the first box that you placed. The region closes and is 
filled in for you. 

 

8. Make any necessary adjustments from the menu (described below). You can make adjustments to 
the region, duplicate it, or rotate it from the menu. 

 To edit the polygon region: 

Right-click the image to view the Image Options (on page 141) menu. Use Edit Mode to Delete, Add, or 
Move any polygon point or the entire region. 

Polygon menu 

 

Repeat Polygons 

Create duplicate copies of the original polygon. Allows from 1 to 10 polygons that are centered and 
rotated around the registered position. 

Repeat Count 

(Available when using multiple polygons) Choose the number of duplicate polygons to place on the 
image. The system automatically distributes these polygons around the image. A common use for 
this feature is for the feet of a PET bottle. 

Rotate Polygon 

Rotate the polygon around the center of the polygon. If you have duplicate polygons, they are also 
rotated. 

Expand or Contract 

Resize the region. A negative number contracts the region, and a positive number expands the 
region. 

 Note: be careful not to contract the region too much. This will distort the original shape. 
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Ribbon Region 

Similar to the Polygon Region (on page 170), the Ribbon Region is a customizable region and can come 
in two different forms: ribbon, and loop. This type of region is used for: 

 free-form inspection areas on a part 

 areas that do not fit a circle or other standard inspection region 

 Note: we recommend that you place a Registration and Orientation (if applicable) prior to adding a 
Ribbon region. This will ensure that the ribbon is placed correctly on the part, regardless of the part's 
placement or rotation. 

 

 

1 Ribbon - a customizable region that does not close, similar to a rubber band that has been cut. Thickness 
remains the same throughout the region. 

2 Loop - a closed version of the ribbon region, similar to a rubber band. Thickness remains the same 
throughout the region. 

 

 To add a Ribbon Region: 

1. Make sure that the part program has a registration and/or orientation in place to ensure proper 
placement of the region on all inspected parts. 

2. Highlight the Registration or Orientation name in the inspection tree. 

3. Right-click on the item you just added. 

4. From the Inspection menu, select Add > Region > Ribbon. Re-name it to something more 
meaningful to you. 

5. A "NEW RIBBON: Click to add points" message is displayed in the large image area, and the Ribbon 
Menu is displayed. (The menu is described below) If you want to change the ribbon type to Loop, 
use the Ribbon Style drop-down item in the menu. 

6. Click anywhere in the image to start the ribbon. 

7. Continue clicking with the yellow boxes (ribbon points) to create a ribbon region. You may create 
as many points as you like. 

8. When you want to close the region, right-click on the image to view the Image Options menu and 
select Complete New Ribbon. The region closes and is filled in for you. 

9. Make any necessary adjustments from the menu (described below). You can make adjustments to 
the region, duplicate it, or rotate it from the menu. 

 To edit the ribbon region: 

Right-click the image to view the Image Options (on page 141) menu. Use Edit Mode to Delete, Add, or 
Move any ribbon point or the entire region. 
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Ribbon menu 

 

Ribbon Style 

Choose between Ribbon and Loop as described above. 

Ribbon Width 

Set the width of the region. 

Repeat Ribbons 

Create duplicate copies of the original ribbon. Allows from 1 to 10 ribbons that are centered and 
rotated around the registered position. 

Mirror Ribbon 

(Only used when Repeat Ribbons is disabled) Create a flipped duplicate of the region. This is typically 
used for the Centerline (on page 201) Registration where two sides are being searched for. 

Mirror Angle 

(Only used with Mirror Ribbon) Flip the mirrored region horizontally (90 degrees), vertically (zero 
degrees), or any angle in between. 

Mirror Offset 

(Only used with Mirror Ribbon) Move the mirrored region further or closer together. 

Repeat Count 

(Available when using multiple ribbons) Choose the number of duplicate ribbons to place on the 
image. The system automatically distributes these ribbons around the image. A common use for this 
feature is for the feet of a PET bottle. 

Rotate Ribbon 

Rotate the ribbon around the center of the ribbon. If you have duplicate ribbons, they are also 
rotated. 

Expand or Contract 

Resize the region. A negative number contracts the region, and a positive number expands the 
region. 

 Note: be careful not to contract the region too much. This will distort the original shape. 
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Measure ROI 

Measure ROI(s) is a region that is intended to be used in measurement type operations (such as Label 
Skew Extract (on page 257), Measure Extract (on page 251), Fill Height (on page 245), and Support Ring 
Registration or Neckring Registration). 

 

 To add a Measure ROI Region: 

 Tip: We recommend that you first add a standard region of interest and registration to locate a 
reference point on the part. The Measure ROI region will then follow the correct location on the part. 

1. Highlight the Registration name (if one is available) in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Region > Measure ROI. The Measure ROI region is added 
to the inspection tree. Re-name it to something more meaningful to you. 

4. The Measure ROI menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

Measure ROI menu 

 

Region Count 

Leave this set at One Region unless you have a Fill Height application. Most measurements require 
one region. Fill Height applications require two regions: one for reference, and one for fill level. 

Region 1 or 2 

Contains the settings for each region. 

Center Offset X and Y 

Set the region offset value relative to the registered center. If your region is off the screen, you may 
need to change these values. 

Region Width, Height, and Angle 

Adjust the size and rotation of the region. You can also click on the image and adjust the region 
graphically (if Enable Region Editor is checked in the Image Options menu). To adjust, click and drag 
one of the empty yellow squares. 
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The Region Angle allows you to ensure that the region is a rectangle. After resizing and moving the 
region, it can become non-rectangular. Use the Region Angle parameter to quickly set to 0, 90, 180, 
or 270 degrees, to make the region a rectangle. 

 

The Measure ROI is a two point polygon ribbon region. Refer to the illustration below. The end points [1] 
adjust the length of the ribbon. The point on the side of the region [2] adjusts the width of the ribbon. 
The diamond [3] indicates the direction towards which the vectors are searching. 

 Note: for the image below, both Enable Region Editor and Enable Region Size are checked in the 
Image Options menu. You view the yellow boxes and points when you click on the image to adjust 
the region size and/or position. 

  

 

1 End points of the ribbon region 

2 Point to adjust the width of the region 

3 Indicates the direction towards which the vectors are searching 

 

Additional menu items for Two Regions 

Vertical Lock Mode, Horizontal Lock Mode, and Sizing Lock Mode 

Choose whether to move the two regions independently, or to lock the regions (move the regions 
together). When you choose to mirror the regions, the regions move in opposite directions. 
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Image options Measure ROI 

When you right-click the image you will see a slightly different image options menu for Measure ROI. 
Most of the menu items are the same as in the default image options (on page 141) menu. The last 
three items are different. 

 

To avoid confusion, we recommend that you make each adjustment one at a time. For example, Enable 
Moving Region to move the region, then disable it. Then Enable Region Size to adjust the size, then 
disable it. Then Enable Region Direction to set the direction. 

Enable Moving Region 

Enable Region Editor must be enabled before you can move the region. Click and drag the entire 
region. 

Enable Region Resizing 

Adjust the region size by clicking on the image and moving the yellow points. 

Enable Set Region Direction 

Click a diamond on any side of the ribbon to change the search direction for the Measure Extract (on 
page 251) inspection. 

Close Menu 

Until you use Close Menu or click on the image, the Image Options menu stays open. 
 

Adaptive Region 

This is a region that is built from the edge points found in registrations (except from Template 
Registration). The region adapts to whatever edge points are found. It can follow the shape of your part. 

Series IV users: this is similar to Tracker or Shape Adapt registrations. 
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 Note: Adaptive Region can be added only after one or more Registrations (on page 191). 

 To add an Adaptive Region: 

1. Make sure at least one Registration (see "Registrations" on page 191) has been added to the 
inspection tree. 

2. Highlight the Registration name in the inspection tree. 

3. Right-click on the item you just added. 

4. From the Inspection menu, select Add > Region > Adaptive. The Adaptive region is added to the 
inspection tree. Re-name to something more meaningful to you. 

5. The Adaptive Menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

Adaptive menu 

 

Creation Mode 

Choose whether to have the region adapt to each part as it is inspected [Adapting Region], or to find 
a region once and use it for all parts [Fixed Region]. Different menu parameters are available. Fixed 
Region is described below. 

Region Style 

Choose the type of region you want to create from the registration results. Use the one best suited 
to the area you are inspecting. The options are described below. 
Fit to Circle - A donut-shaped region is created. 

 Note: For descriptions of shapes, also refer to Polygon Region (on page 170) and Ribbon Region (on 
page 172). The difference in the Adaptive Region is that the shape is created using found registration 
points, rather than manually placed points, as is done in the standard Polygon or Ribbon Regions. 

Polygon - a free-form shape is created and filled in. 
Ribbon - a free-form ribbon shape is created. The ends are open. You specify the width of the region. 
Loop - a free-form shape is created. The ends are connected. You specify the width of the region. 
Custom 2 Sided Polygon - a free-form shape is created and filled in. This shape should only be used 
after a Centerline registration. You have the option of creating separate offsets for each side. A 
common use for this is Preform sidewall inspections, where there is a dark area on either side of the 
preform in cameras one and three. With Custom 2 Sided Polygon, you could create the region to 
ignore that dark area. 

Edge Offset 

Specify how many pixels away from the found registration points the Adaptive Region should be. 

Region Offset Side 2 

(Used with Custom 2 Sided Polygon) Create a different offset for one side of the part. This is normally 
used for Preform sidewall inspections. 

Correction Mode 

Correct the edge positions from one of the available techniques: 
No Correction - uses the original registration positions. 
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Simple Smoothing - smooths the edges of the region. 
Circular Smoothing - smooths the edges to form a circle. 
Dual Edge Correction - (applies additional Correction Settings) this mode should only be used after a 
Centerline registration. It corrects missing and bad points in the two sets of edge locations (the two 
sides of the part). 
Bad Point Removal - uses an additional Correction Sensitivity parameter. Removes bad points from 
the found edge positions. If an edge point does not fall within the specified sensitivity, it is removed 
from the Adaptive region. 

Correction Sensitivity 

(used with Bad Point Removal) Adjust the sensitivity of the edge positions between 10 and 500. A 
smaller number means greater sensitivity. 

Diagnostics 

Show Found Edges 

Display the found edges on the image. 

Show Corrected Edges 

Show the edges that were corrected using Correction Mode. 

Show Region Edges 

Show the location of the edges after using Region Offset. 

Correction Settings (Used with Dual Edge Correction) 

Maximum Deviation 

Specify how many pixels an edge can be away from the found edge before applying edge correction. 

Learn Cross Section 

Click the Learn Distances button to determine normal edge locations for that part. 

Fixed Region Adaptive menu 

 

When you choose Fixed Region, the Intellispec will find the shape of the part once, then use that shape 
region for all remaining parts. 

 To set a Fixed Region: 

1. Select a Region Style. 

2. Set the remaining parameters below Region Style as appropriate for your part. 

3. Click the Get Region button to set the region based on the current part. 

Set Region 

Click the Get Region button (after setting the Region Style and other parameters) to set the region 
based on the current part. The Intellispec finds the region edges for the current part and creates a 
polygon or other region style. That region is then used for inspection of all subsequent parts. 

Region Style 

Choose the type of region you want to create from the registration results. Use the one best suited 
to the area you are inspecting. The options are described below. 
Fit to Circle - A donut-shaped region is created. 

 Note: For descriptions of shapes, also refer to Polygon Region (on page 170) and Ribbon Region (on 
page 172). The difference in the Adaptive Region is that the shape is created using found registration 
points, rather than manually placed points, as is done in the standard Polygon or Ribbon Regions. 
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Polygon - a free-form shape is created and filled in. 
Ribbon - a free-form ribbon shape is created. The ends are open. You specify the width of the region. 
Loop - a free-form shape is created. The ends are connected. You specify the width of the region. 
Custom 2 Sided Polygon - a free-form shape is created and filled in. This shape should only be used 
after a Centerline registration. You have the option of creating separate offsets for each side. A 
common use for this is Preform sidewall inspections, where there is a dark area on either side of the 
preform in cameras one and three. With Custom 2 Sided Polygon, you could create the region to 
ignore that dark area. 

Region Width 

(Used with Fit to Circle, Ribbon, and Loop) Specify how many pixels wide the region should be. 

Edge Offset 

Specify how many pixels away from the found registration points the Adaptive Region should be. 

Region Offset Side 2 

(Used with Custom 2 Sided Polygon) Create a different offset for one side of the part. This is normally 
used for Preform sidewall inspections. 

Ribbon/Loop Offset Style 

(Used with Ribbon and Loop) Distance Offset works best with small offsets. Proportional Scaling 
works better with large offsets and keeps the shape nicely. 

 

Enhancements 
Enhancements are used to alter images for the purpose of better defect detection, or for making certain 
features stand out. They are applied to any region type and you can add as many as needed to a region. 

Notes: 

 The unwrapped image (displayed while you are editing an inspection) shows the effect of the 
enhancement. You will not see any difference in the main image. 

 Enhancements are added prior to inspections 

 The order in which you place enhancements is important. The effect of most enhancements is 
cumulative, except for Color Distance and Color Extraction. Color Distance and Color Extraction work 
independently of other enhancements. 

 To determine the best enhancement for your inspection, it may take some experimentation. Use the 
enhancement that brings out the defects or features best for your part. 

 To add an enhancement: 

1. Make sure at least one region (see "Regions of Interest (ROI)" on page 168) is placed on the 
image. 

2. Right-click over the inspection tree and select Insert or Add > Enhancement. 

3. Choose the desired enhancement from the menu. 

The available enhancements are: 

 Subtract Bias (on page 180) 

 Clipping (on page 180) 

 Stretch Grayshades (on page 181) 

 Binary (on page 183) 

 Gamma Correction (on page 184) 

 Grow Dark Areas (on page 185) 

 Grow Light Areas (on page 186) 

 Absolute Difference (on page 187) 

 Color Distance (on page 187) 

 Color Extraction (on page 189) 

 Note: Your system (and this book) may show only those items that apply to your application. 
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Subtract Bias 

Subtract Bias is a simple value subtraction across the entire region. Subtract the given value from all 
pixels in the region. The example below shows the result (bottom image) of subtracting a gray level of 80 
from the top image. 

 

 To add a Subtract Bias enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Subtract Bias. The enhancement is added 
to the inspection tree. Re-name the inspection to something more meaningful to you. 

4. The Subtract Bias menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the parameters as necessary. 

 

Subtract Bias menu 

 

Use Bias 

Enable the enhancement. 

Black Level 

Set the gray level value to subtract from the original value of each pixel in the region of interest. 
 

Clipping 

Clipping is used to change gray shades to a specified value. It allows the system to ignore light reflections 
or normal grain in a part, to provide easier defect detection. 

 To add a Clipping enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Clipping. The enhancement is added to 
the inspection tree. Re-name it to something more meaningful to you. 

4. The Clipping menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the parameters as necessary. 

Clipping menu 
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Clipping mode 

The available modes are as follows - also refer to the illustration below: 
Disabled [item 1] – no clipping. 
Clip Black Level [item 2] – set a dark gray shade value. A dark clipping value of 100 would take all 
pixels with gray levels of 0-99 and make them a gray level of 100. 
Clip White Level [item 3] – set a light gray shade value. A light clipping value of 150 would take all 
pixels with gray levels of 151-255 and make them 150. 
Clip Black and White Levels [item 4] – set both dark and light levels. 
Below are grayscale plots of the area to illustrate the effects of clipping. 

 

 

1 Original grayscale plot- Clipping Disabled 

2 Clip Black Level - example uses 100 as black level 

3 Clip White Level - example uses 150 as white level 

4 Clip Black and White Levels - example uses 100 as black level and 150 as white level 

You will see the effects of clipping in the Unwrapped Region of Interest, as shown below. 

 

 

1 Region 

2 Clipping Disabled 

3 Clip Black and White Levels applied 
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Stretch Grayshades 

Stretch Grayshades is used when you want to make one feature stand out from the rest of the part. This 
technique works essentially how it sounds: it allows you to zoom in on a specific range of gray shades 
and stretch them to the full 0 - 255 range. You will see the effects of stretching gray shades in the 
Unwrapped Region of Interest. 

 To add a Stretch Grayshades enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Stretch Grayshades. The enhancement is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Stretch Grayshades Menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the parameters as necessary. 

 

Stretch Grayshades 

Enable the enhancement. 

Stretch Technique 

Zoom in on any range of gray shades.  
Use Min/Max of Region - the system uses the lowest gray shade found and the highest gray shade 
found, and stretches that range from 0 to 255. 
Use Grayshade Percentiles - Specify lower and upper values in the Shades of Interest box in terms of 
percentage of pixels. The system counts the number of pixels of each gray shade and puts them into 
bins. An example is when 29-65 is used for Shades of Interest. The system determines (a) the gray 
shade where 29% of the pixels fall, and (b) the gray shade where 65% of the pixels fall. The system 
then takes the pixels at gray shades (a) and (b) and sets them to 0 and 255. The gray shades in 
between (a) and (b) are stretched from 1-254. 
Use Absolute Grayshades - Specify lower and upper values in the Shades of Interest box. The system 
sets all pixels at or below the lower specified value to black, pixels at or above the higher specified 
value to white, and the values in between are stretched from grayshades 1 to 254. 

Shades of Interest 

Define the gray shade range that you want to stretch. Adjust so that the desired feature stands out in 
the image. 
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Stretch Grayshades example 

In the example below, we use the mold line as a reference point. We want that mold line to stand out, so 
we use Stretch Grayshades. 

 

 

1 Original image 

2 Unwrapped region of interest with no enhancement 

3 Unwrapped region of interest with Use Min/Max of Region applied 

4 Unwrapped region of interest with Use Grayshade Percentiles and Shades of Interest applied 

 
 

Binary 

This enhancement makes all pixels at or above a threshold white, and makes all pixels at or below the 
threshold black. This can help certain features to stand out. An example of a Binary enhancement is 
shown below. 

 

 

1 Unwrapped region of interest with no enhancement 

2 Unwrapped region of interest with Binary Enhancement applied 

 

 To add a Binary Enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Binary. The enhancement is added to the 
inspection tree. Re-name it to something more meaningful to you. 

4. The Enhancements menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the parameters as necessary. 
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Binary enhancement menu 

 

Use the technique and threshold that best suits your application. 

Binary Technique 

Choose between Fixed Grayshade and Adaptive Grayshade. Set the related threshold as described 
below. 

Adaptive Threshold 

The system computes the ambient level for the region. Set Adaptive Threshold to the percentage of 
pixels to use in the region. This is similar to the Peak Percentile technique used in the Ambient (on 
page 228) inspection. 

 

 

1 Gray level - choose a percentage 

2 Pixels in the histogram of the image 

Fixed Threshold 

The system uses the number you enter. All pixels at or below the threshold will be turned black. All 
pixels at or above the threshold will be turned white. 

 

Gamma Correction 

Gamma Correction lets you reveal detail in a low-contrast image without significantly affecting the 
shadows or highlights. The example below shows the results of the Gamma Correction enhancement 
applied. 

 

 

1 Original image 

2 Decreased contrast - Gamma value less than one 

3 Increased contrast - Gamma value greater than one 
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 To add a Gamma Correction enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Gamma Correction. The enhancement is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Gamma Correction menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the parameters as necessary. 

 

Gamma Correction menu 

 

Gamma Correction 

Enable the enhancement. 

Gamma 

Change the contrast of the image. Values less than one decrease contrast, and values greater than 
one increase contrast. 

 

Grow Dark Areas 

This enhancement will grow the dark areas of the region. This can be used to remove reflections, or 
shrink bright spots on the image. The example below shows how Grow Dark Areas enhances the image. 

 

 

1 Normal image 

2 Image with Grow Dark Areas applied 

 

 To add a Grow Dark Areas enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Grow Dark Areas. The enhancement is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Grow Dark Areas menu is displayed and the region is shown on the image. (The menu is 
described below). Adjust the parameters as necessary. 

 

Enhancements menu 
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Grow Dark Areas 

Enable the enhancement. 

Growth Rate 

Increase this value to grow the areas more. 

Max. Shade Delta 

Specify the largest gray shade difference that can be applied to a pixel during area growth. If this 
value is set to zero, then the resulting pixel can be set to any value. 

 

Grow Light Areas 

Grow Light Areas is the opposite of the Grow Dark Areas enhancement. Small dark defects can be 
blurred out and therefore ignored. The example below shows how Grow Light Areas enhances the image 

  

 

1 Normal image 

2 Image with Grow Light Areas enhancement applied 

 

 To add a Grow Light Areas enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Grow Light Areas. The enhancement is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Grow Light Areas menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the parameters as necessary. 

 

Enhancements menu 

 

Grow Light Areas 

Enable the enhancement. 

Growth Rate 

Increase this value to grow the areas more. 

Max. Shade Delta 

Specify the largest gray shade difference that can be applied to a pixel during area growth. If this 
value is set to zero, then the resulting pixel can be set to any value. 
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Absolute Difference 

Absolute Difference will subtract a value from all of the gray shades in an image. The resulting gray 
shade value is an absolute value, so that value is always positive. For example, assume Absolute 
Difference is set at 100, and two original pixel values are 175 and 25. When the system subtracts 100 
from each, the resulting values are both 75 [175 - 100 = 75, and 25 - 100 = 75] (using the absolute value). 

The example below shows an Absolute Difference of 100 applied. 

 

 

1 Normal image 

2 Image with Absolute Difference enhancement applied 

 

 To add an Absolute Difference enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Enhancement > Absolute Difference. The enhancement is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Enhancements menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the parameters as necessary. Experiment with values to enhance features 
you want to see more clearly on your part. 

 

Enhancements menu 

 

Absolute Difference 

Enable the enhancement. 

Gray Level 

The resulting pixel gray shade is the absolute difference between this value and the original pixel 
gray shade. 

 

Color Distance 

Color Distance is used to provide more contrast between similar colors on an image to make certain 
defects or features stand out. This enhancement only applies to images produced by color cameras. It is 
similar to the Absolute Difference (on page 187) enhancement that is used for grayscale images. 

 Note: Color Distance works oppositely from Color Extraction. Experiment between the two 
enhancements to see which one works better for your application. 

Color Distance evaluates all pixels in the search region against the selected color and translates that 
value to a gray level. The closer a color is to the selected color, the darker the pixel. The further away a 
color is from the selected color, the lighter the pixel. This difference in pixel appearance is only displayed 
in the unwrapped region - not the full part image. 
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The example below shows a purple part against a blue belt. The region of interest is highlighted in the 
image for illustration purposes. Notice that, in the unwrapped region [item 1], the purple and blue colors 
are very similar when translated to grayscale, making it difficult to detect the part edges. We can apply a 
Color Distance enhancement to this image to make purple and blue stand out from each other, as shown 
in the unwrapped image [item 2]. 

 

  

 

1 Normal image 

2 Image with Color Distance enhancement applied 

 

 To add a Color Distance enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click in the inspection tree to see the Inspection menu. 

3. From the Inspection menu, select Add > Enhancement > Color Distance. The enhancement is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Color Distance menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the parameters as necessary. Experiment with values to enhance features 
you want to see more clearly on your part. 

 

Color Distance tab 

 

Color Distance 

Enable the enhancement. 

Distance Technique 

Select how to determine the distance between two colors. 
RGB - Uses the red, green, and blue components of a color. 
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Delta E - Not currently available. 

Color Picker 

Choose the desired reference color. 

 To use Color Picker: 

1. Click the Color Picker button to begin selecting a color from the image. Click in the image again 
until the cursor becomes a cross-hair with an eye dropper. 

 

2. Using the center of the cross-hair, click in the image over the color you want to compare. The box 
next to Color in the menu displays your selected color. 

3. When you have selected the desired color, click the Color Picker button again to complete the 
selection. 

Color 

The box displays the selected color. 
Click on this menu line to display a drop-down menu  array of colors from which to choose. This can 
be used instead of using the Color Picker. 

 
 

Color Extraction 

Color Extraction allows you to choose a color and then the system lightens all pixels with that color. This 
makes certain defects or features stand out. This enhancement only applies to images produced by color 
cameras. 

 Note: Color Distance works oppositely from Color Extraction. Experiment between the two 
enhancements to see which one works better for your application. 

When the Intellispec enhances the image, pixels containing the selected color will appear brighter. This 
difference in pixel appearance is only displayed in the unwrapped region - not the full part image. The 
color pixels are translated to grayscale values and then inspected. This is what you see in the unwrapped 
image. 
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The example below shows a purple part against a blue belt. The region of interest is highlighted in the 
image for illustration purposes. Notice that, in the unwrapped region [item 1], the purple and blue colors 
are very similar when translated to grayscale, making it difficult to detect the part edges. We can apply a 
Color Extraction enhancement to this image to make purple and blue stand out from each other, as 
shown in the unwrapped image [item 2]. 

 

 

 

1 Normal image 

2 Image with Color Extraction enhancement applied 

 

 To add a Color Extraction enhancement: 

1. Make sure at least one region is placed in the inspection tree. 

2. Right-click in the inspection tree to see the Inspection menu. 

3. From the Inspection menu, select Add > Enhancement > Color Extraction. The enhancement is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Color Extraction menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the parameters as necessary. Experiment with values to enhance features 
you want to see more clearly on your part. 

 

Color Extraction tab 

 

Color Extraction 

Enable the enhancement. Use one of the following selections to choose the color you want to 
enhance. 
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Color Extraction Technique 

From the drop-down menu, select the color closest to the color you want to enhance. If you select a 
Raw color such as red, then the Intellispec enhances only the red pixels and ignores the green and 
blue elements of the image. 

Technique Picker 

Choose a reference color from the image. The system will determine the closest color to the choices 
available. Note that the system has a limited set of color filters. 

 To use Color Picker: 

1. Click the Technique Picker button to begin selecting a color from the image. Click in the image 
again until the cursor becomes a cross-hair with an eye dropper. 

 

2. Using the center of the cross-hair, click in the image over the color you want to enhance. The 
menu item next to Color Extract Technique is updated to reflect the selected color. 

3. When you have selected the desired color, click the Technique Picker button again to complete 
the selection. 
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Registrations 
A registration compensates for part movement by calculating the reference point on the part. All 
analyses follow a registration. 

 Note: you must first place a Region of Interest (see "Regions of Interest (ROI)" on page 168) where 
you want the Registration to take place. 

Available registrations include: 

 Feature (on page 192) 

 Center of Mass (on page 194) 

 Hough (on page 196) 

 Radial Edge (on page 199) 

 Centerline (on page 201) 

 Finish Location (on page 204) 

 Template Registration (on page 208) 

 Support Ring Registration 

 Note: Your system (and this book) may show only those items that apply to your application. 
 

Hough vs. Radial Edge 

This topic is intended to help you decide whether to use a Hough or Radial Edge registration for your 
round parts. 

Use the registration that best fits your needs. 

Hough (on page 196) Radial Edge (on page 199) 

Finds edges on not quite round parts Finds edges on round parts 

Works on incomplete circular features Works on complete circular features 

Takes slightly more processing time Faster 

 
 

Feature 

This registration searches for the center of a specific feature that may not fall into a standard inspection 
shape. It looks for all the pixels within a specified gray shade range. Then you can choose whether to 
select the center from all the found features or just the largest feature. Alternately, you may restrict a 
feature size to determine the center; the found feature does not need to be the largest feature. It also 
allows you to count all the found features and reject the part if there are too many or too few. This can 
work on any region type. 

Series IV users: this is similar to Blob Registration. 
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The example below shows a Feature registration to find the largest feature. The center of the largest 
feature is used as the registration point. 

 

 To add a Feature Registration: 

1. Make sure at least one region of interest has been added to the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Registration > Feature. The Feature registration is added 
to the inspection tree. Re-name it to something more meaningful to you. 

4. The Feature Menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

Feature menu 

 

Center Detection 

Choose whether to use the largest feature found, or all features. 

Feature Gray Scale 

Set the range of gray shades of the feature you want to locate. 

Feature Size 

Set the allowable size of the feature you want to locate. 

Show Features 

Highlight the found features on the image. 

Check Feature Area 

Check the area of the feature to see that it is within the specified tolerance. 

Allowed Area 

[only available if Check Feature Area is enabled] The tolerance (in pixel area) of the feature you want 
to locate. 

Nominal 

The expected area size. This number is populated when you press the Learn button. 

Learn Nominal Area 

Click the Learn button to automatically learn the area. 
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Check Feature Count 

Check to see that the correct number of features is found. 
 

Center of Mass 

Center of Mass is a simple edge center routine that will take the average of all found edges and use that 
as the center position. This can work on any region type. 

 Tip: Center of Mass can be used to find edges before an Adaptive Region (on page 176) to assist in 
locating the adapted region. 

An example of a Center of Mass registration is shown below. This registration works with almost any 
shape. The center of the part is marked with a large magenta "X." 

 

 Note: the center is computed from all found edges. If bad edges are found from a defective part, 
those edges would be used in the center computation. 

 To add a Center of Mass registration: 

1. Make sure a Region of Interest has been added to the inspection tree. This inspection will work 
with any region type. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Registration > Center of Mass. The registration is added to 
the inspection tree. Re-name it to something more meaningful to you. 

4. The Center of Mass menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the placement of the region and parameters as necessary. 

 

 To set up the Center of Mass registration: 

1. Make sure the region surrounds the feature that you want to locate. 

2. Go to the Edge Location menu and select an Edge Polarity. If you are searching for a light edge 
against a dark background, choose Dark to Light. 

3. Go back to the Center of Mass menu and select a Center Technique. 

4. If necessary, change the Search Direction (check the Flipped box) to make the search vectors go in 
the opposite direction. 

5. Adjust other parameters as necessary. The menu is described below. 
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Center of Mass menu 

 

Center Technique 

Choose the best technique to find the center. 
Center of Mass - Find the center of mass of the total area enclosed by all edges. In most cases, this is 
the more accurate technique, but it may fail if the part is shaped irregularly, or if you are trying to 
find edges on a linear feature. 
Average of Edges - Use for linear features or if the Center of Mass technique does not work for your 
part. This technique finds the average location of all individual edges. Average of Edges works better 
for ribbon types of regions. 

Search Vector Count 

Set the number of search vectors to locate the feature on the container. More vectors provide a 
more accurate search, but also take more processing time. 

Search Direction 

Change the search to the opposite direction. 

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. In this inspection, only Read Radially is used. The data is extracted in a radial 
direction as shown in the illustration below. 

 

Show Edges 

Show the found edges on the image. 

Qualifying Percent Limits 

The percentage of edges that must be part of the target circle. If there are not enough found edges 
on the target circle, this registration will fail. This can be set lower if you expect large changes in 
sample size (less sensitive). It can be set higher if the size of your product should not vary (more 
sensitive). 

Area Settings 

Click the Learn button to determine the nominal area (in pixels) for your part. 

Area Range 

Define the acceptable deviation (in pixels) from the normal area of the region. You may also adjust 
the values on the Retro-Spec graph. 

Nominal 

The expected area size. This number is populated when you press the Learn button. 
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Learn Nominal Area 

Click the Learn button to automatically learn the area. 

Edge Location menu 

This menu determines what kind of edges the system should look for. 

 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Use Subpixel 

Finds edges based on their subpixel location, rather than rounding off to the nearest pixel. This gives 
greater centering accuracy. 

 

Hough 

This registration locates a circular feature within an image and computes the center point of that 
feature. It also works with features that are not quite round. An important strength of this registration is 
that the feature you wish to find does not need to fit completely within the camera image. As long as a 
good portion of the feature can be found within the image, the computed center point is accurate. It 
also works well if the feature you wish to find is not clearly defined for 360 degrees. 

 Note: Hough registration only works with a Ring region (on page 169). 

Hough registration locates edges on the desired feature and computes the best center position based on 
these edges. 
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1 Feature (white circle) that we are searching for. This feature is partially outside of the camera view. 

2 Found center of the feature 

3 Bounding rectangle. The center must be found within the rectangle. 

 To add a Hough registration: 

1. Make sure a Ring Region (on page 169) of Interest has been added to the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Registration > Hough. The registration is added to the 
inspection tree. Re-name it to something more meaningful to you. 

4. The Hough menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

 To set up the Hough registration: 

1. Make sure the Ring region surrounds the feature that you want to locate. Adjust the ring with the 
parameters in the Ring menu (or the Region Editor on the image) if necessary. 

2. In the Hough menu select a Search Direction. Flipped means that the vectors search from an outer 
to inner direction. If Flipped is unchecked, then the vectors search from an inner to outer 
direction. 

3. Go to the Edge Location menu and select an Edge Polarity. If searching for a light edge against a 
dark background, choose Dark to Light. 

4. Go to the Target Circle menu and click Learn. If the Edge Location parameters are set correctly, the 
system will automatically detect the proper target radius size. The system uses this radius to 
compute the center. You may need to adjust the parameters in the Hough, Target Circle, and Edge 
Location menus to find the desired feature accurately. These menus are discussed next. 

Hough menu 

 

Search Vector Count 

Set the number of search vectors to locate the feature on the container. More vectors provide a 
more accurate search, but also take more processing time. 

Search Direction 

Change the search to the opposite direction. 

 Tip: if you flip the search direction, go back to the Target Circle menu and press Learn to re-learn 
the target radius size. 

Bounding Rectangle 

Adjust the size of the area where you would expect the center of the feature to be found, even with 
slight movement of parts in the camera’s field of view. The system uses only this area to compute the 
center. If the computed center falls outside of this bounding area, the registration fails. 
Use Height and Width to adjust the number of pixels to create the size of the rectangle. 
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 Note: larger sized Bounding Rectangles take more processing time. 

Search Resolution 

The area (in pixels) within the bounding rectangle where the center should be computed. A larger 
resolution allows a larger area. This allows the system to more accurately locate the center on parts 
that are not perfectly round. 

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. In this inspection, only Read Radially is used. The data is extracted in a radial 
direction as shown in the illustration below. 

 

Show Edges 

Show the found edges on the image. 

Minimum Center Strength 

The minimum strength, or quality, you require for the circle fit. When the quality of the fit is less than 
this value, the registration fails. 

Show Hough Graphics 

Display the bounding rectangle and search graphics on the image. 

Target Circle menu 

 

 Tip: to quickly set the Target Circle, click the Learn button. You could adjust the other parameters as 
necessary. 

Target Radius 

The size of the feature you want to find. This is automatically computed by using the Learn process. 

Learn button 

Using the Edge Location settings, the system automatically sets the Target Radius size. 

Adapting Target Radius 

When this is enabled, the system automatically figures out the best fit for the target radius, within 
the inner and outer radius of the region. 

 Note: Increasing Adaptation Range increases accuracy, but it also increases inspection time. 

Adaptation Range 

When Adapting Target Radius is used, this range limits the number of pixels that the target radius can 
move in either direction. 
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Edge Location menu 

 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Use Subpixel 

Finds edges based on their subpixel location, rather than rounding off to the nearest pixel. This gives 
greater centering accuracy. 

 

Radial Edge 

Radial Edge registration is good for circular parts that have a distinct edge either on the inside or outside 
of the part. This only works with a Ring region. Place the Ring region where you would expect the edges 
of the part to fall. The system searches for edges from the inner to the outer radius (or outer to inner 
radius), searching for a transition from light to dark or dark to light pixels. Each search vector tries to 
detect an edge, using the Edge Location parameters. Found edges are marked with a cyan or red '+' for 
pass or fail status. 

 

 To add a Radial Edge registration: 

1. Make sure a Ring Region (on page 169) has been added to the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Registration > Radial Edge. The Radial Edge registration is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Radial Edge Menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 
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 To set up the Radial Edge registration: 

1. Make sure the Ring region surrounds the feature that you want to locate. Adjust with the 
parameters in the Ring menu (or the Region Editor on the image) if necessary. 

2. In the Radial Edge menu select a Search Direction. Flipped means that the vectors search from an 
outer to inner direction. If Flipped is unchecked, then the vectors search from an inner to outer 
direction. 

3. Go to the Edge Location menu and select an Edge Polarity. If searching for a light edge against a 
dark background, choose Dark to Light. 

4. Go to the Target Circle menu and click Learn. If the Edge parameters are set correctly, the system 
will automatically detect the proper target radius size. The system uses this radius to compute the 
center. You may need to adjust the parameters in the Radial Edge, Target Circle, and Edge Location 
menus to find the desired feature accurately. These menus are discussed next. 

Radial Edge menu 

 

Search Vector Count 

Set the number of search vectors to locate the feature on the container. More vectors provide a 
more accurate search, but also take more processing time. 

Search Direction 

Change the search to the opposite direction. 

Radial Tolerance 

The number of pixels in either direction of the target circle that the system will consider an edge 
(that is, the size range allowed for the part). A radial tolerance of two allows a four pixel wide area in 
which the edge of the part may fall. 

Show Edges 

Show the found edges on the image. 

Qualifying Percent Limits 

The percentage of edges that must be part of the target circle. If there are not enough found edges 
on the target circle, this registration will fail. This can be set lower if you expect large changes in 
sample size (less sensitive). It can be set higher if the size of your product should not vary (more 
sensitive). 

Target Circle menu 

 

Target Radius 

The size of the feature you want to find. This is automatically computed by using the Learn process. 

Learn button 

Using the Edge Location settings, the system automatically sets the Target Radius size. 
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Adapting Target Radius 

When this is enabled, the system automatically figures out the best fit for the target radius, within 
the inner and outer radius of the region. 

Edge Location menu 

 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Use Subpixel 

Finds edges based on their subpixel location, rather than rounding off to the nearest pixel. This gives 
greater centering accuracy. 

 

Centerline 

Centerline Registration finds the sides of a container and determines the center line between them. It 
also computes an orientation of the container. This registration uses the mirrored polygon ribbon region. 
With Centerline registration, you can determine the orientation of a feature and compare it to the 
orientation of the entire part. You can also check the slope of the sides of the container, or check the 
overall shape of the container. 

Series IV users: this replaces Midline Orientation, and is similar to Shape Adapt Registration. 

 Note: this registration requires a Ribbon Region (on page 172) using settings: Ribbon Style = Ribbon, 
and Mirror Ribbon = Enabled. 
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 Tip: you can use Centerline to determine Registration plus Orientation, or just Orientation. 

 

 To add a Centerline Registration: 

1. Place a Ribbon Region (on page 172), using a mirrored ribbon. 

2. Right-click in the inspection tree to see the Inspection menu. 

3. From the Inspection menu, select Add > Registration > Centerline. The Centerline registration is 
added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Centerline Menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

Centerline menu 

 

Applied Results 

This determines whether the found center and/or orientation are reported to inspections that follow 
the Centerline. Use Center and Orientation to report both to following inspections. Use Orientation 
to report only the orientation, but use a previously found center. 

Setup Mode 

Use the same parameters to find both sides of the container (Common Setup), or set up the 
parameters differently for each side of the container (Individual Setup). 

Search Vector Count 

Set the number of search vectors to locate the feature on the container. More vectors provide a 
more accurate search, but also take more processing time. 



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Inspections  203 
© 2014 Pressco Technology Inc. Proprietary 
 

 

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. In this inspection, only Read Radially is used. The data is extracted in a radial 
direction as shown in the illustration below. 

 

Diagnostics 

Show Vectors 

Show the search lines on the image. 

Show Edges 

Show the found edges on the image. 

Show Alignment 

Display the alignment of the current part with respect to the previous alignment. 

Shape Check 

Check the angle of the sides of the container. 

Shape Limits 

Set the angle limits for the container. 

Nominal 

The ideal value for the shape of the container. 

Shape Sensitivity 

Set the sensitivity for the straightness of the center line. 100 indicates that points must fall on a 
perfectly straight line (most sensitive). A setting of one indicates that points can fall anywhere (least 
sensitive). A value of 90 is good sensitivity in most cases. 

Area Check 

Check the area of the points found. It is good for determining underblown and overblown bottles. 

Area Range 

Define the acceptable deviation (in pixels) from the normal area of the region. You may also adjust 
the values on the Retro-Spec graph. 

Nominal 

The expected area size. This number is populated when you press the Learn button. 

Learn Nominal Area 

Click the Learn button to automatically learn the area. 

Angle Check 

Check the orientation of a feature against the previous orientation. If an orientation inspection was not 
added to the part program, zero degrees is used. For example, this could be used to detect turned tabs 
on a converted end. 

Angle Limits 

Set the angle tolerance for the feature. 

Nominal 

The ideal orientation of the feature. 
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Centerline Sensitivity 

Set the orientation sensitivity. The range is from one to 100 with one being the least sensitive and 
100 being the most sensitive. The value of 90 is good sensitivity in almost all cases. 

Search Settings menu 

 

This menu specifies settings for the search vectors. 

Vector Direction 

Specify which direction the vectors should search, with respect to the center. 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Use Subpixel 

Finds edges based on their subpixel location, rather than rounding off to the nearest pixel. This gives 
greater centering accuracy. 
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Finish Location 

Finish Location is used to locate the top corners of a bottle. It uses a ribbon region. Finish Location also 
determines part orientation, and passes on the orientation to subsequent inspections. 

Series IV users: Finish Location is similar to Finish Registration in Series IV 

 

  

 To add a Finish Location registration: 

1. Make sure a Ribbon Region (on page 172) of Interest has been added to the inspection tree. An 
example of region placement is shown below. 

 

2. Right-click in the inspection tree to see the Inspection menu. 

3. From the Inspection menu, select Add > Registration > Finish Location. The registration is added to 
the inspection tree. Re-name it to something more meaningful to you. 

4. The Finish Location menus are displayed and the region is shown on the image. (The menus are 
described below) Adjust the placement of the region and parameters as necessary. 

 

Finish Location tab 
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Search Vector Count 

Set the number of search vectors to locate the feature on the container. More vectors provide a 
more accurate search, but also take more processing time. 

Search Direction 

Change the search to the opposite direction. 

Finish Settings 

Tilt Limits 

Set the allowed range of tilt of the part within the image. 

Nominal 

The expected degree of tilt. 

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. In this inspection, only Read Radially is used. The data is extracted in a radial 
direction as shown in the illustration below. 

 

Search tab 

 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Use Subpixel 

Finds edges based on their subpixel location, rather than rounding off to the nearest pixel. This gives 
greater centering accuracy. 

Corner tab 

Adjust these settings to best find the corner on your part. 
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 Note: Enable the Show Corners option in the Diagnostics tab to see the position of the vectors. 

 

Corner Desensitization 

Larger values are used to detect more rounded corners. This is used to prevent detection of false 
corners. 

The illustration below shows the top and side vectors that search for the part. Note that your image may 
be rotated depending on application. Regardless of orientation, the top vectors search for the top of 
your part, and the side vectors search for the sides of your part. 

 

 

1 Top vector (perpendicular to the ribbon) 

2 Side vector (parallel to the ribbon) 

Top Vector: Side Shift 

Move the top vectors closer or further away from the corner. 

Side Vector: Down Shift 

Move the side vectors closer or further away from the corner. 

Side Vector: Side Shift 

Move the side vectors closer to or further away from the midpoint of the cap or part. 

Side Vector: Length 

Increase or decrease the length of the side search vectors. 

Diagnostics tab 

 

Show Vectors 

Show the search lines on the image. 
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Show Search Direction 

Show the search direction of the vectors with an arrow. 

Show Edges 

Show the found edges on the image. 

Show Corners 

Display the location of the finish corners. 

Show Corner Search 

Display the search used to find the corners. You must also enable 'Show Graphics' in the Image 
Options (on page 141) menu. 

Show Framing 

Display the lines that show where the finish is located based on the projected corners. 
 

Template Registration 

Template Registration is used to locate the center of a feature that is either irregularly shaped, or is 
located in a region with a lot of gray scale variation. Examples include rivets from converted ends, EZO 
ends, and rectangular bottles. 

 Notes: this registration may not perform well if the visual features are not consistent from part to 
part. 

 If an orientation is needed, use a separate Template Orientation (on page 222) instead of the 
orientation built into this inspection, to save processing time, EXCEPT if you are inspecting a part 
with decoration on it. See the Template Registration menu description for more information. 

Series IV users: This is similar to Series IV Template Registration 

Before adding the Template Registration: 

Choose Option 1 or Option 2 from the choices below. 

 Option 1: If your part's feature appears in an unpredictable location in the image, then use 
the Measure ROI method: 

Example: for this EZO closure, we are not sure where the rivet will appear in the image. We are using 
Measure ROI region. 

 

1. Add a Measure ROI (on page 174) region of interest to the part program. This can be placed at the 
highest level in the inspection tree. 

 



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Inspections  209 
© 2014 Pressco Technology Inc. Proprietary 
 

 

2. Leave Region Count at One Region. 

3. In the Measure ROI menu, set the Center Offset X and Y to zero. 

 

4. Place the inspection region over almost the entire region: 

 If you have a 640 x 480 image, then set Region Width and Region Height to 630 and 470, 
respectively. This allows a five pixel margin around the inspection window. 

 If you have a 1360 x 1024 image, then set Region Width and Region Height to 1350 x 1014, 
respectively. This allows a five pixel margin around the inspection window. 

5. Click the OK button  to save changes and exit the menu. 

6. Go to the section: "To add a Template Registration." 

 Option 2: If you know approximately where your part's feature might appear in the 
image, then use a Ring or other region method: 

Example: in this converted end rivet image, we know approximately where the rivet might appear. We 
are using a Ring region. 

 

1. Add a Ring region (or other region) to the part program. Note: make this region as small as 
possible, but make sure that the desired feature is ALWAYS in the region of interest regardless of 
part movement. Using a smaller region saves inspection time. 

2. Click the OK button  to save changes and exit the menu. 

3. Add a Template Registration. 

 To add a Template Registration: 

1. Make sure a region has been added to the inspection tree, as described above in either Option 1 
or Option 2. 

2. Acquire about 100 images to get a good sample population of part images: 

 Put the lane online, long enough to acquire about 100 images. Take the lane offline. 

 OR: Use Offline Imaging (on page 113). Right-click the Sensor button to see the Sensor menu > 
select Offline Imaging > Immediate Mode Run button. Exit the Offline Imaging screen after 
acquiring about 100 images. 

3. Right-click on the item you just added. 
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4. From the Inspection menu, select Add > Registration > Template Registration. The registration is 
added to the inspection tree. Re-name it to something more meaningful to you. The Template 
Registration menus are displayed and the region is shown on the image. (The menus are described 
below) 

5. If your part does not have deco, then un-check the Perform Orientation box in the Template 
Registration menu. Then go to the section: "To save a seed image." 

6. If you are inspecting a part with deco, then leave the Perform Orientation box checked. 

7. Go to the Settings menu and click the Standard Settings button. 

Next, choose an image and save it as a seed image. A "seed" image is a sample image that the system 
uses when creating an average image for the template. 

 To save a seed image: 

1. From the Retro-Spec inspection screen, find an image that represents a regular part - not the best 

image, not the worst image, but a typical part image. Use the forward/ backward arrows  to 
scroll through the acquired images. 

2. If necessary, adjust the region size and placement to cover an area where there is a repeatable 
and distinct grayscale pattern. 

3. Go to the Template menu (described below) and click the Save Seed button. An on screen 
keyboard is displayed.  

4. Name the seed image and click the OK button  to save. A Saved Template dialog box is 
displayed with the name and location of the saved template image. 

 

5. Click the OK button to close the message. 

6. To verify that you have saved a good image, click the View Template button. The Template Image 
Viewer will display the seed image you saved. If you want to save a different image, select another 
image and click the Save Seed button. 

OPTIONAL: Select a Template Region type. The system will look at a smaller portion of the region to 
save inspection time (In our example, we want to find just the rivet in the image). 

 Note: in MOST APPLICATIONS, you will use the entire inspection region rather than looking at only a 
portion of the region. Skip to the section "To adjust the registration." 

 To select a Template Region type: 

1. In the Template Region menu, select a Template Region type: either Ring Region or Polygon 
Region, depending on the feature you want to locate. In our example, we want to find a circle, so 
we choose Ring region. (The region types are discussed in the section titled "Template menu") 

 Notes about using Ring or Polygon region: 

a) The registration does not perform an orientation when looking for this region. The feature used 
for the polygon or ring region must be located in the same place on each part. 

b) Template Region is only used with a seed image. If you later use "Create Template," then the 
inspection uses the entire created prior to adding the Template Registration inspection. It 
ignores this ring or polygon region. 

2. Click the View Editor button. The Template Image Viewer is displayed with the template image. 
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3. Click inside the region in the Template Image Viewer image to adjust its size and position. Use the 
yellow boxes as points to adjust the region. Moving one yellow box adjusts all four boxes, making 
the ring either larger or smaller. Wait while the system updates the image. An example is shown 
below. 

 Right-click in the Template Image Viewer to view the Image Options menu. Turn on or off 
options to change the region and use as needed. 

 If using a Polygon Region, the system will prompt you to click anywhere in the image to begin 
placing points. Keep clicking points in image to create the polygon. To close the polygon, click 
the first point again. 

 Remember that the center point is also a ring (if using a Ring Region). It can be adjusted to 
create a donut shaped region. 

 

4. Click the OK button in the Template Image Viewer to save changes and exit. 

Next, test the registration and adjust settings so that it will work on almost all part images. The menus 
are described below. If you set up a Template Region, then you will NOT use the Create Template section 
described below. 

 FOR MOST APPLICATIONS: To adjust the registration:  

1. In the Retro-Spec graph, or using the forward and backward arrows below the image, view all the 

images in Data Set A. If necessary, use the  or  buttons to acquire more 
images. You want a range of part images that represent your production line. They do not have to 
be perfect images, but you should remove images of parts that should obviously be rejected. 

2. Delete images of any parts that should not be part of the sample population: 

a) Click the Lock/ Move Parts button to unlock the data set.  

b) Click the bar on the graph for any part you want to delete, then click the trash can icon to delete 
the part from the set. 

c) For information about how to use the graph, see Retro-Spec Population View Graph. 

d) Click the Lock/ Move Parts button again to lock it. 

3. In the Template menu, click the Create Template button. This creates a template using all the data 
set images combined instead of using one image. 

4. (Optional) In the Settings menu, set Downsize Level at Level 2 (16 to 1). This will speed inspection 
time. 

 Note: Downsizing creates a slight pixel error. The more Downsizing used, the more pixel error is 
produced. We use Downsizing when Template Registration is being used as a coarse registration 
to locate a feature. We then add an additional registration such as Radial Edge or Hough to 
accurately find the center of the feature. 
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5. In the Template Registration menu, adjust Registration Strength. This can be adjusted by the 
horizontal bar in the Retro-Spec graph. This will set pass/ fail limits for the registration. 

6. Test the registration: put the lane online to acquire several images, then click the  or 

 buttons to update the Retro-Spec graph. Make sure that bad parts are failing, as 

indicated in the Retro-Spec graph (red bars). Take the lane offline. If you used the  to 
update the images, then click it again to stop updating the Retro-Spec graph. 

7. Make adjustments to the registration as instructed by Pressco for your application. The menus are 
described below. 

8. In applications such as our example, Template Registration is used as a coarse registration. Add 
another registration after the Template Registration, such as Radial Edge, to accurately locate the 
center of the feature. 

Template menu 

 

Selected Template 

Select any saved template from the drop-down menu. If no templates have been created, no 
drop-down menu is available. 

Save Template Image 

Save the current image as a template. 

View Template Image 

To verify that you have selected the correct template image, click the View Template button. A 
pop-up window displays the saved template image. An example is shown below. 

 

 Note: displaying the template image does not display it in the Intellispec image area. 

Create Template 

Use all the images in Data Set A to create an average image, starting with the seed image. For best 
results, delete all defective images, or images that you do not want as part of the template, from 
Data Set A. 
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Template Region menu 

Choose whether to use a single region for both the search region and the template region. Using 
multiple regions can speed up inspection time. 

 

Template Region Type 

 Note: most applications use Inspection Region. If you use Ring or Polygon region, then the system 
only uses a seed image as the template (not Data Set A, as is used when you click Create Template). 

Select the region to use for the template region.  

 Use Inspection Region - Use the region of interest already set up prior to this inspection. 

 Use Ring Region - Create a region smaller than the search region, to speed up inspection time. 

 Use Polygon Region - Create a polygon region to use for the template instead of the search 
region, to speed up inspection time. When you choose this option, click the View Editor button 
to create the polygon. In the Template Image Viewer, create a polygon by clicking several points 
in the image. To complete the polygon, click the first point again. 

 Note: The following parameters are used only if Use Ring Region is selected for Template Region 
Type. View Template Editor is also used when Use Polygon Region is selected. 

View Template Editor 

To move the region, click the View Editor button. A pop-up window displays the saved template 
image with a region. Click in the image to move the region. Right-click in the viewer for more options. 
An example is shown below. 

 

 Note: the content in the image viewer does not display in the Retro-Spec image area. 

X and Y 

Enter the X and Y offset coordinates for the center of the region you want to establish as your 
template region. These values are set as a number of pixels away from the center of the search 
region. 

Inner Radius 

Size of the inner ring. 
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Thickness 

The thickness of the ring; outer radius minus inner radius. 

Use Arcs 

This is normally NOT used in this inspection. If enabled, it divides the ring region into arc segments. 

Template Registration menu 

 

Registration Strength 

Set the minimum strength, or quality, you require for registration between the inspected image and 
the template image. This sets the pass/ fail limits. You can set this using the horizontal bar on the 
Retro-Spec graph (after you select this parameter in the menu). 

Registration Normalization 

Normalization uses template data as a reference and compares it to current part data. Normally this 
does not need to be changed from Component Magnitude. If you are getting inconsistent results, try 
another technique. Use the technique that works best for your parts. We recommend trying the 
techniques in this order: 

 Component Magnitude - default, used in most applications. 

 Component Power - try this as a second option. 

 Global Power - try only if Component Magnitude or Component Power do not work for your 
part. 

 Phase Only - not used. 

Registration Normalization Gain 

Leave this set at zero. 

Perform Orientation 

Select whether an orientation is performed as part of the inspection. This is normally not used, 
except if you are inspecting parts with decoration on them. We recommend that if you need to 
perform an orientation (on parts without deco), use a separate Template Orientation (on page 222) 
to save inspection time. 
The following parameters are only used if Perform Orientation is enabled. 

Orientation Strength 

Set the minimum strength, or quality, you require for orientation between the inspected image and 
the template image. You can set this through the bar on the graph. If the current part falls below this 
value, the part fails. 

Orientation Normalization 

Normalization uses template data as a reference and compares it to current part data. Normally this 
does not need to be changed from Component Power. If you are getting inconsistent results, try 
another technique. Use the technique that works best for your parts. We recommend trying the 
techniques in this order: 

 Component Power- default, used in most applications. 

 Component Magnitude - try this as a second option. 
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 Global Power - try only if Component Magnitude or Component Power do not work for your 
part. 

 Phase Only - not used. 

Orientation Normalization Gain 

Leave this set at zero. 

Check Scale 

We recommend that you leave this box un-checked. Scale refers to a magnification factor in the 
event of a change in optics or part movement. It can be used as a reject limit for part size. 

Image Scale Units 

[Only used when Check Scale is enabled] Restrict how much the size of the inspected image is 
allowed to be adjusted to match the template image. A value of one (1) indicates that the size 
matches exactly. A value less than one means that the image needs to be reduced to match the 
template. A value greater than one means that the image needs to be enlarged to match the 
template. If you use this parameter, be aware that it adds time to the inspection. Also know that a 
setting of 0.9 to 1.1 means that there could be 10% variation in either direction from an ideal part. 

Settings menu 

Use the suggested rules, described below, for optimum inspection. 

 

Standard Settings 

Click the Standard Settings button to automatically set Radial Samples and Angular Samples based 
on the current region settings. (In Template Registration, this refers to settings in the Template 
Registration menu only if Perform Orientation is enabled.) 

Radial Samples 

This number divides the region into a number of rings. See example under Angular Samples below. 
To set this manually, set this to the approximate outer radius of the template region, rounded up. For 
example, if you have a Ring region, go to the Ring menu, and add Inner Radius plus Thickness to get 
Outer Radius. In the Settings menu, use the next highest value from the radius. 

Angular Samples 

This number divides the region into a number of arcs. See example below. 
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Example: This example shows a region with three (3) radial samples and eight (8) angular samples. 
(Note: these values are not available in the inspection. These examples and shading are for 
illustration purposes only.) 

 

Downsize Level 

Using this option depends on the image. For example, if your part image has grain, then use a 
Downsize Level of 4 to 1 - this will blur the image enough to almost ignore the grain. 
Enabling this option looks at the region differently by grouping pixels. The system will look at pixels in 
groups of 4 (Level 1), 16 (Level 2), or 64 (Level 3). Larger values reduce the image further, speeding 
up the inspection at the cost of resolution. 

Grain Reduction Technique 

This is an optional filter. Enable this feature only if your part has grain and is causing inspection 
problems. This filter will help block grain from the image. Use the technique that works best on your 
part. 

Contrast Compression Technique 

This is an optional filter. Enable this feature only if your part has low-frequency changes such as 
shadows that are causing inspection problems. Use the technique that works best on your part. 

Advanced Orientation 

If this is enabled, it provides an enhanced technique to perform the orientation. Note that this 
increases inspection time. 

View Filtered Region 

[Only applicable if any of the filter techniques above are being used] This displays the image area 
using the filters. 

Offset Center X and Y 

We recommend that you leave these values set at zero. 

Select Center Offset 

Click the Select Center button to initiate the selection. Then click in the image where the center 
should be. Wait while the system computes the new center values and populates the Offset Center X 
and Y parameters. Then click the Select Center button to complete the selection. 
Offset Angle and Select Offset Angle are only used if Perform Orientation is enabled. 

Offset Angle 

Rotate the inspections on an image. Set the angle on a specific feature to match the current 
orientation of the part. You can use the Select Angle button to set this value. This feature saves you 
from modifying subsequent regions during slight changes that might affect region placement. 

 Note: this angle can only be set after you create a template. 

Select Offset Angle 

Click the Select Angle button to initiate the selection. Then click in the image where the orientation 
should point to. Wait while the system computes and then populates the Offset Angle parameter. 
Then click the Select Angle button to complete the selection. 

Color to Grayscale 

Not used. 
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Support Ring Registration 

The Support Ring Registration is used in the filling application to locate both sides of the neck ring on a 
bottle and then position the following inspections with respect to these points. This registration always 
uses a Measure ROI (on page 174) Region. The Support Ring registration finds the edges of the neck ring, 
then it computes the diameter of the neck ring as well as the tilt of the bottle. 

 Note: Support Ring Registration requires a Measure ROI (on page 174) region. 

 Before adding a Support Ring registration: 

 Add a Measure ROI (on page 174) Region of Interest to the inspection tree (if you do not already 
have one). This region of interest should cover the support ring, a portion of the cap, and enough of 
the bottle so that it can accurately determine the tilt of the bottle. It should also be able to 
accommodate some part movement in the camera's field of view, but make sure that adjacent 
bottles cannot be seen in region. 

 The Measure ROI region of interest should be oriented such that the search direction is pointing 
towards the cap. 

 A sample Measure ROI placement is shown below. 

  

 

Measure ROI placement for Support Ring Registration 

1 Measure ROI re-sizing handles. Make sure these are oriented towards the cap and sides. 

2 Yellow diamond indicates search direction. Make sure search direction is towards cap. 

 

 To add a Support Ring registration: 

1. Make sure a Measure ROI region of interest has been added to the inspection tree. A sample 
Measure ROI placement is shown above. 

2. Right-click on the name of the region you just added. 
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3. From the Inspection menu, select Add > Registration > Support Ring. The registration is added to 
the inspection tree. Re-name it to something more meaningful to you. 

4. The Support Ring menus are displayed and the region is shown on the image. (The menus are 
described below) Adjust the placement of the region and parameters as necessary. 

 

 

Support Ring Registration menu 

Use the Support Ring Registration tab to locate the support ring. Use the settings recommended by 
Pressco support engineers, and adjust as necessary for your part. 

 Tip: use the Learn Settings button to allow the system to automatically learn the parameters for this 
menu. Then adjust the remaining parameters as necessary. 

 

 Note: The symbol [ ] indicates that this value is in pixels. Your system may show [mm] for 
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be calibrated 
using Review Camera Calibration (on page 120) or Image Analysis (on page 114) for the current 
sensor. 

Candidate Threshold 

The minimum distance you expect the support ring to extend from the profile of the bottle. Set this 
value at a minimum distance, such as 15. Setting this value too high may make the inspection less 
accurate if there is water under the support ring. 
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Candidate Delta 

The number of pixels between each edge comparison that the system looks for transitions that 
indicate the support ring. The system looks at the edge profile of the bottle. A typical setting is 10. 

Candidate Thickness 

The minimum width (in pixels) that you expect the support ring to be. You can usually set this to a 
small value, such as five. 

Learn Settings 

Click this button to automatically set the parameters to find the support ring edges. 

Tilt Limits 

Set the allowed range of tilt of the part within the image. 

Nominal 

The expected degree of tilt. 

Distance Limits 

Specify the minimum and maximum distance between the two reference points. 

Nominal 

The ideal distance. 

Show Vectors 

Show the search lines on the image. 

Show Search Direction 

Show the search direction of the vectors with an arrow. 

Show Edges 

Show the found edges on the image. 

Edge Location Setup 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Calibration menu 

Use this menu to program the system to translate pixels into your desired units of measure (mm, for 
example). 

 

Calibration Mode 

The system will convert the pixel dimensions into your preferred unit of measurement. 
Sensor Calibration -- Use the calibration previously set up for the sensor through Image Analysis (on 
page 114) or through another inspection. 
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Inspection Calibration -- Use the calibration from this inspection only. 

Units 

Choose your preference in the reporting of the measurements. Choose from millimeters, inches, 
pixels, and custom. Custom allows any calibration factor to be used. 

Conversion Factor 

This indicates the pixel size and is used to convert one pixel into the units selected. The initial 
conversion will be controlled by the Learn Calibration results. You can adjust this value manually if 
necessary. 

Learn Calibration 

Click the Learn Calibration button to automatically determine the scale factor, which converts the 
value to the desired units. 

 Note: you must first enter the Measured Distance before learning calibration. 

Save Calibration 

Click the Save Calibration button to save the calibration scale and units to the sensor for use by other 
inspections. 

Measured Distance 

Measure your part with calipers or another tool, then enter the actual value for Measured Distance. 
This is used to help calibrate the measurement. 
 

 

Orientations 
An orientation compensates for part rotation by finding a grayscale pattern. An analysis which must 
rotate with the part must follow an orientation. 

 Note: you must first place a Region of Interest (see "Regions of Interest (ROI)" on page 168) where 
you want the Orientation to take place. 

Available orientations include Pattern Match (on page 220) and Template Orientation (on page 222). 

 Note: the Centerline (on page 201) and Template (see "Template Registration" on page 208) 
Registrations also contain an orientation angle that can be used to orient regions. 

 

Pattern Match 

Pattern Match Orientation creates a pattern to be matched. A Pattern Match reference must be set on 
one part that you consider to have the desired pattern. The Pattern Match reference sets the standard 
to which all other parts inspected must meet. The Pattern Match is based on percentages; the 
referenced pattern will be 100%. All other parts will be compared to the referenced pattern and given a 
percentage depending on how the two patterns match up. In other words, a part with an 88% Pattern 
Match rating is 88% similar to the referenced part. If the inspected part has too low of a percentage, the 
part will fail the orientation. 
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1 Normal orientation 

2 Incorrect orientation 

 

 Note: Pattern Match only works with a Ring Region (on page 169). 

 To add a Pattern Match Orientation: 

1. Make sure a Ring Region (on page 169) of Interest has been added to the inspection tree. 
Normally the region is a narrow donut- shaped region placed over a repeatable pattern on the 
part, such as ridges or other geometry. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Orientation > Pattern Match. The Pattern Match 
orientation is added to the inspection tree. 

4. The Pattern Match menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the placement of the region and parameters as necessary. 

Pattern Match menu 

 

  Important:  Set Reference before adjusting other parameters. 

Symmetry Repeat 

Divide the donut-shaped region into a number of pie-shaped sections. The system need only match 
the gray shade pattern in one of these sections to determine proper orientation. 
An example for the use of symmetry is when you are inspecting the base of a bottle that has five feet 
- use a symmetry of five. The system uses a gray shade pattern in one-fifth of the region, and you are 
assured proper orientation because these gray shade patterns are identical in the other four sections 
of the region. 
This feature can speed up this orientation. The time required for the orientation is reduced by 
1/symmetry squared. If you have a symmetry of five, this orientation takes 1/25th the amount of 
time it would take with a symmetry of one. 

Radial Spacing 

The number of pixels between search circles. It can be used to increase the speed of this inspection, 
especially if the region is large. 

Select Offset Angle 

Set the Offset Angle (described below). Click the Select Angle button, then click in the image where 
you want the orientation to point to. 
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 Note: you can only set Offset Angle if the inspection is passing. You may have to adjust other 
parameters, or disable other inspections while setting this to get the inspection to pass. 

Offset Angle 

Allows you to rotate the inspections on an image. Set the angle on a specific feature to match the 
current orientation of the part. This feature saves you from modifying subsequent regions during 
slight changes that might affect region placement. 

Set Reference 

Click the Set Reference button  to set the reference pattern from the currently 
displayed image. 

Show Orientation 

Display the orientation line on the image. 

Part View Display 

Allows you to look at different results for the part. You must enable 'Show Pattern Match' to see the 
information in the unwrapped image. 
Show Correlation Plot - Displays a plot to show the correlation between the reference pattern and 
the current image in the unwrapped image. 
Show Pattern - Displays the extracted grayscale pattern of the current image. 
Show Normalized Pattern - Displays the extracted grayscale pattern of the current image; the values 
are normalized so that the highest value is one.  
Show Pattern Delta - Displays a plot of the differences in the pattern. 

Show Pattern Match 

Display a graphical plot of the pattern match on the unwrapped image. An example is shown below. 

 

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. In this inspection, only Read Radially is used. The data is extracted in a radial 
direction as shown in the illustration below. 

 

Pattern Match Confidence 

Define how closely the pattern must match the original sample. To adjust this value, you can change 
the numerical value, or click and drag the red line in the Retro-Spec graph at the top of the screen. 
If you check Show Pattern Match, you can see the red failure limit line in the unwrapped image move 
when you change this value.  
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Template Orientation 

Template Orientation can determine the orientation of a feature that is either irregularly shaped, or is 
located in a region with a lot of gray scale variation. However, it can be used on any part. It is fast and 
accurate. 

 Note: if you have a part that requires using symmetry, such as the base of a plastic bottle, or a 
lugged closure, use Pattern Match (on page 220) to find the orientation. 

 Note: you must have a registration in the part program prior to the Template Orientation. The 
registration will locate the part and allow the Template Orientation to be properly placed. 

 Before adding a Template Orientation: 

1. Add a registration that will best locate your part. 

2. Add a region of interest in the area where you want to place the Template Orientation. An 
example is shown below. We want to orient the part using the rivet and the surrounding part 
geometry. 

 

 To add a Template Orientation: 

1. Make sure a region of interest has been added to the inspection tree. A sample Ring region 
placement is shown above. 

2. Acquire about 100 images to get a good sample population of part images: 

 Put the lane online, long enough to acquire about 100 images. Take the lane offline. 

 OR: Use Offline Imaging (on page 113). Right-click the Sensor button to see the Sensor menu > 
select Offline Imaging > Immediate Mode Run button. Exit the Offline Imaging screen after 
acquiring about 100 images. 

3. Right-click on the item you just added. 

4. From the Inspection menu, select Add > Orientation > Template Orientation. The orientation is 
added to the inspection tree. Re-name it to something more meaningful to you. 

5. The Template Orientation menus are displayed and the region is shown on the image. (The menus 
are described below) Adjust the placement of the region and parameters as necessary. 

Next, choose an image and save it as a template as follows: 

 To save a template image: 

1. From the Retro-Spec inspection screen, find an image that represents a regular part - not the best 
image, not the worst image, but a typical part image. Use the forward/ backward arrows to scroll 
through the acquired images. 

2. If necessary, adjust the region size and placement to cover an area where there is a repeatable 
and distinct grayscale pattern. 
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3. Go to the Template menu (described below) and click the Save Template button. An on screen 
keyboard is displayed. 

4. Name the template image and click the OK button   to save. A Saved Template dialog box is 
displayed with the name and location of the saved template image. 

 

5. Click the OK button to close the message. You can set the remaining parameters of the Template 
menu at a later time. 

Next, set the parameters in the other menus. Use the steps below for quick setup of the orientation. 
Depending on your part and application, you may need to make other adjustments after these steps. The 
parameters for each of the menus are described below. 

 To set up the Template Orientation: 

1. In the Template Region menu, make sure Use Inspection Region is selected. 

2. In the Settings menu, click the Standard Settings button so that the system can adjust to the 
image. 

3. In the Settings menu, click the Select Angle button. Click in the image where the orientation 
should point to. Wait while the system populates the Offset Angle parameter. Then click the Select 
Angle button again to complete the process. 

4. In the Template Orientation menu, adjust Orientation Strength to pass or fail the part. This can be 
adjusted using the bars on the graph. 

5. Acquire more images and test the orientation. Make other adjustments as necessary in the menus, 
making sure that the orientation is properly found on each part, and that improperly oriented 
components make the part fail. 

Below is an example of how a Template Orientation looks on a part. 

 

The menu parameters are described below. 
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Template Region menu 

Make sure that Use Inspection Region is selected. This setting should be used unless otherwise 
instructed by Pressco. 

 

Settings menu 

Use the Standard Settings button and Select Angle button for easy setup in this menu. 

If your inspection is not getting consistent results, set the Angular Samples, Downsize Level, and Offset 
Angle, using the guidelines described below. 

 

Standard Settings 

Click the Standard Settings button to automatically set Radial Samples and Angular Samples based 
on the current region settings. (In Template Registration, this refers to settings in the Template 
Registration menu only if Perform Orientation is enabled.) 

Angular Samples 

This number is automatically set by clicking the Standard Settings button (in the Settings menu). This 
number divides the region into a number of arcs. See example below. 
Example: This example shows a region with three (3) radial samples and eight (8) angular samples. 
(Note: these values are not available in the inspection. These examples and shading are for 
illustration purposes only.) 

 

Downsize Level 

Using this option depends on the image. For example, if your part image has grain, then use a 
Downsize Level of 4 to 1 - this will blur the image enough to almost ignore the grain. 
Enabling this option looks at the region differently by grouping pixels. The system will look at pixels in 
groups of 4 (Level 1), 16 (Level 2), or 64 (Level 3). Larger values reduce the image further, speeding 
up the inspection at the cost of resolution. 
For Template Orientation, this can be left disabled for most applications. 

Offset Angle 

Rotate the inspections on an image. Set the angle on a specific feature to match the current 
orientation of the part. You can use the Select Angle button to set this value. This feature saves you 
from modifying subsequent regions during slight changes that might affect region placement. 

 Note: this angle can only be set after you create a template. 

Select Offset Angle 

Click the Select Angle button to initiate the selection. Then click in the image where the orientation 
should point to. Wait while the system computes and then populates the Offset Angle parameter. 
Then click the Select Angle button to complete the selection. 
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Template Orientation menu 

Set the parameters in this menu to pass or fail the part based on orientation. 

 

Orientation Strength 

Set the minimum strength, or quality, you require for orientation between the inspected image and 
the template image. You can set this through the bar on the graph. If the current part falls below this 
value, the part fails. 

Orientation Normalization 

Normalization uses template data as a reference and compares it to current part data. Normally this 
does not need to be changed from Component Power. If you are getting inconsistent results, try 
another technique. Use the technique that works best for your parts. We recommend trying the 
techniques in this order: 

 Component Power- default, used in most applications. 

 Component Magnitude - try this as a second option. 

 Global Power - try only if Component Magnitude or Component Power do not work for your 
part. 

 Phase Only - not used. 

Orientation Normalization Gain 

Leave this set at zero. 

Template menu 

This menu allows you to save a template image, view the selected template image, and create a region 
that is different from the region of interest that the orientation uses. 

 

Selected Template 

Select any saved template from the drop-down menu. If no templates have been created, no 
drop-down menu is available. 

Use Common Template Region 

[only available after more than one template is saved] There are two regions to consider: the 
template region and the search region. Using a Common Template Region uses the same region for 
both. Using this feature depends on your part. When you have an image that does not work well with 
other registrations, such as a rivet on a converted end, an EZO end, or rectangular bottles, then 
un-check Common Template Region. 
Where possible, use another registration such as Radial Edge or Hough prior to this inspection, and 
Use Common Template Region. This allows you to keep the region smaller, and uses less processing 
time. 
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Template Center X and Y 

This is not normally used in an orientation. However, it allows you to offset the center of this region 
from the center found by the registration that this orientation uses.  

Template Region Radius 

This is not normally used in an orientation. However, it allows you to adjust a region radius different 
from the one set up by the region of interest. 

Save Template Image 

Save the current image as a template. 

View Template Image 

To verify that you have selected the correct template image, click the View Template button. A 
pop-up window displays the saved template image. An example is shown below. 

 

 Note: displaying the template image does not display it in the Intellispec image area. 

 
 

Analyses 
These analyze the part for defects, features, measurements, or gray shades. 

 Note: you must first place a Region of Interest (see "Regions of Interest (ROI)" on page 168) where 
you want the analysis to take place. We also recommend a Registration (see "Registrations" on page 
191) and an Orientation (see "Orientations" on page 220) (depending on the part type) prior to an 
analysis. 

The available types of analyses are: 

 Ambient (on page 228) 

 Shape Check (on page 230) 

 Contrast (on page 232) 

 Measurement (on page 238) 

 Fill Height (on page 245) 

 Measure Extract (on page 251) 

 Distribution (on page 252) 

 Label Skew Extract (on page 257) 

 Feature Detect (on page 259) 

 Note: Your system (and this book) may show only those items that apply to your application. 
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Ambient 

Ambient is a measure of gray levels in a selected region and looks for abnormal gray levels. There are 
three ways in which to measure a part’s ambient: Max Amplitude, Peak Percentile, and Density. You can 
set the Ambient Analysis Mode to have maximum reject limits, minimum reject limits, or a combination 
of maximum and minimum reject limits. 

  

 

1 Normal Ambient 

2 Incorrect Ambient 

 

 To add an Ambient analysis: 

1. Make sure a Region of Interest (see "Regions of Interest (ROI)" on page 168) has been added to 
the inspection tree. We also recommend a Registration (see "Registrations" on page 191). 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Analysis > Ambient. The Ambient analysis is added to the 
inspection tree. 

4. The Ambient menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

Ambient menu 

 

Ambient Technique 

This method determines the region’s ambient. Choose the method through the drop-down menu. 

 Max Amplitude looks for the maximum gray level amplitude — the gray level with the most pixel 
counts — within the histogram of the search area. 

 

1 Gray level 
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2 Pixels in the histogram of the image 

 

Peak Percentile locates the gray level value that exceeds the threshold. In the example below, the 
system would use the gray level to the right of the line marking 80%. 

 Ambient Threshold defines what percentage of the search area to use. 

 

 

1 Gray level - choose a percentage 

2 Pixels in the histogram of the image 

 

 Density computes the average of all the pixel gray levels — total gray level divided by pixels. 

Ambient Analysis Mode 

Specify the reject criteria.  
Min & Max - The minimum and maximum acceptable ambient gray level values. Any computed 
ambient found lower than or greater than these values will cause the inspection to fail. 
Min Only - The minimum acceptable ambient gray level value. Any computed ambient found lower 
than this value will cause the inspection to fail. 
Max Only - The maximum acceptable ambient gray level value. Any computed ambient found greater 
than this value will cause the inspection to fail. 

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. 

 Note: some inspections do not use all of these options 

The illustration below shows how the information is read by each method. Note that these shapes 
are examples only - your region does not have to match the shape. 

 

 

1 Read Horizontally - Extract the region horizontally - 90 degrees with respect to orientation. 

2 Read Vertically - Extract the region vertically - parallel with respect to orientation. 

3 Read Circularly - Extract in a circular fashion around the region. 

4 Read Radially - Extract region in a radial direction. 

5 Read Horizontally and Vertically - Extract the region both horizontally and vertically (with respect to 
orientation). This is used in special cases. 
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Ambient Limits 

The minimum and maximum acceptable ambient gray level values. Any computed ambient found 
lower than or greater than these values will cause the inspection to fail. 

Nominal 

The expected gray level value of the region of interest. 
 

Shape Check 

Shape Check looks for a certain shape in the search region and will reject a part if it is out of tolerance. 
This feature helps ensure that the custom search region does not get fooled by an irregularly shaped 
container. 

 Note: This inspection is only available for Adaptive Regions. 

Series IV users: Shape Check is similar to the Shape Adapt region analysis in Series IV. 

The example below shows a normal part [item 1], and a part that failed the Shape Check [item 2]. 

 

 

1 Normal part 

2 Part failed Shape Check 

 

 To add a Shape Check inspection: 

1. Make sure an Adaptive Region (on page 176) of Interest has been added to the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Analysis > Shape Check. The analysis is added to the 
inspection tree. Re-name the inspection to something more meaningful to you. 

4. The Shape Check menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

 



Software User's Guide INTELLISPEC™ (Software Version 5.0.501)  Inspections  231 
© 2014 Pressco Technology Inc. Proprietary 
 

 

Shape Check menu 

Select between three different methodologies to determine proper shape (Area Check, Cross Section 
Check, and Vertex Deviation Check). 

 

Area Check 

Enable the Area Range portion of the inspection. This computes the area of the region in pixels to 
check for proper region size. 

Area Range 

Define the acceptable deviation (in pixels) from the normal area of the region. You may also adjust 
the values on the Retro-Spec graph. 

Nominal 

The expected area size. This number is populated when you press the Learn button. 

Learn Nominal Area 

Click the Learn button to automatically learn the area. 

Cross Section Check 

Enable the Cross Section portion of the inspection. This is only used when an Adaptive region is 
added to a Centerline registration. The system ensures that the learned distance between the two 
sets of points is within tolerance. 

Maximum Cross Section Deviation 

First use the Learn Cross Section button to determine the normal values. The distance is in pixels. 
Then adjust these values per your specifications. 

Learn Cross Section 

Click this button to determine the normal values for the Cross Section check. 

Vertex Deviation Check 

Enable the Vertex Deviation Check portion of the inspection. This is only used when an Adaptive 
region is added to a Centerline registration. This check looks at the deviation between consecutive 
edge points, and is performed on each side. An example where this feature might be used is when 
searching for choked necks on bottles. 
The vertex edge points are determined when you use Learn Cross Section. 

Maximum Deviation Side 1 and 2 

The system computes the distance (in pixels) between consecutive edge points. Adjust the sensitivity 
per your specifications. 
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Contrast 

The Contrast analysis looks for light and dark defects within your desired region. You can set the 
Contrast analysis to look for light defects only, dark defects only, or both light and dark defects. In the 
example image below, a Contrast analysis found a scratch. 

 

 To add a Contrast analysis: 

1. Make sure a Region of Interest (see "Regions of Interest (ROI)" on page 168) has been added to 
the inspection tree. We also recommend a Registration (see "Registrations" on page 191). 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Analysis > Contrast. The Contrast inspection is added to 
the inspection tree. Re-name it to something more meaningful to you. 

4. The Contrast menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 

Contrast menu 

 Note: The symbol [ ] indicates that this value is in pixels. Your system may show [mm] for 
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be calibrated 
using Review Camera Calibration (on page 120) or Image Analysis (on page 114) for the current 
sensor. 

 

Contrast Limits 

Set the sensitivity of the inspection. You can also move the red and yellow bars on the Retro-Spec 
graph by selecting the arrows to the left of the graph. 
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Size Filter 

Choose a defect size you want to catch. For example, you may want to pass very small defects but fail 
larger ones. For example, if Size Filter is set to 3 -- 80, any defects smaller than three pixels or larger 
than 80 pixels would be ignored. 

Acceptable Size 

This looks at the width of only those peaks that go above the contrast bar. It sums up the total size of 
those peaks and puts a limit on how large the total size of the defects can be. In the Part View graph 
shown below, there are peaks that go above the contrast bar. However, Acceptable Size is set to a 
number greater than the sum of those peaks, and this part passes. Acceptable Size allows you to pass 
parts with some anomalies, but reject parts with too many anomalies. 

 

Use Size Weighting 

This feature helps find defects such as wrinkles on metal parts. It is not normally used on bottles. 

 If an area of the part fails, it is weighted. If the area does not fail, it is not weighted. 

 The Acceptable Size parameter changes to provide adjustment for weighting. 

o The left value is Acceptable Size; see the description for that parameter. 

o The right value adjusts the weighted size limit. 

Sizing 

Choose between Total Width and Total Area for the inspection. The Number of Rings also affects 
Sizing. 

 Total Width, the default setting, adds the number of units (pixels, millimeters, etc.) of defective 
bars at or above the sensitivity level within an inspection region or segment. 

 Total Area adds all the defect pixels. Suppose your part had two small defects along the same 
radial line. Normally, the width of the predominant defect would be counted. But with Area 
enabled, all defect pixels are counted. This results in a larger defect area counted. 

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. 

 Note: some inspections do not use all of these options 

The illustration below shows how the information is read by each method. Note that these shapes 
are examples only - your region does not have to match the shape. 

 

 

1 Read Horizontally - Extract the region horizontally - 90 degrees with respect to orientation. 
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2 Read Vertically - Extract the region vertically - parallel with respect to orientation. 

3 Read Circularly - Extract in a circular fashion around the region. 

4 Read Radially - Extract region in a radial direction. 

5 Read Horizontally and Vertically - Extract the region both horizontally and vertically (with respect to 
orientation). This is used in special cases. 

Advanced Settings 

Sample Filter 

Choose how to filter the samples. The default selection is Integration. Leave that selected for most 
applications. Concavity is used for detecting and ignoring draw marks in two-piece beverage cans. 

Fuzzy Edge Removal 

This is for parts that have normal anomalies at the edges that are fuzzy, but the feature edges are 
sharp and clear on the image. The default is disabled. The higher the Filter Level, the stronger the 
fuzzy edge removal. Be aware that this filtering increases inspection time. 

Defect Type 

Search for dark, light, or both types of defects. 

Optimize settings 

Described below. 

Detection Mode 

Search for either a defect (default setting) or for a feature (for example, a feature that should be 
there and its absence represents a defect). 

Segment Settings 

Number of Rings 

The number of concentric rings the region is divided into (for Read Circularly or Read Radially Region 
Extractions only). More rings generally means more sensitive. 

  

 

a Region with one ring 

b Region divided into three rings 

 
The example below shows a Part View graph of the same part's region with one ring [item 1], and 
that same region divided into several rings [item 2]. Notice that the width of the peaks do not 
change, but the amplitude of the peaks change, because the system is focusing on a smaller region. 
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1 Part with region with one ring 

2 Same part with region divided into several rings 

Number of Segments 

The number of angular segments the region is divided into. 

Ring Height 

Ring Height is similar to Number of Rings, but applies to a polygon region. This number refers to a 
number of pixels wide or high, depending whether you are using Read Horizontally or Read Vertically 
for Region Extraction. Ring Height can improve inspection sensitivity to defects that do not span the 
width of the inspection region. The default value for Ring Height is one, which is the most sensitive 
value. In the example below, suppose Ring Height in [item 1] is one pixel, and Ring Height in [item 2] 
is five pixels. In this case, the part using Ring Height of one [item 1] would be more likely to fail than 
with a Ring Height of five [item 2]. 

 

 

1 Smaller Ring Height - more sensitive 

2 Larger Ring Height - less sensitive 

Using the Optimize feature 

The Optimize feature automatically sets the optimum settings for many inspection parameters. It is 
processor-intensive and must be done off-line. For this to work correctly, ensure that you have moved all 
acceptable images to the left side of the Retro-Spec graph (Set A), and the defect images to the right side 
of the graph (Set B). Optimize is available under the Advanced Settings. 

 To use the Optimize feature: 

1. Make sure the Retro-Spec graph is in Population view: right-click on the graph to select Population 
View. 

2. Load a set of good parts into Data Set A using the steps below. 
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 To load Data Set A: 

1. Look at the Retro-Spec Population View Graph (on page 162). 

2. Click the left arrow  button on the Retro-Spec graph to view the Select Data Sets menu. 

 

3. Click the Image Files button for Set A. 

4. Click the disk icon  to browse to the folder where the images were saved. The Select File 
menu is displayed. 

 

5. Browse to and select the folder that contains the images you want to load. 

6. Click the OK button  in the Select Location and Select Data Sets menus to load all the bitmap 
images that were previously saved in the selected folder. 

Next load a set of images of bad parts into Data Set B. These parts should have defects in the current 
inspection's region of interest. 
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 To load images of bad parts: 

1. Click the right arrow button  to view the Select Data Sets menu. 

2. From the Select Data Sets menu, select Latest Defects, or choose Image Files for Set B. If you 
choose Image Files, select images similarly as you did for Set A, except this time choose defect 
images. 

3. Exit the Select Data Sets menu. 

If there are any parts that do not belong in either sample set, try moving or deleting those samples [refer 
to the illustration below]. 

 To move an image: 

o Click on the image lock icon [item 1] to allow images to be moved. 

o Then click and hold the desired image's peak [item 2] - it displays a small image - and drag it 
to the other side of the center. 

 To delete an image: 

o Click on the image lock [item 1] to allow images to be moved. 

o Then click on the desired image's peak [item 2] - it displays a small image - and drag it to the 
trash can icon [item 3].  

o OR: Click on the desired image's peak [item 2] - and then click the trash can icon [item 3].  

o The system displays a "Deleted!" message above the trash can icon when it is deleted. 

 

 To finish setting up the Optimize feature: 

1. In the Contrast menu, choose the Defect Type: light, dark, or both. 

2. Adjust the Acceptable Size parameter to catch the size of defect you want to detect. 

3. Click the Optimize button. The system will analyze the part sets and determine the best settings to 
pass the good parts while failing the bad parts. Wait till the optimization process is complete - this 
may take several seconds. 
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4. Look at the Retro-Spec graph to determine whether the good parts are still passing and the bad 
parts are failing. Most likely, you will see a significant separation of contrast between good and 
bad parts. 

5. Test the inspection by loading (see "Loading Saved Images" on page 139) more images. You can 
make slight adjustments in the Contrast menu if necessary. 

 
 

Measurement 

This analysis measures an inner/outer diameter and/or width of a feature. It can be used in other types 
of shapes, but is most often used to measure circular features. It can find non-round (oval) parts, as well 
as incorrect widths of circular features. 

Series IV users: this inspection is similar to Circle Width Dimension or Retro-Spec Measurement inspection 

 Before you set up the Measurement analysis: 

1. Decide which feature you want to measure: inner diameter, outer diameter, width, or all three. 

2. With calipers or other measuring tools, make actual measurements on a good part. Measure at 
least one of the features you want to measure (inner diameter, outer diameter, and/ or width). 
Make a note of these measurements to input into the analysis during setup. 

 Note: if you choose Inspection Calibration [most common] during setup, then you only need one 
measurement. If you choose Feature Calibration, you will need the actual values of all the 
features you want to measure. 

3. Place a Region of Interest (see "Regions of Interest (ROI)" on page 168) over the area you want to 
measure, allowing space to find edges. 

 Tip: If you want to measure the width of a circular feature, make the region approximately as 
wide as the feature on both sides. For example, if the feature is 10 pixels wide, place the region 
10 pixels outside of the feature, as well as 10 pixels inside of the feature as in the example shown 
below. 

 

  

1 feature 

2 region 

 

 To add a Measurement analysis: 

1. Make sure a Region of Interest (see "Regions of Interest (ROI)" on page 168) has been added to 
the inspection tree to surround the areas you want to measure. We also recommend a 
Registration (see "Registrations" on page 191) before the measurement region of interest. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Analysis > Measurement. The Measurement analysis is 
added to the inspection tree. Re-name it to something more meaningful to you. 
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4. The Measurement menus are displayed and the region is shown on the image. (The menus are 
described below) Adjust the placement of the region and parameters as necessary. 

 To set up a basic Measurement analysis: 

1. In the Measurement menu, pick a Feature Type [see description below]. 

2. Choose whether to inspect for inner diameter, outer diameter, width, or all three. Under each of 
the corresponding menus, enable those measurements. 

 Note: for most applications, you can disable Range and Continuity. Leave these enabled only if 
required by your plant. 

3. Go to the Contrast menu and adjust the Contrast Limits until you find an edge. 

4. Go to the Measurement menu and set most of the parameters [described below]. 

5. Click the Learn button. This sets the inspection limits for the Inner, Outer, and Width 
measurements. 

6. Find the actual measurements you made on the part prior to setting up the inspection. Go to the 
corresponding menus (example, inner diameter = Inner menu). Enter these values in the 
Measured Distance field for each measurement (depending on Calibration Provider setting in the 
Calibration menu). 

 If you use Inspection Calibration [most common] for Calibration Provider, then you only need to 
enter one value in one of the Inner/ Outer/ or Width menus. 

 If you use Feature Calibration for Calibration Provider, then you must enter values for all 
enabled measurements. 

 If you use Sensor Calibration for Calibration Provider and the system has already been 
calibrated, then skip this step. 

7. Change the Units field to match your actual measurement (example, millimeters). 

8. Go to the Calibration menu and use the Calibrate on Part [recommended setting] or Calibrate on 
Set features to set the scale factor for the analysis. 

9. Set other parameters as required by your plant. 

 

Measurement menu 

This menu provides settings that will be used in all (Inner, Outer, or Width) measurements. It also has a 
Learn feature that automatically sets measurement reject criteria for you. 

 

Learn Settings 

Click to learn the measurements of the part. This sets the diameter, min/max values, and average 
values for you and updates that information in the Inner/ Outer/ Width menus. 

 Note: if you make significant changes to the parameters in this menu or the other Measurement 
menus, click the Learn button again to update the information. 
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Fuzzy Edge Removal 

This is for parts that have normal anomalies at the edges that are fuzzy, but the feature edges are 
sharp and clear on the image. The default is disabled. The higher the Filter Level, the stronger the 
fuzzy edge removal. Be aware that this filtering increases inspection time. 

Feature Type 

Determine the type of feature you want the inspection to search for. Use the type that best finds the 
region on your part. 

 

 

1 Light Feature 

2 Dark Feature 

3 Borders - both dark 

4 Borders - both light 

5 Borders - dark inner, light outer 

6 Borders - light inner, dark outer 

Feature Selection Logic 

Set this according to your part type and measurement type. Choose the type of edges you want to 
find for a type of feature.  

 Tip: for most applications, leave Border Sharpness, Balance, Balance Side, and Allowed Gap Size at 
their default settings. 

Border Sharpness 

For most cases, leave this set at 1 - 9. This allows you to choose whether to find sharp or gradual 
edges. At the default setting, the system finds both types of edges. If you only want to find sharp 
edges, set the values closer to one. If you only want to find gradual edges, set the values closer to 
nine. 
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Balance 

For most cases, leave this disabled. This parameter applies mostly to Feature Type = Feature. If the 
feature in your image is not the same gray shade across the feature, you could adjust Balance to 
compensate for the change in gray shade. Normally, the histogram across the feature is flat, as in 
illustration [a]. In the example below, the histogram for the feature of part [b] shows that the gray 
scale of the inner diameter is about 50% of the gray scale of the outer diameter. In this example, we 
would use a Balance of 0.5, and we would choose Outer for Balance Side. This allows the system to 
treat part [b] as though it has similar gray shades on both sides. 

 

Balance Side 

When using Balance, choose which side's contrast needs to be reduced. 

Sample Count 

Choose how to divide up the circle. For example, if Sample Count is 36, then the system places a 
search vector every 10° (360° divided by 36 equals 10°). 

Allowed Gap Size 

This is used in special cases where you want to ignore a number of segments. Set this to the number 
of search vectors you want to ignore. For example, if Sample Count is 36, and the gap is 
approximately 40°, then the Allowed Gap Size would be four. 

 

  

a Allowed gap size 
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Inner/Outer/Width menus 

There are three menus to provide three different measurements. The parameters in each of the menus 
are the same. 

 

Inner diameter/outer diameter/width 

Check the box under the appropriate menu to perform this measurement. 

 Tip: When you click the Learn button in the Measurement menu, the values for Diameter/Width, 
Min/Max, and Average are set for you. Normally, you do not need to adjust these further. 

Min/Max 

Set the minimum and maximum allowable measurement. 

Average 

Set the average measurement for the part. 

 Tip: for most applications, Range and Continuity are disabled. 

Range 

Set the acceptable measurement range for the part. This can be used to check for ovality. The system 
subtracts the minimum value found from the maximum value found. 

Continuity 

This feature checks for local changes in edge position between vectors. This allows detection of 
defects where the part may be crushed or bent. 

 

Continuity - Size 

Choose the size range of the defects you want to catch, specified in segments. 

Units 

Choose your preference in the reporting of the measurements. Choose from millimeters, inches, 
pixels, and custom. Custom allows any calibration factor to be used. 
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Measured Distance 

Measure your part with calipers or another tool, then enter the actual value for Measured Distance. 
This is used to help calibrate the measurement. 
 

Calibration menu 

This menu uses your actual measurements (that you input into the Measured Distance parameter) to 
convert the number of pixels into your preferred unit of measurement. This ensures that the system is 
making accurate measurements. 

 

Calibration Provider 

Specify the source for the display of the calibrated values. 
Sensor Calibration -- Calibration can be done through Image Analysis (on page 114), or through an 
inspection. When Save Calibration is used within an inspection, that information can be used in any 
other inspection (that uses Calibration Provider) for that sensor. 
Inspection Calibration -- [most common] use the value from one of your actual measurements to 
calibrate the Measurement analysis. Additional Dimension and Units parameters are available to 
choose one of your measurements and preferred unit of measurement. Additionally, Conversion 
Factor can be adjusted manually to get the best match between pixels and physical length. 
Feature Calibration -- use separate calibration settings for each of the enabled measurements (inner 
diameter, outer diameter, or width). You must enter an actual measured value into each of the 
appropriate menus. 

Dimension 

[Available when Calibration Provider = Inspection Calibration] Specify which dimension to use to 
calibrate the inspection. 

Units 

Choose your preference in the reporting of the measurements. Choose from millimeters, inches, 
pixels, and custom. Custom allows any calibration factor to be used. 

Calibrate on Part 

Use the current image to calibrate the Measurement analysis. Use a known good part. 

Calibrate on Set A 

Use the current set of images in Set A to calibrate the Measurement analysis. The system takes the 
average value of the set and uses that number to calibrate the analysis. 

Save Calibration 

Click the Save Calibration button to save the calibration scale and units to the sensor for use by other 
inspections. 

Conversion Factor 

This indicates the pixel size and is used to convert one pixel into the units selected. The initial 
conversion will be controlled by the Learn Calibration results. You can adjust this value manually if 
necessary. 
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Contrast menu 

This menu allows you to adjust for sensitivity and defect size for the inspection. 

 

Contrast Limits 

Set the sensitivity of the inspection. You can also move the red and yellow bars on the Retro-Spec 
graph by selecting the arrows to the left of the graph. 

Size Filter 

Choose a feature size you want to measure. For example, you may want to ignore very small features 
but find larger ones. For example, if Size Filter is set to 3 -- 80, any feature smaller than three pixels 
or larger than 80 pixels would be ignored. 

Results window 

The results displayed for a measurement inspection are different than other inspections. In addition to 
the parameters, a measurements table is displayed. 

 

You can perform several functions through this results window, including: 

 Go directly to the parameters to adjust a particular measurement. If you click the [6.01] in the 
example, the Width menu is displayed and the Min/ Max parameter is highlighted for you. 

 View the corresponding Retro-Spec graph. If you click [6.01] under Width in the example, the Width 
Min/ Max graph is displayed at the top of the screen. 

More options are available when you right-click over this window to see the Measurement Results 
menu. This menu allows you to enable or disable an entire measurement set such as Inner, Outer, or 
Width. If you click "Enable/ Disable Measure," then the parameter you right-clicked to see this menu 
becomes enabled or disabled. 
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Fill Height 

Fill Height inspection is used for determining the fill level of containers, mainly to find containers with 
high fill or low fill. The Fill Height inspection compares the fill level of the liquid to a standard reference 
point, which is typically the neck ring of a container. 

 Notes: This inspection requires a Measure ROI (on page 174) Region using two regions. 

The example below shows a bottle with a normal fill height [item 1], and a bottle with a fill height that is 
too low [item 2]. 

 

 

1 Normal fill height 

2 Fill height too low 

 To add a Fill Height inspection: 

1. Make sure a Measure ROI (on page 174) Region of Interest has been added to the inspection tree. 
Suggested settings are as follows: 

a) In the Measure ROI menu, set Region Count to Two Regions. 

b) Place Region One over a distinct reference point, such as the neck ring. 

c) Place Region Two over a section of the bottle where you expect to see the liquid level. An 
example is shown below. 

d) Save and close the Measure ROI region menu. 

 

2. Highlight the region name in the inspection tree. 

3. Right-click on the name of the region you just added. 

4. From the Inspection menu, select Add > Analysis > Fill Height. The analysis is added to the 
inspection tree. Re-name the inspection to something more meaningful to you. 

5. The Fill Height menus are displayed and the regions are shown on the image. (The menus are 
described below) Adjust the placement of the regions and parameters as necessary. 
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Fill Height menu 

 Note: The symbol [ ] indicates that this value is in pixels. Your system may show [mm] for 
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be calibrated 
using Review Camera Calibration (on page 120) or Image Analysis (on page 114) for the current 
sensor. 

 

Fill Mode 

Choose whether to measure fill level at the Top Only or at the Top and Bottom 
Top Only is generally used for water or other non-carbonated beverages. 
Top and Bottom is used mainly for carbonated beverages, or beverages that foam when the liquid 
sloshes around in the container as it moves in front of the inspection module. The inspection can 
measure the distance from the reference point to the top of the foam, and also from the reference 
point to the bottom of the foam. 

Part Orientation 

Choose the orientation of your part. In many cases, the part image is sideways to optimize the 
inspection area on the screen. 

Reference Region 

Choose a region from the Measure ROI region of interest to set as the reference point (in our setup 
example, we picked Region 1). A typical setup uses the neck ring of a bottle as the reference region. 
The direction of the search is determined in the region setup (search towards the diamond). You can 
change search direction by right-clicking over the image and using the choices from the Image 
Options (on page 141) menu. 

 

Correct Fill Position 

Enables edge correction, where the system uses a "moving average" technique to eliminate outlying 
edges (example: edges caused by water spots or bubbles in the liquid). 

Fill Correction Deviation 

[Available when Correct Fill Position is enabled] This is used to correct stray points that fall too far 
away from the moving average edge position. The value is in pixels. Make sure you use a high enough 
value, or the inspection will not properly detect sloshing liquid. A common value to use is 25 or 
higher. 
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Fill Height Limits 

Define the valid fill height range per your specifications. This value is measured with respect to your 
reference point (the neck ring, in our example). You can use the bars on the Retro-Spec graph to 
adjust the limits. 

Nominal 

The ideal fill height value. 

Show Fill Height 

Show the fill height measurement on the image. 

Reference menu 

 

Set the parameters to find the edges in the reference region. 

Vector Spacing 

The distance between search vectors. 

Max Missed Edges 

The number of search vectors that are allowed to fail without causing the inspection to fail. 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Edge Thickness 

The number of consecutive times that the gradient must be met to define an edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Show Edges 

Show the found edges on the image. 

Show Vectors 

Show the search lines on the image. 

Show Search Direction 

Show the search direction of the vectors with an arrow. 
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Fill Top or Fill Bottom menu 

 

Set the parameters to find the edges for the fill level top (Fill Top menu) or the fill level bottom (Fill 
Bottom menu). 

Vector Spacing 

The distance between search vectors. 

Search Direction 

Change the search to the opposite direction. 

Max Missed Edges 

The number of search vectors that are allowed to fail without causing the inspection to fail. 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Edge Thickness 

The number of consecutive times that the gradient must be met to define an edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Show Edges 

Show the found edges on the image. 

Show Vectors 

Show the search lines on the image. 

Show Search Direction 

Show the search direction of the vectors with an arrow. 
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Empty/ Full menu 

 

Use this check to determine whether the bottle is empty or full. The system performs an ambient check 
in the Fill Height region to determine whether the bottle is empty or full. 

Ambient Technique 

This method determines the region’s ambient. Choose the method through the drop-down menu. 

 Max Amplitude looks for the maximum gray level amplitude — the gray level with the most pixel 
counts — within the histogram of the search area. 

 

1 Gray level 

2 Pixels in the histogram of the image 

 

Peak Percentile locates the gray level value that exceeds the threshold. In the example below, the 
system would use the gray level to the right of the line marking 80%. 

 Ambient Threshold defines what percentage of the search area to use. 

 

 

1 Gray level - choose a percentage 

2 Pixels in the histogram of the image 

 

 Density computes the average of all the pixel gray levels — total gray level divided by pixels. 

Ambient Analysis Mode 

Specify the reject criteria.  
Min & Max - The minimum and maximum acceptable ambient gray level values. Any computed 
ambient found lower than or greater than these values will cause the inspection to fail. 
Min Only - The minimum acceptable ambient gray level value. Any computed ambient found lower 
than this value will cause the inspection to fail. 
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Max Only - The maximum acceptable ambient gray level value. Any computed ambient found greater 
than this value will cause the inspection to fail. 

Ambient Limits 

The minimum and maximum acceptable ambient gray level values. Any computed ambient found 
lower than or greater than these values will cause the inspection to fail. 

Nominal 

The expected gray level value of the region of interest. 

Calibration menu 

 

Set the parameters to convert pixel measurement into your preferred measurement unit. 

Calibration Mode 

The system will convert the pixel dimensions into your preferred unit of measurement. 
Sensor Calibration -- Use the calibration previously set up for the sensor through Image Analysis (on 
page 114) or through another inspection. 
Inspection Calibration -- Use the calibration from this inspection only. 

Units 

Choose your preference in the reporting of the measurements. Choose from millimeters, inches, 
pixels, and custom. Custom allows any calibration factor to be used. 

Conversion Factor 

This indicates the pixel size and is used to convert one pixel into the units selected. The initial 
conversion will be controlled by the Learn Calibration results. You can adjust this value manually if 
necessary. 

Learn Calibration 

Click the Learn Calibration button to automatically determine the scale factor, which converts the 
value to the desired units. 

Save Calibration 

Click the Save Calibration button to save the calibration scale and units to the sensor for use by other 
inspections. 

Measured Distance 

Measure your part with calipers or another tool, then enter the actual value for Measured Distance. 
This is used to help calibrate the measurement. 

Measured Fill Level 

Measure your part's normal fill level (with respect to the bottom of the bottle) with calipers or 
another tool, then enter the actual value for Measured Fill Level. This is used to help calibrate the 
measurement. 
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Measure Extract 

This analysis will use edge search criteria to find the minimum, maximum, and average edge location in a 
Measurement ROI. You then add a Dimension - Distance (on page 262) inspection to do the 
measurement of the found feature position. 

 

 To add a Measure Extract analysis: 

1. Make sure a Measure ROI (on page 174) Region of Interest has been added to the inspection tree. 
Make sure the region is placed over the feature(s) you want to measure. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Analysis > Measure Extract. The Measure Extract analysis 
is added to the inspection tree. Re-name it to something more meaningful to you. 

4. The Measure Extract menu is displayed and the region is shown on the image. (The menu is 
described below) Adjust the placement of the region and parameters as necessary. 

Measure Extract menu 

 

Vector Spacing 

The distance between search vectors. 

Max Missed Edges 

The number of search vectors that are allowed to fail without causing the inspection to fail. 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 

Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 
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Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Enhance Vectors 

Computes an average pixel value from a neighborhood of 3x3 pixels around each pixel of the vector. 

Show Edges 

Show the found edges on the image. 

Show Vectors 

Show the search lines on the image. 

Show Search Direction 

Show the search direction of the vectors with an arrow. 

Show Measurement Positions 

Show the location of the measurement positions (minimum, maximum, and average). 
 

Distribution 

The Distribution inspection looks at color printing on parts, detecting 'tramp cans' or gross decoration 
errors on parts. If you are familiar with the Pressco Extractor product, the Distribution inspection will 
seem familiar to you. 

This inspection can also inspect for proper color of a product. For example, if you are inspecting blue 
preforms, it can detect when a preform is not the proper color blue, or if it is an incorrect color. 

The Distribution inspection can inspect for gross decorator defects in gray scale images or color images. 
Use Gray Scale mode if your system does not have a color camera, or you want to focus on a specific 
range of gray shades. This can help detect scratches or other defects where the color is missing from an 
area on the part. 

 

The inspection uses: 

 A learned data set to compare to newly inspected parts 

 Color histograms (see "Distribution Histogram Types" on page 256) that consist of a number of 
color bins. Each color in the region of interest is analyzed. The total number of pixels containing a 
certain color (or gray scale) are counted and placed in each bin. 

 To add a Distribution analysis: 

1. Make sure a Region of Interest has been added to the inspection tree. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Analysis > Distribution. The analysis is added to the 
inspection tree. Re-name the inspection to something more meaningful to you. 

4. The Distribution menu is displayed and the region is shown on the image. (The menu is described 
below) Adjust the placement of the region and parameters as necessary. 
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Load a set of good images into Data Set A 

You can use images of the last parts run (up to 100 parts) and learn using this data. However, you must 
make sure that all the images in the data set are from good parts. You can look at the Population View 
graph and delete the images you do not want. Alternately, you can load a set of known good images that 
you have saved previously using the steps below. 

 To load Data Set A: 

1. Look at the Retro-Spec Population View Graph (on page 162). 

2. Click the left arrow  button on the Retro-Spec graph to view the Select Data Sets menu. 

 

3. Click the Image Files button for Set A. 

4. Click the disk icon  to browse to the folder where the images were saved. The Select File 
menu is displayed. 
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5. Browse to and select the folder that contains the images you want to load. 

6. Click the OK button  in the Select Location and Select Data Sets menus to load all the bitmap 
images that were previously saved in the selected folder. 

 

Set up the Distribution inspection 

 To set up a Distribution inspection: 

1. Make sure a good set of images is loaded into Data Set A (see above). 

 Note: descriptions of the parameters mentioned are described under the Distribution menu 
section below. 

2. Choose a different Histogram Type if appropriate for your part. 

3. Use the Learn function. 

4. Set the Attenuation if desired. 

5. Use the Learn More function if desired. 

 Note: To use the Learn More function, you will need a set of part images in Data Set A. The images 
can be the last 100 parts you have inspected, or images from a file. To load more images, use the 
instructions to "Load a set of good images into Data Set A" listed above. 

Distribution menu 

 

Histogram Type 

Select one of the Distribution Histogram Types (on page 256). This is not used if Color Mode = Gray 
Scale. 

Gray Scale 

Specify the range of gray scales for the distribution inspection. This is not used if Color Mode = RGB. 

Bin Count 

This is only used when Color Mode = Gray Scale. Set the number of bins (gray shades) the histogram 
is divided into. Note that some constraints may apply, and this number may not exactly match the 
number of bins. 

Deviation Limits 

Set the tolerance level for the colors or gray scale values. Positive values represent too much of some 
color. Negative values represent too little of some color. The values correspond to the largest 
deviations of some color from its expected amount, which is determined when learning the data set. 
Values of zero represent no deviation of color. 

Attenuation 

Set the minimum number of pixels of a color or gray shade that must be seen before they are 
counted. For example, if Attenuation is set at 100, there must be at least 100 pixels of that color or 
gray shade, or it will be ignored. Increasing attenuation reduces sensitivity to small changes. It 
ensures that only significant color changes cause the product to fail. 
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Learn 

The inspection needs to learn the colors or gray shades of your product. To learn, the inspection 
looks at the samples in Data Set A. Therefore, you will need a set of images in Data Set A. The data 
set should contain a good sample of your production line. Ideally, you should store the images of 
about 100 good parts in Data Set A. The larger the sample population, the better the inspection 
results. 

 Note: if there are any defective parts in Data Set A, they will be included in the learned data. 
Therefore, you might want to look through the data set using the Comparison View graph, and 
move defective parts to Data Set B. 

 Note: Learn overwrites existing data. It can be used if you are testing the inspection on a new 
part, or want to clear the data from a previous learn. 

Learn More 

[Only available after you use Learn] - After you have used the Learn function, you can add to the 
learned data. Use this to learn new parts where the colors might be slightly different than your 
original data set, but are still good parts. This builds a wider tolerance of colors for your parts. This 
feature can be used at any time - for example: immediately after the initial learn, or several weeks 
later. 

  

Region Extraction 

Choose how the Intellispec should read the information from the region. This usually depends on the 
shape of your region. 

 Note: some inspections do not use all of these options 

The illustration below shows how the information is read by each method. Note that these shapes 
are examples only - your region does not have to match the shape. 

 

 

1 Read Horizontally - Extract the region horizontally - 90 degrees with respect to orientation. 

2 Read Vertically - Extract the region vertically - parallel with respect to orientation. 

3 Read Circularly - Extract in a circular fashion around the region. 

4 Read Radially - Extract region in a radial direction. 

5 Read Horizontally and Vertically - Extract the region both horizontally and vertically (with respect to 
orientation). This is used in special cases. 

Color Mode 

Choose whether to extract the data in Gray Scale or RGB mode. Note that your system must have a 
color camera to use RGB mode. 

Information about the graphs in Distribution inspection 

The Part View graph view shows the distribution of the color of pixels in the inspection's region of 
interest. Each bar on the graph represents a number of pixels in each color bin. The color bins are shown 
in the color band at the bottom of the graph. For information about the color bins, refer to Distribution 
Histogram Types (on page 256). 
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The example below shows a Part View graph with a good part (top) and a defective part (bottom). The 
defective part had too many pixels of several different colors in this example - possibly a 'tramp' part. 

 

 
 

Distribution Histogram Types 

In the Distribution (on page 252) inspection, there are several color histograms available. Most often, 
you will be using the New Retro-Spec Color Histogram. You will notice the difference between the 
histograms in the color bar directly below the Retro-Spec Part View Graph (on page 165). 

  

 

1 New Retro-Spec Color Histogram 

2 Special Color Histogram (Chartreuse, Green, Spring Green shown) 

3 Classic Extractor Histogram 

4 White Level Histogram - not shown 

 

 To see a different histogram: 

1. Select a different from the Histogram Type drop-down menu. 

2. Switch to Population View on the graph by right-clicking the Retro-Spec graph, then selecting 
Population View from the Retro-Spec Options menu. 

3. Switch to Part view by right-clicking on the Retro-Spec graph, then selecting Part View from the 
Retro-Spec Options menu. The new histogram is displayed below the graph. 
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New Retro-Spec Color Histogram 

In this histogram, there are 16 bins of gray scale, 48 bins of dark or pastel colors, and 192 bins of very 
bright colors. The 48 bins of dark or pastel colors have a wider tolerance, and therefore you may see 
most of the colors of your part in those bins. This histogram also has some overlapping of colors - that is, 
pixels may be mapped to more than one color bin. This ensures that slight variations of color do not 
cause the product to fail. 

Special Color Histograms 

In special cases, you may use other color histograms. The color bars are viewable under the Part View 
graph. 

If you are trying to detect off-color parts, such as preforms, use one of the special color histograms. For 
example, if your preforms are supposed to be green, use the histogram that most closely matches the 
correct color. This provides a large range of green colors to be detected. When a different color part 
(blue, for example) goes through your product stream, that part will be easily detected because it will 
not fall into the learned green color range. 

Classic Extractor Histogram 

This histogram is the same as the original Pressco Extractor product. It has 16 gray scale bins and 240 
color bins. This is different from the New Retro-Spec Color Histogram in that it does not have the middle 
section of 48 bins of dark or pastel color. 

This histogram is only used when an approximate comparison between the original Extractor product 
and the Retro-Spec Distribution is required. 

White Level Histogram 

(As of this printing, the white level histogram is not displayed under the Retro-Spec graph) 

This histogram is used for pastel colors, or if you want to differentiate between shades of the same 
color. For example, you might need to detect when a yellow color is too light compared to the normal 
yellow shade. 

 

Label Skew Extract 

Label Skew Extract is similar to Measure Extract (on page 251). Label Skew Extract is specialized to locate 
the edge of the label and can be set up for either one or two search regions. It finds the edges of a label 
and draws a "best fit" line using those edges. The inspection's main function is to export this data to a 
Dimension > Angle inspection. Label Skew Extract inspection can reject a part if the label is not 
consistent enough, such as a flagged label. 

Label Skew requires a Measure ROI (on page 174) to set up the region(s). The actual skew inspection is 
handled by the Angle (on page 266) dimension.  

 

1 Normal label 

2 Skewed label 
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 To add a Label Skew Extract inspection: 

1. Make sure a Measure ROI (on page 174) Region of Interest has been added to the inspection tree. 
Set up the Measure ROI for one or two regions. 

2. Right-click on the item you just added. 

3. From the Inspection menu, select Add > Analysis > Label Skew Extract. The analysis is added to the 
inspection tree. Re-name the inspection to something more meaningful to you. 

4. The Label Extract and Region menus are displayed and the region is shown on the image. (The 
menus are described below) Adjust the placement of the region and parameters as necessary. 

5. After setting up the Label Skew extract, add an Angle (on page 266) dimension. 

 

Label Skew Extract menu 

 

Check Consistency 

Enable the consistency check (the label skew check). 

Label Consistency 

Set up the limits for the position of the found edges. This number indicates the straightness of a line. 
A lower number means the points do not deviate much from a straight line and is therefore more 
consistent. 

Region 1 menu 

Set the parameters so that desired label edges are found. Note that search direction and region position 
can be set by using the Image Options (on page 141) menu. Right-click over the image to see the Image 
Options menu. 

 

Vector Spacing 

The distance between search vectors. 

Max Missed Edges 

The number of search vectors that are allowed to fail without causing the inspection to fail. 

Edge Polarity 

Choose the type of edge to search for – Light to Dark, Dark to Light, or Either. For example, if the 
feature you want to find is very bright, choose Dark to Light. 
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Edge Gradient 

The minimum and maximum difference in gray shades, between two pixels, to be considered an 
edge. 

Edge Size 

Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size, the 
stronger the edge will need to be. This parameter acts like a filter that looks at a length in pixels 
before and after the edge. 

Edge Delta 

The distance between pixels being compared when seeking an edge. A higher Delta value is more 
sensitive because it finds more edges. 

Edge Thickness 

The number of consecutive times that the gradient must be met to define an edge. 

Use Subpixel 

Finds edges based on their subpixel location, rather than rounding off to the nearest pixel. This gives 
greater centering accuracy. 

Enhance Vectors 

Computes an average pixel value from a neighborhood of 3x3 pixels around each pixel of the vector. 

Show Vectors 

Show the search lines on the image. 

Show Search Direction 

Show the search direction of the vectors with an arrow. 
 

Feature Detect 

 Feature Detect analysis can be used to detect a range of specific gray shades to determine defects. For 
example, in a fill height/ cap placement inspection, it can be used on the cap to determine whether a 
tamper band is broken. 

 Note: Feature Detect analysis requires either a Ring Region (on page 169) or Polygon Region (on 
page 170) of interest. 

Series IV users: Feature detect is similar to Zones Inspection. 

 To add a Feature Detect analysis: 

1. Make sure a Ring Region (on page 169) or Polygon Region (on page 170) of interest is already 
added to the inspection tree. Adjust the region to examine the area of interest where you will 
place the Feature Detect inspection. 

2. Right-click in the inspection tree to see the Inspection menu. 

3. From the Inspection menu, select Add > Analysis > Feature Detect. The analysis is added to the 
inspection tree. Re-name it to something more meaningful to you. 

4. The Feature Detect menus are displayed and the region is shown on the image. (The menus are 
described below) Adjust the placement of the region and parameters as necessary. 
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Feature Detect menu 

Use the Feature Detect menu to specify a range of gray shades to find. 

 

Feature Method 

Choose a method to determine the ambient value in a search region. 
Use All Data - Analyzes all the pixels in the search region, and counts the total number of pixels that 
meet the criteria set in Feature Gray Scale. 
Use Qualified Features - Analyzes all the pixels in the search region, but only counts pixels if: 

 The pixels meet the Feature Gray Scale criteria, AND 

 The pixels meet the Feature Size criteria. 

Feature Gray Scale 

Set the range of gray shades of the feature you want to locate. 

Show Features 

Highlight the found features on the image. 

Check Feature Area 

Check the area of the feature to see that it is within the specified tolerance. 

Allowed Area 

[only available if Check Feature Area is enabled] The tolerance (in pixel area) of the feature you want 
to locate. 

Nominal 

The expected area size. This number is populated when you press the Learn button. 

Learn Nominal Area 

Click the Learn button to automatically learn the area. 

Check Feature Count 

Check to see that the correct number of features is found. 

The following parameters are available when Feature Method = Qualified Features. 

Feature Size 

Set the allowable size of the feature you want to locate. 

Show Feature Centers 

Show the center points of the found features, marked with an 'X.' 
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Feature Detect - example FHCP 3X 

The example below shows where a Feature Detect inspection could be used within a Fill Height/ Cap 
Placement inspection. It could be used to detect a defective tamper band. This tamper band did not 
meet tolerance criteria for gray scale range, so it failed inspection. 
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Dimensions 
The dimension inspection type is special in that it connects the results of two other inspections to do the 
analysis. For example, a distance inspection can connect two registrations to measure the distance 
between centers of two features. 

The Dimension inspections include: 

 Distance (on page 262) 

 Angle (on page 266) 

 Note: Your system (and this book) may show only those items that apply to your application. 
 

Distance 

The Distance inspection computes the distance between two points. This is useful if you want to find 
features that are out of tolerance or out of place on a part. Distance inspection does NOT use a region. It 
obtains information produced in other inspections. The other inspections can include a Registration (it 
uses the found registration point), or a Measure Extract inspection. 

Series IV users: this inspection produces the same results of Dimension inspection, but in Series V the 
measurement points are found by other inspections. 

Examples of where Distance inspection might be used is for detecting swung gates or high caps on 
bottles, turned tabs on converted or EZO ends, or computing finish dimensions. The example below 
shows a gate position computed with respect to the center of the base. 

 

 

1 Full image with swung gate 

2 Enlarged image of good part 

3 Enlarged image of bad part showing incorrect position of gate 

 

Distance can be computed with respect to the center of the screen, if desired. 

 

 To add a Distance measurement: 

1. Make sure at least one Registration (see "Registrations" on page 191) or Measure Extract (on 
page 251) inspection is placed in the inspection tree. To find the distance between two points, 
place the registrations or Measure Extract inspections for each point. 

2. Right-click in the inspection tree to see the Inspection menu. 

3. From the Inspection menu, select Add > Dimension > Distance. The dimension is added to the 
inspection tree. Re-name it to something more meaningful to you. 
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4. The Distance menus are displayed and the region is shown on the image. (The menus are 
described below) Adjust the parameters as necessary. 

 To set up a basic Distance measurement: 

1. Choose a Distance Component from the Distance tab. 

2. Go to the Extraction 1 tab and click the Select Inspection button. 

3. Select the first reference point (in the inspection tree) you want to use for the Distance 
measurement. Click the Select Inspection button again to complete the selection. 

4. Go to the Extraction 2 tab and click the Select Inspection button. 

5. Select the second reference point (in the inspection tree) you want to use for the Distance 
measurement. Click the Select Inspection button again to complete the selection. 

6. Go back to the Distance tab and set the Distance Limits. 

7. Adjust other parameters as necessary. 

Distance menu 

 Note: The symbol [ ] indicates that this value is in pixels. Your system may show [mm] for 
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be calibrated 
using Review Camera Calibration (on page 120) or Image Analysis (on page 114) for the current 
sensor. 

 

Distance Component 

Point to Point -- [most common] Find the distance between two reference points. 
Perpendicular to Orientation and Parallel to Orientation -- These two modes are good for measuring 
distance across a bottle finish. You would set this mode depending on the part orientation. 

  

 

1 Part oriented upright - use Perpendicular to Orientation 

2 Part oriented sideways - use Parallel to Orientation 

 Note: If you use Finish Location or Centerline registrations for either of the extractions, note that 
these registrations produce an orientation. The distance measured will reference the orientation 
produced by the Finish Location or Centerline registrations. If using other inspections, zero 
degrees or ninety degrees is used as a reference. 

Setup 

Set up the reject criteria for the measurement. 

Distance Limits 

Specify the minimum and maximum distance between the two reference points. 

Nominal 

The ideal distance. 
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Extraction 1 and Extraction 2 menus 

 Note: when only one inspection is used for Extraction, the second reference point used is the center 
of the screen. 

 

Select Extraction 

These menus allow you to choose an inspection to use as a reference point for the measurement. 
Click the Select Inspection button, then choose an inspection from the inspection tree. Click the 
Select Inspection button again to set the choice. The Assigned Inspection and Location Provider Type 
information is filled in -- you cannot manually change these. 
In this example, we chose Hough as Extraction 1 and Feature as Extraction 2 from the inspection tree. 
Those inspections become highlighted when Distance is selected in the inspection tree and/or is 
being edited. 

 

Reference Point 

(Available when you use the Measure Extract inspection) Choose which edges to use when 
computing Distance. 

 
Minimum Position -- The system will use the minimum distance of the search region, and reject parts 
if the measurement is out of limits. 
Maximum Position -- The system will report the maximum distance of the search region, and reject 
parts if the measurement is out of limits. 
Average Position -- The system will report the average distance of the search region, and reject parts 
if the measurement is out of limits. 
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Suppose the illustration below indicates a search region, in which the system is searching from right 
to left, seeking a light to dark transition. Position 1 is the Maximum Position. Position 2 is the Average 
Position. Position 3 is the Minimum Position found in the search region. 

 

Finish Corner 

(Available when you use Finish Location as the extraction for Distance) Choose which corner to use as 
a reference when computing Distance. 

  

Calibration menu 

Use this menu to program the system to translate pixels into your desired units of measure (mm, for 
example). 

 

Calibration Mode 

The system will convert the pixel dimensions into your preferred unit of measurement. 
Sensor Calibration -- Use the calibration previously set up for the sensor through Image Analysis (on 
page 114) or through another inspection. 
Inspection Calibration -- Use the calibration from this inspection only. 

Units 

Choose your preference in the reporting of the measurements. Choose from millimeters, inches, 
pixels, and custom. Custom allows any calibration factor to be used. 

Conversion Factor 

This indicates the pixel size and is used to convert one pixel into the units selected. The initial 
conversion will be controlled by the Learn Calibration results. You can adjust this value manually if 
necessary. 

Learn Calibration 

Click the Learn Calibration button to automatically determine the scale factor, which converts the 
value to the desired units. 

 Note: you must first enter the Measured Distance before learning calibration. 
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Save Calibration 

Click the Save Calibration button to save the calibration scale and units to the sensor for use by other 
inspections. 

Measured Distance 

Measure your part with calipers or another tool, then enter the actual value for Measured Distance. 
This is used to help calibrate the measurement. 

 

Angle 

Angle computes the difference in angles between two orientations or registrations. Angle does NOT use 
a region by itself. It uses information obtained in previous registrations or orientations. To measure an 
angle, use at least one registration or orientation - anything that produces an orientation. Examples 
where Angle could be used are to find skewed labels, or turned tabs on converted ends or EZO ends. 

Inspections that produce an orientation, that can be used to compute an angle include: 

Centerline (on page 201) 

Finish Location (on page 204) 

Template Registration (on page 208) 

Pattern Match (on page 220) 

Template Orientation (on page 222) 

Label Skew Extract (on page 257) 

In the example below, a label angle is computed with respect to the centerline of the part. 

 

 

1 Good part 

2 Bad part - label angle is out of tolerance 

 

You can measure the angle with respect to zero degrees on the image, if desired. 

 

 To add an Angle dimension: 

1. Make sure at least one inspection that produces an orientation has been added to the inspection 
tree. [see list above] 

2. Right-click on the item you just added. 
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3. From the Inspection menu, select Add > Dimension > Angle. The Angle dimension is added to the 
inspection tree. Re-name the inspection to something more meaningful to you. 

4. The Angle menu (along with two Orientation menus) is displayed and the region is shown on the 
image. (The menu is described below) Adjust the placement of the region and parameters as 
necessary. 

 

 To set up Angle dimension: 

1. Select the Orientation 1 menu. 

2. Click the Select Inspection button. 

3. From the inspection tree on the left side of the screen, choose an inspection to reference one 
angle. The inspection you choose must be one that produces an orientation. See list at the 
beginning of this topic. 

4. Click the Select Inspection button again to complete the selection. 

5. If you have another inspection to reference, use the Select Inspection button in the Orientation 2 
menu. If you do not have another inspection to reference, the system uses zero degrees on the 
image as a reference. 

6. Go to the Angle menu and set the Angle Limits to pass or fail parts based on your quality control 
criteria. For example, a part may be rejected if the angle of the label is too large compared to the 
centerline of a bottle. 

7. Adjust other parameters as necessary to pass or fail parts per your criteria. 

 

Angle menu 

 

Angle Limits 

Set the valid range of measured angles per your specifications. 

Nominal 

The ideal angle measured. 

Angle Mode 

Use the Smallest or Largest Angle. An example: the system could measure an angle at 2° or 358° 
depending which direction it is measuring. Choose whether to use the smallest or largest angle 
found. 

Flip Angle 180 

Use this option if your angles are pointing in opposite directions and you want them aligned in the 
same direction. Sometimes this depends on how a ribbon was drawn, for example. 

Orientation menu (1 or 2) 

Pick the reference point(s) to measure the angle. 
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 Note: when only one inspection is used for Extraction, the reference angle used is zero degrees, so 
the inspection would measure the angle with respect to zero degrees. 

 

Select Extraction 

These menus allow you to choose an inspection to use as a reference point for the measurement. 
Click the Select Inspection button, then choose an inspection from the inspection tree. Click the 
Select Inspection button again to set the choice. The Assigned Inspection and Location Provider Type 
information is filled in -- you cannot manually change these. 
In this example, we chose Finish Location as Extraction 1 and Centerline as Extraction 2 from the 
inspection tree. Those inspections become highlighted when Angle is selected in the inspection tree 
and/or is being edited. 

 

Angle Selection 

This parameter is available when the inspection selected for the extraction contains more than one 
data point to reference. Examples include Finish Location or Centerline. Select the data point to 
which you want to reference the angle. 

 

Correlation 
There are no correlation inspections in the system. 
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Defect Database Tool (option) 

 Note: the Defect Database tool is an optional feature. To purchase this feature, please contact your 
Pressco Sales Manager. Additional hardware may be required, depending on your system. How to 
Contact Pressco (on page 303). 

The Series V Intellispec system is capable of archiving data associated with defective parts. The archiving 
of this data may be enabled or disabled. The defect data collected includes information related to the 
part program, lanes, inspections, sensors and correlated machine parts. The information can be from any 
type of sensor - camera, x-ray, mass, etc. The Defect Database tool allows you to search, view, and 
report defect information. 

This information is valid as of 5.0.491/ 5.2.022/ 5.3.004 software. 

What is the Defect Database? 

The Defect Database is a tool within the Intellispec system that uses a separate hard drive used to 
archive information associated with rejected parts. This tool has two components: 

 The Defect Data File that contains images of parts that have been rejected, and 

 The Defect Database that stores defect information for each part that has been rejected.  

Defect Database Specifications and Limitations 

 The Defect Database is an option and therefore has to be part of the original install, or purchased as 
an upgrade. 

 A separate hard drive is installed to support this database. A minimum 500GB hard drive is 
recommended. 

 If your system has a part number 70315 or higher, then it is hardware-ready. This means that the 
system has the hardware capable of running the Defect Database. 

 If your system has a part number below 70315, then additional hardware (hard drive and 
possibly memory) may be required. Contact Pressco. 

Chapter 11 
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 The Defect Database is maintenance-free. 

 A separate database is created for each lane. You must enable the Defect Database individually for 
each lane. 

 The Defect Database supports up to 500,000 records for each lane. 

 The number of images available depends on the size of the Defect DB hard drive installed. You can 
see this information on the Intellispec screen on your system. (see example below) This total 
number of images is shared between all lanes. As defect images are written first-come first-served, 
more images are stored for a lane with a higher number of defects. 

 There may be more records for all lanes than available image space. Therefore the oldest records 
may have no valid image associated. 

 We cannot guarantee that all records and all images are saved because of memory constraints and 
available time for writing images to a hard drive. 

 The Defect Database is designed to limit interference with the inspection system. This means that 
under high system load data may not be recorded as the database has to yield to the inspection 
system. 

 The Defect Database file size is fixed. The entire hard drive space is allocated upon initial setup. 
When the database reaches its maximum number of records or images, it overwrites the oldest 
information. 

 Example file size and number of images available: 

 

Note the following about the Defect Database 

The information below refers to content you can find by using the Defect Database Viewer (on page 
277). 

 Defect images can be accessed from the Defect Database by looking at details of a search result 
record. 

 You can create defect rate reports over a time span for any or all part programs. 

 You can search the database by criteria including: 

 Part program 

 Sensor 

 Inspection (your name for the inspection, such as "Find Center") 

 Inspection type (Intellispec inspection type, such as "Contrast") 

 Sets of machine parts (such as "Cavity 3 through 10" or "Spindle 1 through 100") 

 Time span of calendar dates and clock times 
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Preparing the Database 

 Note: the Pressco installer will configure your database upon installation if you have purchased this 
option with your system. However, if you purchase this option as an upgrade, you may need to 
configure the database as described below. 

 What you need: 

 A dongle with the Defect Database feature enabled (provided with the purchase of the feature). 

 A hard drive labeled “Defect DB” The size of the hard drive determines the number of images that 
can be stored. (At least 500 GB of storage is recommended, more if you are using cameras of 
resolutions higher than 640x480). Name the hard drive "Defect DB" using the Computer or Windows 
Explorer on the Intellispec system. The drive letter does not matter. Make sure to use the exact 
capitalization and spacing as shown. 

 

Enabling Defect Recording versus Defect Database 

Enabling Defect Recording will start saving images to the Defect Data File, which can be accessed by 
using the Defect Data (Images) Viewer (on page 275). You can disable Defect Recording (recording of 
images and data of non-image type sensors) for each lane individually. However, in order to enable the 
Defect Database that stores defect information for each part that has been rejected, Defect Recording 
must be enabled. Enabling the searchable Defect Database is described next. 

 To see whether the Defect Database is already enabled: 

1. From Lane Overview or Sensor Overview mode, click the Tools button to see the tools menu. 

2. Select Lane Setup > Defect Recording Configuration. The configuration menu is displayed. (This 
menu is only available when you have the configured dongle and hard drive as described above) 

 

 If ”Preparation Required” is displayed, then you need to set up the Defect Database; see below. 
Otherwise, if any box is unchecked you can enable the option by checking it. You can only check 
“Enable Defect Database (Lane)” if  “Enable Defect Recording” is already checked. 

 If both boxes are checked, then the Defect Database is ready to use. 

Prepare the hard drive for defect recording. This process needs to be done only once. 
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 To prepare the hard drive: 

 Warning 
When you complete these steps, all information from the Defect DB hard drive is deleted. In 

addition, if you are upgrading from a system with software earlier than 5.0.480 that was 
already using the Defect Database, then the entire old database will be erased. This action 

cannot be undone. 

1. From the Intellispec application, go to Lane Overview or Sensor Overview mode and click the Tools 
button to see the tools menu. 

2. Select Lane Setup > Defect Recording Configuration. The configuration menu is displayed. It should 
indicate that preparation is required. 

 

3. Check the Enable Defect Recording box. A message will explain that the Intellispec system will 
delete everything from the hard drive that it recognizes as "Defect DB." 

 

4. Click the Prepare Hard Drive button. As a safety precaution, the system asks you to type the word 
"DELETE" before it prepares the hard drive. 

5. If you are sure that you want all information deleted from the "Defect DB" hard drive, type DELETE 
in all capital letters on the displayed keyboard, then click the OK button. This action does two 
things: 

 Formats the hard drive, and 
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 Creates a large file on the hard drive that holds the images and the non-image sensor data. This 
file is shared by all lanes. 

 

6. The hard drive is prepared. A message indicating the space available on your hard drive is 
displayed. Click the OK button to continue. 

 

7. The configuration menu is displayed, showing that Defect Recording has been enabled. The Defect 
Database (non-image sensor data) still needs to be prepared. Check the Enable Defect Database 
(Lane) box to begin preparation. 
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8. The system displays a message stating that it will prepare the database for all lanes. Click the Start 
button to continue. 

 

The Defect Database is ready to use on the lane on which it was enabled. The database will record 
defects and images each time you put the lane online. Enable the Defect Database for other lanes 
through the Defect Writing menu (see "Enabling/ Disabling Defect Writing" on page 274). 

 

Enabling/ Disabling Defect Writing 
From System Overview mode, you can enable or disable Defect Recording (images) and the Defect 
Database (data) for all lanes. 

 Note: this feature is available in software versions 5.0.493, 5.2.026, 5.3.005 and later. 

First time usage 

If this is the first time you are using this feature, you must prepare the hard drive once from Lane 
Overview mode. If you select Defect Writing > Configure Defect Writing from the Tools menu in System 
Overview mode without first preparing the hard drive, the following message will be displayed. 

 

Go to Preparing the Database (on page 271) for information on setting up the hard drive to configure 
your defect database. 

 Note: once the hard drive is prepared initially, you do not need to prepare it again for additional 
lanes, except if you add a lane subsequent to preparing the database the first time. If you have 
added a lane, then you will need to prepare the database through Lane Overview mode on the new 
lane. 

Subsequent usage 

If you have previously used the Defect Database and disabled it from any or all lanes, you can enable it 
for multiple lanes at once. No further hard drive preparation is required after initial setup. 

 To enable the Defect Database on any lane: 

1. From System Overview  mode, select the Tools button  to see the tools menu. 
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2. Select Defect Writing > Configure Defect Writing. The Global Defect Recording Settings menu is 
displayed. 

 

3. To enable Defect Recording (the recording of images), check the Defect Recording box. 

4. Check the Defect Database box to enable recording of non-image sensor data. The database is 
enabled for the selected lane(s). 

5. Click the OK button to save changes and exit. 

The system is ready to record defect images and data as you selected. 
 

Saving Items to the Database 
To save items to the database, the database must first be enabled. See Preparing the Database (on page 
271). 

Each time you put a lane online, the Intellispec saves defect information and images to the database. 
The defect database for each lane has a fixed number of 500,000 records, and once this number is 
reached the oldest records will be overwritten with the newest ones. 

 Note: when the database is prepared, the entire hard drive space is used, so the "Defect DB" hard 
drive will appear full. The Defect Database Tool places images and defect information into the 
database, using allocated placeholders in the database. You will not be able to tell whether the 
database is full by looking at hard drive space. 

 
 

Defect Data (Images) Viewer 
The defect data viewer is an auxiliary tool that allows access to the contents of the Defect Data File, 
which is a very large file containing image data and data of non-image sensors, such as Mass. This tool is 
not part of the defect database but provided for your convenience.  
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 To open the Defect Data Viewer: 

From Lane Overview or Sensor Overview mode, click the Tools button , and select Reporting > Defect 
Data Viewer. The Defect Data File Viewer and Extractor screen is displayed. 

 

If the lane was online when you opened the viewer, the database will continue to collect defect data and 
images. However, the information in the viewer reflects only the data as of the time you opened the 
viewer. To see more recent data, you must close and re-open the Defect Data Viewer. 

Filtering images 

In the upper part of the menu, you can filter the images you want from the database. Choose from lane, 
sensor, part program, and date range. This affects the list of images available to view on the right of the 
menu, as well as the images you may export from the lower part of the menu. 

Viewing defect images 

Images are displayed on the right side of the viewer. Use the buttons below the image to scroll through 
the available images. 

Extracting images 

In the lower part of the menu, you can extract images from the database for use in another location or 
during part program setup. The images available for extracting are determined by the filter settings in 
the upper menu. 

 To extract images: 

1. Enter the Number of Files if you want to save a different number of images than the available 
items. 

2. Click the disk icon  to change the location to which to extract the images, and browse to the 
desired location. 

3. Click the Extract button to save the selected images. 
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Defect Database Viewer 
This tool allows you to: 

 Search the defect database 

 Examine and export images of defects 

 Export search results, and 

 Create and export defect rate reports from the database. 

 To open the Defect Database Viewer: 

From Lane Overview or Sensor Overview mode, click the Tools button  and select Reporting > Defect 
Database. The Defect Database Viewer is displayed. 

In the upper right corner, a Snapshot time is displayed. This is the time when you entered this menu. If 
the lane is online, the Intellispec keeps saving defect data and images, but any data collected while this 
window is open will not be available for searching. You can close and re-open the menu for the most 
recent data. 

 

Reports 

The Reports tab allows you to view reports by minute, hour, or day. You can choose from all or a single 
part program.  A date/time range picker is provided to limit the report to a specific period. The Quick 
Select drop-down menu allows you to choose a time period of the last 24 hours, today's data (until the 
snapshot time), or all available data. 

 

Click the View Report button to see the report from the selected criteria. 
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The example below shows a report with a time step of one minute. Use the buttons on the right side of 
the window to page through the reports. 

 

Printing the report 

Click the Preview button to enable the print function. A print preview is displayed. Use the Print button 
to print the report to the configured printer. (For more information, see Setting up a printer (on page 
100)) 

Saving the report to file 

If you have not yet saved any reports, then a message stating "File Does Not Exist" is displayed below the 
disk icon. 

 To save a new report: 

1. Click the disk icon . The Select File window is displayed. 

2. If desired, use the disk icon in the Select File window to browse to a different location on the hard 
drive, or a USB drive. Browse to the desired location and click the OK button to continue. 

3. Click the New button in the Select File menu to create a new report file name. The onscreen 
keyboard is displayed. 

4. Type the report name, and click the OK button to continue. A file is created at 
C:\Pressco\DataExport (or another location that you selected in step 2) but no data is saved yet. 

5. Click the Export button from the Defect Report window. The report is saved as a text (.txt) file and 
the file name contains lane, time interval, and time stamp information. You can use this data in 
your own spreadsheets or other databases to chart your plant's defect data. 
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 To save new data to an existing report name: 

You can use an existing report name to save more data to a new file. The last used report name is 
displayed under the Export button. 

Click the Export button to save new data. The report is saved as a new text (.txt) file. The file name 
contains lane, time interval, and time stamp information. You can use this data in your own 
spreadsheets or other databases to chart your plant's defect data. 

 

Exported Report Example 

The file below is an example of a text file exported from the Defect Database. The file is tab-separated, 
and you can import it into your preferred reporting software. The header describes the contents in 
detail. The header text and all number and time formatting depend on the currently chosen language. 

 
 

Search 

The Search tab allows you to search the database by part program, sensor, inspection, inspection type, 
date, time, and machine part. 

 

 To start the search: 

1. Choose the desired filters from the available options. 

2. Click the Search button. The search may take a few seconds depending on the search criterion and 
the size of the database. Afterwards, the Search Results tab is automatically selected. 
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If your system uses machine parts, you have the option of searching for defects by machine part. 

 To search by Machine Part: 

1. Check the box next to "Machine Parts" to enable the search filters. 

2. If you want to search by all machine parts, leave the drop-down menu at "All." 

 

3. To select specific machine parts, select "Use Filter" in the drop-down menu. The Select Machine 
Parts screen is displayed. 

 

4. Select a machine part number in the "Available" column. Click the right arrow button to move that 
machine part number to the "Selected" column. 

a) To select additional machine parts, select each machine part, then click the right arrow button to 
move each into the "Selected" column. 

b) To select contiguously listed machine parts, select the first desired machine part, then click the 
Mark Range button. Select the last listed machine part you want to search for. The system 
selects all machine parts between the first and last machine part you selected. Click the right 
arrow button to move all those machine parts to the "Selected" column. 

5. To de-select any machine part, highlight it in the "Selected" column, then click the left arrow 
button to move it to the "Available" column. Use the Mark Range feature to select a group of 
contiguously listed machine parts. 

6. All selected machine parts are listed below the "Selected" column. Click the OK button to save 
changes and exit. The selected machine parts are also displayed in the Defect Database Viewer 
Search screen. 

7. In the Defect Database Viewer Search tab, an "Edit Filter" option is added to the drop-down menu. 
You can change the list of machine parts to search using the "Edit Filter" option. 
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Search Results 

After performing a search, the Search Results tab is automatically selected. Defect data returned as 
search results is presented within the grid. Each row represents an inspection associated with a defective 
part based on the search criteria. Each column represents specific information about the inspection (for 
example, part program, inspection name, sensor, status, time stamp, etc.). Use the scroll bars to see 
data from a specific time period. 

 

Scrolling through the data 

Click the scroll bar to the immediate right of the grid to scroll to a specific record.  Labels appear 
indicating the time stamps that will be scrolled to when moving the button next to the label. Note that 
the labels are spaced by records not by time. 
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For larger data sets (more than about 160 records) a second scrollbar “Data Zoom” appears to the right 
of the first scroll bar. This allows narrowing in on the time of interest. While moving the Data Zoom scroll 
bar two thick lines appear in the first scroll bar, which indicate the time span to which scrolling will be 
restricted. Labels indicate the times of the first and last record of the search result; the first and last 
record of the current scroll restriction selected by Data Zoom and of one currently displayed record. Use 
the first scroll bar to get closer to the desired time and repeat the process as needed. 

 

Viewing result details 

Click the Details button for a highlighted item to view the Record Details. This window displays the 
associated image and inspection information. It also allows you to export the image. The Full Size button 
brings up a viewer showing the unscaled image in full resolution (screen resolution may restrict this for 
images of very high resolution). 

 or  

 Note: The details viewer will not always show a specific text such as “Distance too Large.” This 
depends on the type of inspection and the specific type of defect. 
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Exporting the results 

 To export the results: 

1. Click the Export button at the bottom of the Defect Database Viewer Search Results screen. The 
Export Search Results window is displayed. 

 

2. If desired, use the disk icon to browse to a different location on the hard drive or a USB drive. 
Browse to the desired location and click the OK button to continue. 

3. Select an existing file from the displayed box, or click the New button to create a new report file 
name. 

4. (If creating a new file) In the on-screen keyboard type a file name, and click the OK button to 
continue. A file is created at the location displayed in the drop-down but no data is saved yet. 
Highlight the new file as in step 3. 

5. Click the OK button. The search results are saved as a text (.txt) file. You can use this data in your 
own spreadsheets or other databases to chart your plant's defect data. Exported Search Results 
Example (on page 284). 

 
 



284  Defect Database Tool (option) Software User's Guide INTELLISPEC™ (Software Version 5.0.501) 
   © 2014 Pressco Technology Inc. Proprietary 
 

 

Exported Search Results Example 

The file below is an example of a text file exported from the Defect Database after using the Search 
feature. The file is tab-separated, and you can import it into your preferred reporting software. The 
header describes the contents in detail.  The header text and all number and time formatting depend 
on the currently chosen language. 

 
 

Abnormal Results 

Sometimes you may see results in the database that do not show defect data. These are rare situations, 
but can be caused by high part rates, high defect rates, or a heavy processor load on the system. You 
may also have less space for images in the defect data file than the total number of defect database 
records over all lanes, so images in the defect data file may already have been overwritten for the oldest 
records in the defect database. 
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Stale Data 

This happens when the real time processor was busy for too long while the image was pending a write to 
the hard drive. This condition may happen when there is a high defect rate and a high load on the 
system. In this case the record exists in the database but the image is not valid because it was never 
written in the first place. 

 

Recycled Data 

This happens for the oldest records in the defect database when their images in the defect data file have 
been overwritten. 

 

Spilled Record 

This happens when the defect record (not image) cannot be written to the hard drive. This may occur if 
the system is too busy writing images to the hard drive. The screen will indicate how many defect 
records were spilled during which time interval. 
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About OPC 

OPC (OLE {Object Linking and Embedding} for Process Control) is a data communication standard 
developed by leading manufacturing equipment and software vendors, in conjunction with Microsoft. Its 
purpose is to promote interoperability between a wide variety of data sources and the consumers of 
that data, eliminating the need for diverse and incompatible “drivers” for each separate device or 
program. 

The OPC specifications are developed and administered by the OPC Foundation: 
http://www.OPCFoundation.org http://www.OPCFoundation.org 

Pressco has been an OPC Foundation Member since Spring of 2004, and participated in their 
Interoperability Workshop of April 2005. 

 

The Intellispec OPC Server 
The Pressco OPC Server for Intellispec systems supports the OPC Foundation “Data Access” specification. 
It is compatible with all versions of the specification in widespread use today (1.0a, 2.05 and 3.00). The 
OPC Server does not support other OPC specifications (including Alarms & Events, Historical Data or XML 
Data or Unified Architecture). 

The Intellispec OPC Server is an optional feature - contact (see "How to Contact Pressco" on page 303) 
your Pressco sales manager for details. 

Sampling rate 

Sampling of data is based on an ‘update rate,’ which is specific to a group of OPC data items. There may 
be several groups of items, each having an update rate appropriate for the items in that group. The 
maximum update rate supported by the OPC Server is 100 milliseconds (i.e. 10 updates / second); this 
may be less depending on the system configuration, part programs and part rates. Note that OPC does 
NOT support event-driven data updates; example, every 10,000 parts inspected or every rotation of a 
machine part. 

Defect statistics 

The data items available from the Intellispec OPC Server include most inspection defect statistics 
produced by the system. In particular, the following five items will be found: 

 TotalNumberInspected: the number of parts inspected since last reset. 

 TotalNumberDefects: the number of defective parts identified since last reset. 

 TotalPercentDefects: the defective part rate expressed as a percentage of total number inspected, 
since statistics were last reset. 

 RecentNumberDefects: the number of defective parts over the last “N” number of parts inspected, 
where “N” is a configurable system parameter. 

 RecentPercentDefects: the defective part rate expressed as a percentage of the last “N” parts 
inspected, where “N” is a configurable system parameter. 

These data items appear repeatedly within a hierarchical (“multi-level”) structuring of the data items and 
represent a variety of different subsets of the parts inspected. More specifically, they are maintained for 
every lane in the system (top level), every camera or sensor within each lane (second level) and every 
individual inspection within each camera (third level). Some values are also available for correlated 
machine parts when the system is so configured. 

Chapter 12 

http://www.opcfoundation.org/
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The exact names of the levels containing these data items are automatically derived from the names 
given to the lanes, cameras and inspections programmed into the Intellispec system. This makes 
“browsing the tree” of available data items extremely intuitive and eliminates the tedious and 
time-consuming process of OPC server configuration. 

 

OPC Configuration 
The OPC Configuration screen provides access and settings to the OPC server. 

To access OPC Configuration: 

1. Log in. 

2. Click the  button. 

3. Click the Tools button  to see the Tools menu > select OPC Configuration. The OPC 
Configuration menu opens. Please see the information about each section below. 

 

Refresh Interval 

Not used. 

Counter Setup 

See Counter Rollover (on page 297) or Using the OPC Private Counters option (on page 295). 

Options 

"Show Alarms Node" and "Show Groups Node" are not used. "Force Upper Case" is only used for 
compatibility with a specific OPC client - in most cases it is not used. 
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Show 'Generic' Mode 

Use this to view items when inspection names or other parameters have been re-named using 
non-ASCII characters. Note that everything is named generically, including sensors, lanes, and 
inspections. 

 Tip: This can be used by Pressco Service Engineers to view data that is not in English. 

Show 'Measurements' Items 

See Measurement data items (on page 293). 

Show 'Parameters' Items 

See Parameter data items (on page 294). 

Permissions 

Reserved for Pressco Technicians only. 

OPC Test Client button 

Click this button to open The Intellispec OPC test client (on page 289). 
 

The Intellispec OPC test client 
USER LEVEL: ADMINISTRATOR 

The Intellispec provides test client software to make sure that the OPC server is properly working. It is 
not a fully functional software client - it is only intended to be used to verify the functionality of the 
server. This is only available if your system has been configured for OPC. 

 To use the OPC test client: 

1. Log in. 

2. Click the  button. 

3. Click the Tools button  to see the Tools menu > select OPC Configuration. The OPC 
Configuration menu opens. 

4. Click the OPC Test Client button. The Softing OPC Toolbox Demo Client opens. 

5. Click Open on the program's toolbar. The File Open dialog box is displayed. 

 

6. Click the IspecSystem.soc file >> click Open. 
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 The left pane of the demo client window should now display ‘Data Access’ at the very top, with 
‘Pressco Intellispec OPC Data Server’ below that, a group below that, and a list of data items (all 
beginning with Lane.’) below the group. Each of these items (except ‘Data Access’) should have a 
solid green circle containing a black dot to the left of it. 

 

7. Click the DA Items tab at the bottom of the window. Note that there are columns for Item, Value, 
Quality, and Time Stamp for each of the items in the left window frame. 

 

8. Verify that all data items have a solid green circle next to them. 

9. Verify that all data items have GOOD status in the Quality column. 

10. Verify that data item "System.Current.Time" is being updated once per second. 

11. In the left window frame, select Pressco Intellispec OPC Data Server. 

12. At the bottom of the right window frame, select the DA Browse tab. 
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13. At the top of the right window frame, click the '+' to the left of the blue diamond. There should be 
one blue square for each lane configured on the Intellispec, plus a blue square named System. 
Each blue square is a container for whatever data items are available for each group, and 
additional nested containers if appropriate. 

 
 

Interpreting the Data 

The data items in the OPC test client correspond to the statistics on the Intellispec screen. 

 To see the individual data items: 

1. Click the 'DA Browse' tab on the lower right screen. 

2. Click on the '+' next to the blue square for a lane. This will display a nested blue square for each 
camera and machine part configured on that lane, plus several more blue circles for the data items 
summarizing that lane, including: TotalNumberInspected, TotalNumberDefects, 
TotalPercentDefects and TimeLastReset. 
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3. Click on the '+' next to the blue square for a camera. This will display a nested blue square for each 
inspection currently programmed for that camera, plus several blue circles for the data items 
summarizing that camera. These items correspond to the statistics on the screen, as shown below. 

 

4. Click on the ‘+’ next to the blue square for an inspection (example, Tamperband). This will display 
several more blue circles for the data items summarizing that inspection, including: Enabled, 
TotalNumberDefects, TotalPercentDefects, RecentNumberDefects and RecentPercentDefects. 

5. Click the ‘+’ next to the blue square for a machine part (if any) (example, CapperHead). This will 
display a blue circle for each camera in the lane, named ‘<CameraName>NumberDefects’, 
'<CameraName>PercentDefects,' plus ‘TotalNumberDefects’ and 'TotalPercentDefects.' Note that 
each of these data items is an array containing defect counts for the machine part correlation 
feature. 
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Adding data items to those being monitored 

Double-click a data item (blue circle) in the ‘DA Browse’ tab to add that data item to the list of those 
which are being monitored in the ‘DA Items’ tab. 

 
 

Measurement data items 

Additional inspection data is presented for some inspections. 

To see measurement data items, check the Show 'Measurements' Items box in the OPC Configuration 
(on page 288) screen. 

A number of inspections include data items providing measurements, including: 

 Measurement inspection: the measurements “Inner,” “Outer,” and “Width” are available (see note 
1 below) 

 Distance inspection: the measurement “Distance” is available 

 Angle inspection: the measurement “Angle” is available 

 Mass inspection: the measurement “Value” is available (see note 2 below) 

 Note 1: some of the measurements for the “Measurement” inspection may not be active, depending 
on the specific configuration of the inspection. 

 Note 2: if machine part correlation is available on the system, the single “Value” measurement will 
instead be named “AllCavities” and the per-cavity measurements “Cavity1,” “Cavity2,” Cavity3,” … 
“Cavity(N)” where (N) is the total number of cavities configured will also be available. 
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For each available measurement, the data items “Average,” “StdDev,” Minimum,” and “Maximum” are 
presented, based upon a running sample of the last 100 good parts inspected while online. The following 
example shows the items for a Measurement inspection. 

 
 

Parameter data items 

Additional inspection data is presented for some inspections. 

To see parameter data items, check the Show 'Parameters' Items box in the OPC Configuration (on page 
288) screen. 
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Contrast inspection includes parameter values (user settings affecting the performance of the 
inspection), including: “MaxContrast," “MinFeatureSize," “MaxFeatureSize,” and “MaxTotalSize” are 
presented. An example of a Contrast inspection is shown below. 

 
 

Checking for Errors 

At the bottom of the right window frame, click the Errors tab. Verify that no errors have been reported. 
 

Exiting the Test Client 

Click the ‘X’ in the upper right corner of the Softing OPC Toolbox Demo Client window to close the 
program. If you are prompted to save changes (probably due to changing the list of data items being 
monitored), click No. 

 

Using the OPC Private Counters option 

A separate set of OPC counters is available for long-term statistics tracking. When this feature is 
enabled, OPC counters are unaffected when the system statistics are reset either manually or 
automatically. When this feature is not enabled, the OPC counters are reset the same as the system 
statistics you see on the Intellispec screen. 

When the Private Counters option is enabled, the OPC Counters will only reset when: 

 A new part program is loaded, or: 

 You use the Reset Private Counters button 

 To enable the OPC Private Counters: 

1. Log in as Administrator. 

2. Click the  button. 



296  About OPC Software User's Guide INTELLISPEC™ (Software Version 5.0.501) 
   © 2014 Pressco Technology Inc. Proprietary 
 

 

3. Click the Tools button  to see the Tools menu > select OPC Configuration from the menu. The 
OPC Configuration (on page 288) menu is displayed. 

4. Check the Use Private Counters box. 

5. Click the OK button to save changes and exit. 

6. The Intellispec must re-start for changes to take effect. Click the OK button (check mark) to 
acknowledge the message. 

 

7. Click the Tools button  to see the Tools menu > select Exit System from the menu. 

8. Select "Shut Down Intellispec and Restart Computer" from the drop-down menu. The Intellispec 
system shuts down and restarts. The Private Counters are enabled. 

To see the difference between the statistics on the Intellispec screen and the OPC Private Counters, use 
The Intellispec OPC test client (on page 289). 

To view only items such as parts inspected, number of defects, etc., see how to View only defect data 
(on page 298). 

The example below shows what happens when Private Counters is used. 
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A Normal condition. Intellispec and OPC statistics are the same. 

B Private counters enabled. The Intellispec statistics are reset, but the OPC statistics do not get 
reset. 

 
 

Reset Private Counters 

When you use the OPC Private Counters option, you may need to manually reset the OPC data. 

 To reset the OPC Private Counters: 

1. Take the Intellispec system offline. 

2. Log in. 

3. Click the  button. 

4. Click the Tools button  to see the Tools menu > select OPC Configuration. The OPC 
Configuration menu opens. 

 

5. Click the Reset Private Counters button. A confirmation box appears to notify you that the 
counters will be reset on the OPC server. 

6. Click OK. The OPC counters are reset. 
 

Counter Rollover 

Counter Rollover is an advanced option for the OPC server. It allows the OPC server to behave like PLC 
counters if the digits are limited. For example, you may use a PLC where the data rolls over after 9,999. 
In this example, set the Counter Rollover value to 10,000. This would make the OPC data roll over after 
9,999 to be compatible with your PLC. 

 Note: if your plant is not limited in the number of digits for your OPC counter, make sure the Use 
Counter Rollover box is un-checked. 

If you have a PLC that has limited digits, set the Counter Rollover to a number equal to one greater than 
your PLC's highest number. 

 If your PLC rolls over after 9,999, set Counter Rollover to 10,000 

 If your PLC rolls over after 99,999, set Counter Rollover to 100,000 

 To set Counter Rollover: 

1. Take the Intellispec system offline. 

2. Log in. 

3. Click the  button. 

4. Click the Tools button  to see the Tools menu > select OPC Configuration. The OPC 
Configuration (on page 288) menu opens. 

5. Check the Use Counter Rollover button. 

6. Click either the 10,000 or 100,000 button. 

7. Click the OK button to save changes and exit. The Intellispec needs to re-start for the changes to 
take effect. 

8. Click the  button. 

9. Click the Tools button  to see the Tools menu > select Exit System. 

10. Select Shut Down Intellispec and Restart the Computer from the drop-down menu. The Intellispec 
software shuts down and restarts. 

11. Log in after the software restarts, and continue operation. 
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View only defect data 

To see the effects of Private Counters, set up the OPC test client to show only the defect items such as 
parts inspected and number of defects. 

Open the The Intellispec OPC test client (on page 289). 

Next, set up the data items to display only defect information. 

 To see the defect items: 

1. Remove the items that you do not want to see by clicking each item, then clicking the Delete 
button at the top of the menu. 

 Note: do not click the "System" item in the left pane. If you remove that item, then none of the 
statistics items will be available to view. 

 

2. Click the DA Browse tab at the bottom of the window. The "Pressco Intellispec OPC Data Server" 
item is displayed in the right pane. 

3. Click the '+' next to the Data Server item to expand the tree. 

4. Click the '+' next to a Lane name to expand the Lane tree. 

5. Choose the items from the right pane that you do want to view by double-clicking each item. 
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6. Continue choosing all the items you want to see. Expand the individual camera trees and choose 
the defect statistics for each camera, if desired. 

7. Once you have all the items you want to see in the left pane, click the DA Items tab at the bottom 
of the window. Your selected items appear in the right pane. 

Next, test the Private Counters: Put the Intellispec system online. Observe the defect data on screen and 
in the OPC test client. Notice that the numbers are essentially the same. Due to different update rates, 
the numbers may be slightly off at times. 

 

List of Data Items 
The following list contains the common data item IDs that are available on the Intellispec OPC Server. 
Note that the names of the data items depend on your system configuration. 

TotalNumberInspected 

Total number of parts inspected since statistics were last reset. Present for each lane, camera and 
inspection. 

TotalNumberDefects 

Total number of defective parts found since statistics were last reset.  Present for each lane, camera 
and inspection, and also for each machine part when machine part correlation is in effect (in which 
case this item is a one-dimensional array with each array element representing the defect count for 
one occurrence of the machine part). 

TotalPercentDefects 

Percentage of defective parts per the total number of parts inspected since statistics were last reset. 
Present for each lane, camera and inspection, and also for each machine part when machine part 
correlation is in effect (in which case this item is a one-dimensional array with each array element 
representing the defect percentage for one occurrence of the machine part). 

RecentNumberDefects 

The number of defective parts found in the last “N” number of parts inspected, where “N” is a 
configurable parameter. Present for each lane, camera and inspection. 

RecentPercentDefects 

Percentage of defective parts found per the last “N” number of parts inspected, where “N” is a 
configurable parameter. Present for each lane, camera and inspection. 

RecentSampleSize 

Gives the value of the configurable parameter “N” mentioned in the preceding “Recent…” data 
items. Present for System. 

Enabled 

True if the inspection is currently enabled or False if it is disabled. Present for each inspection. 

RejecterEnabled 

True if the rejecter for this camera or inspection is currently enabled or False if it is disabled. Present 
for each camera and inspection. 

RejecterNumber 

Gives the rejecter number assigned to this camera in lanes configured to have multiple rejectors. 
Present for each camera. 

TimeLastReset 

Gives the date and time statistics were last reset to zero. Present for each lane. 

CurrentPart 

Name of the currently selected part program. Present for each lane. 

ChuteFull 

True if the defective part container for this lane is currently full or False if it is not. Present for each 
lane. 
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MissedResults 

The number of parts that reached the reject point on the conveyor before the system was able to 
determine if the part was defective or not. Present for each lane. 

PartRate 

The number of parts to be inspected being encountered per minute. Present for each lane. 

EncoderFrequency 

The number of encoder pulses being produced per second (which is proportional to the conveyor 
speed). Present for each lane. 

AlarmActive 

True if the red light on the light tree is currently illuminated or False if it is not. Present for each lane. 

WarningActive 

True if the yellow light on the light tree is currently illuminated or False if it is not. Present for each 
lane. 

AnnunciatorActive 

True if the horn or buzzer on the light tree is currently sounding or False if it is not. Present for each 
lane. 

Online 

True if parts are currently being inspected with defective parts being rejected or False if they are not. 
Present for each lane. 

MissedPartPresents 

Total number of parts for which a usable image was not received from the camera. Present for each 
camera. 

Average 

Arithmetic mean of measurement. Present for each inspection measurement. 

StdDev 

Standard deviation of measurement. Present for each inspection measurement. 

Minimum 

Lowest value of measurement. Present for each inspection measurement. 

Maximum 

Highest value of measurement. Present for each inspection measurement. 

Version 

String giving the major, minor and build numbers of the software currently running on the Intellispec 
system. Present for System. 

SerialNumber 

String giving the system serial number. Present for System. 

CurrentUser 

String giving the name of the user currently logged onto the system, or empty string if no user is 
currently logged on. Present for System. 

CurrentTime 

Current date and time as given by system clock. Present for System. 
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References 
To learn more about OPC, visit these links: 

OPC Foundation 
(http://www.opcfoundation.org/Default.aspx/01_about/01_whatis.asp?MID=AboutOPC) 

OLE for process control (http://en.wikipedia.org/wiki/OLE_for_process_control) 

Or perform a search on the Internet, using "OLE for process control" as the search criteria. 

 

http://www.opcfoundation.org/Default.aspx/01_about/01_whatis.asp?MID=AboutOPC
http://en.wikipedia.org/wiki/OLE_for_process_control
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How to Contact Pressco 

24/ 7 Customer Support: 

+1 440-498-2000 

E-mail: 

dispatch@pressco.com (mailto:dispatch@pressco.com) or techsupport@pressco.com 
(mailto:techsupport@pressco.com) 

Customer Service Fax: 

+1 440-498-4761 

Mailing Address: 

Pressco Technology Inc.  29200 Aurora Rd.  Cleveland, OH USA  44139-1847 

Main Phone: 

+1 440-498-2600 

Web Site: 

www.pressco.com (http://www.pressco.com) 

Business Hours: 

Monday - Friday, 8:00am - 5:00pm Eastern Standard Time 

 

 

Chapter 13 
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